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Introduction
Paragon Partition Manager™ Server is an integrated set of powerful tools that is specially designed to tackle most of the

problems the user might face while using PC. A highly intelligent program engine together with built-in advanced

recovery facilities make it possible to securely carry out partitioning operations of any complexity, optimize

performance of NTFS and FAT file systems, migrate the system to another hard disk, etc. without fear to lose precious

data.

In this manual you will find the answers to many of the technical questions, which might arise while using the program.

JAN

Our company is constantly releasing new versions and updates to its software, that's why
images shown in this manual may be different from what you see on your screen.

What's New in Partition Manager Server

Next generation Adaptive Restore™ (P2P Adjust OS) to successfully migrate a Win2K+ physical system to a

different hardware platform (P2P) by allowing automatic injection of all required drivers and the other actions
crucial for a migration of this kind.

Smart Driver Injector to make the process of adding new drivers for P2P operations smooth and easy.

Selective Restore to easily extract files and folders from a backup image with the Restore Wizard without the

need to restore the whole image.

Boot Corrector for WinPE to fix most of the system boot problems not only with the Linux and PTS DOS
bootable recovery environments, but WinPE 3.0 as well.

The latest Linux kernel to enjoy support of a wider range of hardware configurations, including the brand new
Intel ICH9 chipset.

WInPE 3.0 based bootable recovery environment to enjoy support of a wider range of hardware configurations
with the option to add drivers for specific hardware on-the-fly.

More flexibility for online data processing techniques to provide for easier configuration for both, Paragon Hot

Processing and Microsoft Volume Shadow Copy Service (VSS).

Better support for 64-bit platforms to reboot your computer to one of the three special modes (Windows
native, Linux, or DOS) to automatically complete operations, which cannot be accomplished under 64-bit
Windows.

Better support for GUID Partition Table (GPT) to back up and restore not only single GPT volumes but entire
disks, including the option of resize during the restore operation.

Better support for the Apple Boot Camp Configuration with the option not only to back up and restore this kind
of configurations, but to copy single volumes or entire disks with resize.

Better support for Linux ExtFS starting from Ext2FS up to the brand new Ext4FsS.
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Product Components
In order to cope with different tasks, the product contains several components:

Windows based set of utilities is the crucial part of the product. With the help of an easy to use launcher you

may find and run tasks of any complexity in the field of data and system protection, hard disk partitioning and
cloning, etc.

Linux/DOS based recovery environment is a multi-platform bootable media that enables to run utilities under

Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes. Both
platforms have their strong sides, for instance Linux can boast support of FireWire (i.e. IEEE1394) or USB
devices. It enables to burn CD/DVD disks. However there can be some difficulties with detecting new hardware.
DOS in its turn has no problems of that kind but is limited in features. The Linux/DOS recovery environment
requires no installation and can be of great help when the system fails to boot. Besides it offers a Windows XP
like environment.

WinPE based recovery environment. Especially for keen followers of Windows, our product also offers a WinPE

3.0 based bootable media. Unlike the Linux/DOS recovery environment it can boast an excellent hardware
support and the same interface as the Windows version can. However its system requirements are much
tougher.

Features Overview
This chapter dwells upon key benefits and technical highlights of the product.

Key Features
Let us list some of the key features:

User Friendly Fault Minimizing Interface

Graphical representation of the data to gain a better understanding.
A handy Launcher to easily find and run the required tasks.

Comprehensive wizards to simplify even the most complex operations.

Resize partitions directly on the Disk Map with the drag-and-drop technique.
A context sensitive hint system for all functions of the program.

Previewing the resulting layout of hard disks before actually executing operations (so-called virtual
operations).

Backup Facilities

Support of major techniques to store backup images:

- Backup to local mounted/unmounted (without drive letter assigned) partitions;

- Backup to an external mounted storage to provide for a higher level of data protection and system
independence;

- Backup to external media (CD/DVD) to guarantee a high level of data protection as long as the backup media is
kept secure;
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- Backup to a network drive to stand a better chance of success in case of a hard disk failure.

Restore Facilities

Restore an entire disk, separate partitions or only files you need from the previously created backup image.

Restore with Shrink to restore a backup image to a free block of smaller size taking into account only the
amount of actual data of the image.

Adaptive Restore to successfully migrate a Win2K+ physical system to a different hardware platform (P2P) by

allowing automatic injection of all required drivers and the other actions crucial for a migration of this kind.

Copy Facilities

Partition/hard disk copy to successfully transfer all on-disk information including standard bootstrap code and

other system service structures, thus maintaining the operating system’s working capability.

A Copy functionality can also be used as an alternative way of data protection.

Boot Management Facilities

Boot Manager Setup Wizard to easily manage several operating systems on one computer.

Partition/Hard Disk Management Facilities

Basic functions for initializing, partitioning and formatting hard disks (create, format, delete). Instead of the

standard Windows disk tools, the program supports all popular file systems.

Express Create Partition Wizard to create a new partition in the most appropriate place of a hard disk, format it

to NTFS and then make it available in the system by assigning a drive letter.

Merge Partitions Wizard to consolidate the disk space, which originally belongs to two adjacent partitions
(NTFS, FAT16/FAT32), into a single, larger partition.

Redistribute Free Space Wizard to increase free space on one partition by up-taking the on-disk unallocated

space and the unused space of other partitions.

Express Resize Partitions Wizard to increase free space on one partition by up-taking the unused space of an

adjacent partition of a hard disk (including partitions of Apple Boot Camp).

NTFS hot resize upward to enlarge an NTFS partition (system, locked) without rebooting Windows and
interrupting its work.

Convert a file system (FAT16/32, NTFS, Ext2/Ext3) without reformatting.

Mount a partition (assign a drive letter) of any file system type to make it available for your operating system.

Modify file system parameters (make active/inactive, hide/unhide, change serial number, partition ID, volume

label, etc.).
Install New OS Wizard to make a system ready to install a new operating system.

Undelete Partitions Wizard to recover an accidentally deleted partition.
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File System Optimization Facilities

27 defragmentation strategies available to defragment FAT and NTFS file systems.

MFT defragmentation and shrinking to improve performance of NTFS.
Safe Defragmentation Mode to guarantee data loss free defragmentation of any version of NTFS and FAT.

Low free space defragmentation (less than 1% of the free space required) to successfully defragment almost full
disks.

Auxiliary Facilities

File Transfer Wizard to make such operations as transferring of files/directories or burning of them to CD/DVD
as easy and convenient as possible. Providing access to Paragon backups as regular folders, it may also help to
replace corrupted data from a previously created image in case of an operating system failure.

Volume Explorer is a handy tool when you have different file systems on the disk, whether they contain an

operating system or just data. Volume Explorer will let you explore a file system of any type and provide access
to the necessary files and directories regardless of their security attributes.

Recovery Media Builder to create a bootable recovery media based on Linux/DOS or WinPE 3.0 on a CD, DVD

disc, or flash memory, which can later be used to boot and recover your computer in case of an operating
system failure. Moreover, with its help you can save data from partitions of your hard disk directly to compact
discs or burn 1ISO-images. The utility supports various formats of laser discs: CD-R/RW, DVD-R/RW, DVD+R/RW,
DVD-R, DVD+R double layer, Blu-ray and can handle multi-session burning.

Network Configuration Wizard to establish a network connection under Linux or WinPE either to save a backup

of a partition/hard disk or just several files on a network computer or retrieve a previously made backup from a
network computer for recovery purposes.

Boot Corrector to fix most of the system boot problems that can be a result of a human factor, program error or
a boot virus activity.

JAN

Boot Corrector is only available for the WinPE 3.0 or Linux/DOS bootable recovery
environment.

Supported Technologies
Along with using innovative technologies from outside, Paragon has developed a number of its own original

technologies that make its products unique and attractive for customers:

Paragon Hot Backup™ technology to back up locked partitions and hard disks under Windows NT+ family
operating systems providing both high operating efficiency as well as low hardware requirements.

Paragon Adaptive Restore™ technology to successfully migrate a Win2K+ physical system to a different
hardware platform (P2P).

Paragon Power Shield™ technology to provide data consistency in case of a hardware malfunction, power
outages or an operating system failure.

Paragon UFSD™ technology to browse partitions of any file system including hidden and unmounted, modify
and copy files and folders, etc.
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e Paragon Hot Resize™ technology to enlarge NTFS partitions (system, locked) without rebooting Windows and
interrupting its work.

e Paragon Restore with Shrink™ technology to restore a backup image to a free block of smaller size taking into
account only the amount of actual data of the image.

e Paragon Smart Partition™ technology to securely perform hard disk partitioning operations of any complexity.

e Paragon BTE™ technology to set tasks for execution in the Windows blue screen mode, thus saving from the
need to use a bootable media when modifying system partitions.

e Microsoft Volume Shadow Copy Service (VSS) to provide the copy/backup infrastructure for the Microsoft
Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent
point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the
leading copy/backup solution vendors on the market, it is based on a snapshot technology concept.

e Microsoft Dynamic Disk (simple, spanned, striped, mirrored, RAID-5) to offer more management flexibility
without the partition limitation of basic disks. Dynamic storage can be particularly beneficial for large-scale
businesses when dealing with many physical hard disks involving complex setup.

e GUID Partition Table (GPT). It is the next generation of a hard disk partitioning scheme developed to lift
restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and Linux.

Supported File Systems
e Full read/write access to FAT16/FAT32 partitions.

e Full read/write access to NTFS (Basic and all five types of Dynamic Disks) under Windows 95/98/ME, Linux and
PTS DOS. Compressed NTFS files are also supported.

e Full read/write access to Ext2FS/Ext3FS/Ext4FS partitions under all versions of Windows, DOS 5.0 and later.

e Limited read/write access to Apple HFS+ partitions.

Unfortunately, support of non-Roman characters for the HFS+ file system is unavailable at
the moment. The company is about to implement it in the nearest future.

Supported Media
e Support of both MBR and GPT hard disks (up to 1,5 TB tested)

IDE, SCSI and SATA hard disks

CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW, DVD-R, DVD+R double layer and also Blu-ray discs

FireWire (i.e. IEEE1394), USB 1.0, USB 2.0 hard disks

PC card storage devices (MBR and GPT flash memory, etc.)

Getting Started

In this chapter you will find all the information necessary to get the product ready to use.
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Distribution
Paragon Partition Manager Server is distributed in two ways:

e Boxed package from Paragon Technology GmbH and resellers
e Downloadable package over the Internet at the company’s web-site

Distributive CD
The boxed package includes a distributive CD that is in fact a bootable Linux/DOS recovery environment with auto-run
of the Windows installation, thus it can be used as a ready-made solution (see Booting from the Linux/DOS Recovery

Media). But if you’re going to run the Windows components, you need to install them first (see Installation).

If you want to download an update/upgrade of the product, it will be in form of the downloadable installation package
as described in Online Distribution).

The WinPE recovery environment can only be obtained through the company’s web service.
You will get the required download link after the product has been purchased.

Online Distribution
Partition Manager Server purchased over the Internet will be in form of an MSI package. After installing the product you
can launch the Recovery Media Builder to build the Linux/DOS or WinPE recovery media.

The WinPE recovery environment can only be obtained through the company’s web service.
You will get the required download link after the product has been purchased.

Registration
Paragon Technology GmbH provides a wide range of online services through its web-portal - www.paragon-
software.com/support/:

e Registration of new users;
e Registration of purchased products for registered users;

e Available around-the-clock downloading center, where registered users can get product updates/upgrades as
well as all the necessary documentation;

e Downloadable free demo versions and open documentation for all users.

A It is recommended to use Internet Explorer 5+ or any compatible browser.

To register as a new user
To register as a new user, please do the following:

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

2. Click Create of the Create a Paragon Account section;

3. Fill out a registration form;

Copyright© 1994-2010 Paragon Software Group. All rights reserved.
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4. Click Register.

The most important field in the form is an E-mail address, as it serves as a login to enter the system. Besides your access
password will be sent to this address as well.

To register a new product
If you are a registered user and would like to register Partition Manager Server, please do the following:

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

2. Inthe Email field of the Authorization section, enter an E-mail used for registration;
3. Inthe Password field enter a password received after registration;

4. Click Signin;

5. If the user name and password are valid, you will get to your account;

6. Click Register new product of the Products section;

7. Enter your product serial number in the Serial Number field. You can find it in the product box or obtain from
your reseller. Click Next;

8. On the next page you will be asked to provide some additional data. Also you will need to decide whether you
want to get confirmation on registering the product by E-mail or not. Click Next, and then click Finish.

That is all. The product is now registered.

How to Download Updates/Upgrades
Downloading of updates/upgrades can be fulfilled in the following way:

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

2. Inthe Email field of the Authorization section, enter an E-mail used for registration;

3. Inthe Password field enter a password received after registration;

4. Click Signin;

5. If the user name and password are valid, you will get to your account;

6. Select My Downloads of the Products section to see what updates are available for you;

7. Select the desired update and click Download.

Contacting Paragon Technology GmbH
If you have any questions about the company products, please do not hesitate to contact Paragon Technology GmbH.

Service Contact

Visit Paragon GmbH web site WWww.paragon-software.com

www.paragon-

Registration & updates web-service
software.com/support
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Knowledge Base & Technical Support kb.paragon-software.com

Pre-sale information sales@paragon-software.com

System Requirements

Windows based set of utilities
To use the Windows utilities, you should install them first. But before that, please make sure your computer meets the
following minimum system requirements:

e Operating systems: Windows 2000/XP/Vista/7/Server 2000/2003/2008 and XP SP2/Vista/7/Server 2003/2008
64-bit

e Internet Explorer 5.0 or higher

e Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
e 128 MB of RAM (256+ recommended)

e Hard disk drive with 460 MB of available space

e SVGA video adapter and monitor

e Mouse

Linux/DOS based recovery environment
To use the Linux/DOS recovery environment on your computer (it doesn’t matter what operating system is installed),
please make sure that it meets the following minimum system requirements:

o |BM AT compatible computer with i486 or higher CPU
e 256 MB of RAM

e SVGA-compatible monitor

e Mouse (recommended)

WinPE based recovery environment
To use the WinPE based recovery environment on your computer, (it doesn’t matter what operating system is installed),
please make sure that it meets the following minimum system requirements:

e Intel Pentium Il CPU or its equivalent, with 1000 MHz processor clock speed
e Atleast 512 MB of RAM

e SVGA-compatible monitor

e Mouse (recommended)

Additional requirements
There may be additional requirements if you want to use advanced features:

e Network card to send/retrieve data to/from a network computer

Copyright© 1994-2010 Paragon Software Group. All rights reserved.
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e Recordable CD/DVD drive to burn data to compact discs
e External USB hard drive to store backup data.

Installation
As we have already mentioned only Windows components of the product require installation. So to install Paragon
Partition Manager Server under Windows, please do the following:

1. Run Setup Application. Click on the *.MSiI file. This application will guide you through the process of the
program installation. The setup utility is compiled with the InstallShield SDK, hence it contains the standard user
interface and set of installation steps.

In case there is some previous version of the program installed on the computer, the
program will offer the user to uninstall it first.

2. Starting Setup. The Welcome page informs that the application is being installed. Click the Next button to
continue.

3. Confirm License Agreement. The License Agreement page displays the Paragon License Agreement. Read the
agreement and then select the appropriate option to accept. If you do not agree with any conditions stated
there, the installation process will be interrupted. By clicking the Print button, the License Agreement may also
be printed out.

4. Provide Registration Information. On the Registration page you are to provide your product key and serial
number.

5. Provide Customer Information. On the Customer Information page you are to provide the standard
information, i.e. a user name and an organization. Besides you need to decide whether to make the program
available for all users of this computer (if several) or only for the current one.

6. Select an Installation Folder. The Destination Folder page allows you to choose a folder where the program will
be installed. By default, the installation folder will be created as:

C:\Program Files\Paragon Software\Paragon Partition Manager Server. To select another folder, click the
Change... button.

After you have selected the required folder, click the Next button to continue.

Do not install the program on network drives. Do not use Terminal Server sessions to install
and run the program. In both cases, the program functionality will be limited.

7. Confirm Installation. On the Ready to Install the Program page click the Install button to start the installation or
the Back button to return to any of the previous pages and modify the installation settings.

8. Copying Files. The Copying Files page shows the overall progress of the installation. Click the Cancel button to
abort the setup.

9. Finishing the Installation. The Final page reports the end of the setup process. Click the Finish button to
complete the wizard.
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To accomplish online backup/copy of locked partitions/hard disks the program uses a
A kernel mode hotcore driver, thus the system reboot is required to complete the installation

procedure.

First Start
To start Paragon Partition Manager Server under Windows, please click the Windows Start button and then select
Programs > Paragon Partition Manager™ Server > Paragon Partition Manager™.

The program provides wide opportunities in the field of hard disk structure modification, so
just to be on the safe side, please make a backup of your data before carrying out any
operation.

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out categorization
and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular
basis. With its help you can also start up the traditional launcher, the help system or go to the program’s home page.

P

f @ Paragon Partition Manager™ 11 Server Edition

=jion )

Paragcon

SOFTWARE GROUP

Paragon Partition Manager™ 11 . )S‘

Server Edition

Partitioning Partitioning
What would you like to do?
Migprztiogn | # Create Partition
1\ Create a new partition and set #ts properties.
Backup and Rescue #» Delete Partition

. Delete existing partition and al data it contains.

Boot Management # Resize Partitions
& Move border of adacent partitions of the same type (both logical or both
primary) to redistnbute space between them. Note: this wizard covers only
basic resize scenarios, if resize operation cant be camed out with Express
oge Resize Wizard, please switch to Partition Manager main launcher, right
Partition Manager click on a partition you would like to resize and select "Move/Resize Parition”.

# Merge Partitions
Support Contacts & Merge two adjacent partitions with the same fie system and the same type
(primary to prmary or logical to logical).

To start up the traditional Launcher, please click the Partition Manager button and then
A Partition Manager.

To know more on how to handle the product’s interface and accomplish typical operations,
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please consult the Windows Components chapter.

Building Recovery Media

Recovery Media Builder can help you accomplish the following operations:

Prepare the Linux/DOS recovery environment (included in the installation package) on external media (CD, DVD,
or flash memory) to boot and run utilities under Linux or PTS DOS, and that way to get access to your hard disk
for maintenance or recovery purposes (strongly recommended);

Prepare a custom Linux/DOS recovery environment by adding any data you like to the standard image;

Prepare a bootable recovery environment from any ISO image, including our WinPE 3.0 image (strongly
recommended);

Create from the master CD the Linux/DOS or WinPE recovery environment on a CD/DVD disc, or flash memory.

Below you can find how to build our WinPE 3.0 based recovery environment on a thumb drive:

1.

Plug in a thumb drive of at least 250 MBs in size. Please note all data on that drive will be deleted.
Launch the Recovery Media Builder. There are several ways to do it:

e Inthe Main Menu: select Tools > Recovery Media Builder...

e On the Common Tasks Bar: click the Recovery Media Builder item of the Wizards menu.
On the Wizard's Welcome page, click the Next button.

Select the Flash Memory option.

@ Rash Memory
Selact this option to create the recovery environment on a flash memory media, Thus you will get all
recovery features avaiable in the program on a compact. reliable. and fast device frecommended)
CD/DVD
Selact this option to create the recovery environment on 3 CD/DVD. Thus you wil also get a bootable

CD or DVD with all recovery features avalable in the program (ndispensable in case your computer
does not support booting from USB drives)

5. Select the User specified CD/DVD image (.iso file) option, then browse for an ISO image of our WinPE 3.0

recovery environment or manually type in a full path to it. By selecting the Typical option you can build our
Linux/DOS recovery environment, which we highly recommend you to do as well.

Typical
Use the standard Recovery Media image suppled with the program
o User specified CD/DVD image (.iso file)
Use CD/DVD image from specific location
E-/Downloads/Paragon/winpe20_BR10_Sute-eaam iso [ Browse
Copy from a CD/DVD
Choose a source CD/DVD dive
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You can get an ISO image of our WinPE 3.0 recovery environment through the company’s
web service.

6. Select the required thumb drive from the list of flash memory devices available in the system at the moment (if
several).

Forailable drives:
Dviwe Supported Formats
drive #4 (500 MB)

7. You will have to confirm the operation.

WARNING: As a result of this operation ALL DATA on the flash memory media will be ERASED.
Click "OK" if you agree or ‘Cancel’ if you do not.

i; OK | Cancel

Booting from the Linux/DOS Recovery Media

The Linux/DOS recovery environment can be used to boot your computer into Linux or PTS DOS to get access to your
hard disk for maintenance or recovery purposes. It also has the PTS DOS safe mode, which may help in a number of non-
standard situations such as interfering hardware settings or serious problems on the hardware level. In this case, only
basic files and drivers (such as hard disk drivers, a monitor driver, and a keyboard driver) will be loaded.

Startup
To start working with the Linux/DOS recovery environment, please take the following steps:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery

2 environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Launch a boot mode you need (Normal, Safe, Low-Graphics Safe) in the Boot menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Click on the required operation to start. Hints on the selected at the moment item will help you make the right
choice.

4. Consult the help system by pressing ALT+F1 to know more on the subject.

Boot menu
The Boot menu contains the following commands:
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F.+ MHormal Mode Hain recouvery
& Safe Mode enuvironment

& Low-Graphics Safe Mode

= Floppy disk

& Hard disk B HER

& Find 0Ses on your hard disks

e Normal Mode. Boot into the Linux normal mode. This mode uses the full set of drivers (recommended);

e Safe Mode. Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux normal mode if it
fails to work properly;

e Low-Graphics Safe Mode. Boot into the PTS DOS safe mode. In this case, only the minimal set of drivers will be
included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu;

e Floppy Disk. Reboot the computer from a system floppy disk;
e Hard Disk 0. Boot from the primary hard disk;

e Find OS(s) on your hard disks. The program will scan hard disks of your computer to find any bootable operating
system.

To move within the menu, please use the arrow keys of the computer keyboard.

While working with the recovery environment you might experience some inconvenience
caused by possible video artifacts. It is just a result of changing video modes and in no way
will affect the program functionality. If this is the case, please wait a bit and everything will
be OK.

Normal Mode
When the Normal mode is selected, the Linux launch menu appears:
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You can create, delete and format hard disk

Paragon Partition Manager™ partitions wsing Paragon Parition Manager™,
which will stan now. Upon the star, please
Restore Wizard select the drive and one of its partitions or its

free space. Then activate the Panition’
_ _ pulkdown menu and select one of the
File Transfer Wizard partitioning operations.

%o+ £F

\

Boot Cormrector

Metwork Configurator

Log Saver

View the mounted partitions
Stan the command line
Eject CD/DVD

Reboot the computer

Power off

@O B B%E.

e Partition Manager (enables to copy and back up separate partitions or entire hard disks, carry out partitioning
operations, etc.);

o Simple Restore Wizard (allows restoring hard disks and partitions);

e Express Resize Wizard (enables to increase free space on one partition by up-taking the unused space of an
adjacent partition);

e File Transfer Wizard (allows coping files/folders to another disk or a partition as well as recording them to
CD/DVD);

e Boot Corrector (helps to correct the Windows System Registry without Windows being loaded);

o Network Configurator (enables to establish a network connection under Linux);

If you are going to use network resources, first launch the Network Configuration Wizard to
establish a network connection.

e Log Saver (helps to collect and send the necessary log files to the Technical Support);

e View the mounted partitions (the list of all mounted partitions will be displayed);

The Linux/DOS recovery environment assigns drive letters to partitions the way it is done in
DOS, i.e. one after another, primary partitions at first. Thus mounted partitions may have
different drive letters from Windows.

e Eject CD/DVD;
e Command Line (allows experienced users to execute any operation);

e Reboot the computer;
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o Power off the computer.
To move within the menu, please use the arrow keys of the computer keyboard.

Safe Mode
When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same functionality as for the
Normal mode except the Network Configurator and Log Saver commands. Besides due to certain limitations of the PTS

DOS environment, there is no possibility to burn CD/DVD discs.

Low Graphics Safe Mode
When the Low Graphics mode is selected, the PTS DOS launch menu appears. It has the same functionality and looks

similar to the Safe mode but graphically simpler.

g Partition Manager 11 You can create, delete and

# Simnple Restore Hizard format hard disk partitions
HE File Transfer Wizard using this program, which
[E] Boot Corrector will start now.

Upon the start, please
M Start the command 1ine select the drive and one of
¥ Reboot the computer its partition=s or its free

space. Then activate the
'Partition’ pull-down memu
and select one of the
partitioning operations.

Booting from the WinPE Recovery Media
The WiInPE recovery environment can be a real alternative to the Linux/DOS recovery environment. Providing nearly the
same level of functionality it offers an excellent hardware support and the same interface as the Windows version does.

Startup
To start working with the WinPE recovery environment, please take the following steps:

1. Start up the computer from our WinPE recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery
f environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Once it has been loaded, you will see the License Agreement. Read the agreement and then mark the
appropriate checkbox to accept. If you do not agree with any conditions stated there, you won’t be able to use

the program.

Copyright© 1994-2010 Paragon Software Group. All rights reserved.



19

License i

Press Page Up and Page Down 1o scroll the text

End User License Agreement ﬂ
petwesn

PARAGON Technolcgie GmoM,

Systemprogrammierung

Heinrich-von-Stephan-Sir. 5 ¢, 79100 Freiburg, Germany,

and

You, &s end yser

If ¥Oou accept the terms of the agreement, click the check box below

[V } agcept the terms in the License Agreement |

A‘m I Decline I

3. Once you accept the agreement, you will see the Universal Application Launcher. In general it enables to run

components of the product, load drivers for undefined hardware or establish a network connection.

Paracon

SOFTWARE GROUP

Paragon Partition Manager™ 11 . S‘

Partitioning

Partitioning
What would you like to do?
Copying and (
_— M ratign #) Create Partition
9 _ A Create a new parttion and set &s properties.
t!—j SR # Delete Partition
* Rescue A Delete existing parttion and 2l data & contains
E Boot Management ‘ Resize Partitions
- Move border of adacent parttions of the same type (both logical or both pamary) to redistribute
space between them. Note: this wizard covers only basic resize scenanos. ff resize operation cant
be camed out with Express Resize Wizard, please switch to Partition Manager main launcher,
o right click on a partition you would like to resize and select "Move/Resize Partition”.
/\ Tools
# Merge Partitions
T & Merge two adizcent partitions with the same file system and the same type (primary to prmary or
@ Partition Manager logical to logical).
o Support Contacts
© Help g8 Restart (@) Shutdown

4. Click on the required operation to start. Hints on the selected at the moment item will help you make the right
choice.

5. Consult the help system by pressing ALT+F1 to know more on the subject.
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case it doesn’t have a driver for your disk controller, your hard disks will be unavailable.

: Our WinPE 3.0 based recovery environment offers excellent hardware support. However in
Please consult the Adding specific drivers scenario to know how to tackle this issue.

Basic Concepts

This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general
notion of the operation performance and makes it easier for the user to operate the program.

System and Data Protection

The data protection issue is a growing cause of worrying for more and more people today. Indeed, it is hardly to find a
person who will be particularly happy when all precious information on the hard disk is irreversible lost as a result of its
malfunction. So how this tragedy can be prevented?

Backup Storage
Our program supports major present day techniques of storing backup images. Let’s take a closer look at them all to
understand what kind of storage is able to provide better security:

e You can place a backup image to a local mounted or unmounted (without drive letter assigned) partition.
Despite the fact that it is the most convenient way, try not to use it. You can delete your backup just by accident
or lose it as a result of a hardware malfunction, or a virus attack;

e You can place a backup image to an external mounted storage to provide for a higher level of data protection
and system independence;

e You can place a backup image to external media (CD/DVD) to guarantee a high level of data protection as long
as the backup media is kept secure;

e You can place a backup image to a network drive to stand a better chance of success in case of a hard disk
failure. Moreover, by storing it on a special-purpose server you may be pretty sure nothing will happen to it.

Adaptive Restore

Windows family operating systems are notorious for their excessive sensibility to hardware, especially when it turns to
replacement of such a crucial device as HDD controller or motherboard — actually Windows will most likely fail to boot
as a result of this operation.

With our technology (available in the P2P Adjust OS Wizard) you can make your Windows bootable on some other
computer by allowing automatic injection of all required drivers and the other actions crucial for a migration of this
kind. Actually, this operation for Windows 2000/XP/Server 2003 and Windows Vista/7/Server 2008 differs a bit, so does
the wizard’s work algorithm.

Adaptive Restore for Windows 2000/XP/Server 2003
It actually implies three operations:

e Providing the ability to change the Windows kernel settings to the most suitable for your new configuration.
The program will automatically add all available Windows HAL and kernels to the boot menu (the boot.ini file)
to choose the required platform in case your system fails to boot (Uniprocessor, Multiprocessor, or Old legacy
PC without ACPI). You can later remove them from the menu either under Windows or with Boot Corrector.
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A If you’ve got a 64-bit operating system, no options will be added to the boot menu.

e Automatic replacement of the boot critical drivers (HDD controller, PS/2 and USB mouse and keyboard) to the
default Windows drivers to provide the maximum level of compatibility. Once your Windows starts up, it will
initiate reconfiguration of all Plug'n'Play devices, so we do recommend you to provide the latest drivers for your
motherboard and processor at this step, as it can considerably improve the overall performance of your system.

e The option to inject 3rd party drivers to guarantee your system will start up on the new hardware. Actually
you’ve got two options, either provide a path to your own driver repository (collection of all drivers to your
hardware devices located in one folder) for the program automatically pick and install only those drivers
required for your OS (recommended), or manually specify drivers critical for the guaranteed startup of your
system on the new hardware.

Adaptive Restore for Windows Vista/7/Server 2008

It is based on the fact that these operating systems do not delete their distributive driver repositories after the setup,
but simply make them inactive in the Windows Registry. So thanks to our technology these driver repositories can be
made available during the restore procedure to let Windows Vista/7 or 2008 Server automatically find and install any
lacking driver with no action from your side required, what is very convenient.

Anyway, not all drivers can be found in the built-in driver repositories, especially when you’ve got to do with specific
SCSI or Serial ATA controllers. For situations of this kind you’ve got the option to inject any 3™ party driver, either by
providing a path to your own driver repository (collection of all drivers to your hardware devices located in one folder)
for the program automatically pick and install only those drivers required for your OS (recommended), or manually
specifying drivers critical for the guaranteed startup of your system on the new hardware.

Adaptive Restore Application
Let’s consider a number of situations when the Adaptive Restore feature can help you out:

e |f you need to upgrade to newer hardware while keeping all your programs and settings intact;
e If you need to replace failed hardware and cannot find an exact match for your original system specifications.

Known Issues
1. After transferring Microsoft Vista and later versions to different hardware, you will need to re-activate license of
the system. It's normal behavior as these systems keep tracking any change of hardware. Re-activation is legally
justified in this case, as you transfer your system to another PC.

2. If you've installed several operating systems on one partition, we can only add drivers to the latest version of
0S. Microsoft highly recommends that you install an operating system on a separate partition.

3. Please note drivers are not cached during selection. That’s why if you select a driver to add to the system, but
it’s already unavailable during the operation, the program will end the operation with an error.

Paragon Hot Processing & Volume Shadow Copy Service

Offline versus Online Data Processing
In the course of time there have been developed various methods of data processing. Despite different work concept,
all of them can be divided into two principal groups: offline (cold) and online (hot) data processing techniques.
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As the name infers, offline data processing can only be accomplished when the data is in consistent state (the operating
system and all the applications are completely shut down). Actually it is the most preferable way of image creation or
data cloning, since software can obtain an exclusive right to process data that guaranties high level of operating
efficiency. However, the offline data processing is absolutely out of question when dealing with 24/7 production
environments.

In contrast, online data processing enables to create a consistent snapshot even as the data is currently modified. It is
particularly useful for systems with high availability requirements, but it won’t be accomplished until all active
transactions are complete. The point is to provide a coherent state of all open files and databases involved in a process,
taking into account that applications may still keep writing to disks. As a result an online data processing cannot boast
high operating speed.

Our program supports both offline and online methods of data processing. As far as online method is concerned it offers
its own hot processing algorithm together with the possibility to use snapshot technologies provided by the Microsoft
VSS framework.

Paragon Hot Processing Technology
Paragon Hot Processing is an online copy/backup technology for Windows NT+ family operating systems. Developed
back in 2001, nowadays it is integrated with all copy/backup solutions offered by the company.

Paragon Hot Processing is not exactly a snapshot technology, though it has much in common with it. During an online
copy/backup, the program uses the kernel mode driver HOTCORE.SYS to intercept and control disk write activity of
applications and the operating system. The hotcore driver as an integral part of the program is installed during the setup
procedure (that’s why the system reboot is required to complete the setup procedure). For the most part the driver is in
the idle mode until it is activated with the program. While in this mode it bypasses any calls having no effect on the
overall system performance, but a few kilobytes of the system memaory.

Paragon Hot Processing technology offers copy/backup of locked partitions and hard disks under Windows NT+ family
operating systems providing both high operating efficiency as well as low hardware requirements.

It is not recommended to use Paragon Hot Processing with active SQL Server, Exchange or
Oracle databases since the backup image contents may be corrupted.

Volume Shadow Copy Service

Microsoft Volume Shadow Copy Service (VSS) is designed to provide the copy/backup infrastructure for the Microsoft
Windows XP/Vista/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent point-in-
time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the leading
copy/backup solution vendors on the market, it is based on a snapshot technology concept.

Initiated by a VSS aware copy/backup utility, VSS creates snapshots for the selected volumes and represents them as
virtual read-only devices, called volume shadow copies. Once the shadow copies are created, the copy/backup utility
starts processing the data while applications keep writing to original volumes.

Unlike Paragon Hot Processing the VSS technology provides a unique possibility to make a synchronous snapshot of
multiple volumes. This very feature can be particularly beneficial when backing up active SQL Server 2003, Exchange
2003 or Oracle databases located on multiple volumes the way it is recommended by Microsoft to improve the level of
database performance and reliability, thus providing 100-percent data consistency.
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A To use VSS it is necessary to have a mounted 300 MB+ NTFS partition.

Dynamic Disks

As you probably know, MS-DOS, Microsoft Windows 95/98/Me/NT/2000/XP/Vista/Server 2003/2008 support four
primary partitions per physical hard disk, one of which can be extended. Certainly there is the possibility to create
logical drives within the extended partition. Such types of disks are called basic. Windows XP Professional, Windows
2000, Windows Vista and Windows Server 2003/2008 follow the same strategy: You can have a maximum of four
primary partitions, one of which can be an extended partition with logical drives. However, these operating systems also
introduce a new disk configuration type - dynamic disk - which must be understood to effectively configure and manage
hard disks.

Dynamic disk is a physical disk that doesn't use partitions or logical drives. Instead, it contains only dynamic volumes.
Regardless of what format you use for the file system, only Win2K computers can access dynamic volumes directly.
However, computers that aren't running Win2K can access the dynamic volumes remotely when connected to the
shared folders over the network.

Dynamic disks can co-exist on a system with basic disks. The only limitation is that you cannot mix Basic and Dynamic
disks on the same hard drive.

There are five types of dynamic volumes: simple (uses free space from a single disk), spanned (created from free disk
space that is linked together from multiple disks), striped (a volume the data of which is interleaved across two or more
physical disks), mirrored (a fault-tolerant volume the data of which is duplicated on two physical disks, and RAID-5
volumes (a fault-tolerant volume the data of which is striped across an array of three or more disks).

With dynamic storage, you can perform disk and volume management without the need to restart Windows.
Limitations:

e Dynamic disks are not supported on portable computers.

e Dynamic disks are not supported on Windows XP Home Edition-based computers.

e You cannot create mirrored volumes or RAID-5 volumes on Windows XP Home Edition, Windows XP
Professional, or Windows XP 64-Bit Edition-based computers.

Thus, the dynamic disk is a new way of looking at hard disk configuration. Dynamic disks offer you more management
flexibility without the partition limitation of basic disks. Dynamic disks can contain an unlimited number of volumes, but
they cannot contain partitions or logical drives. Dynamic storage can be particularly beneficial for large-scale businesses
when dealing with many physical hard disks involving complex setup.

GPT versus MBR

GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift restrictions of the
old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed by Intel to replace the outdated PC
BIOS, it offers a number of crucial benefits:

e Up to 128 primary partitions for the Windows implementation (only 4 in MBR);

e The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR);
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e More reliable thanks to replication and cyclic redundancy check (CRC) protection of the partition table;

o A well defined and fully self-identifying partition format (data critical to the platform operation is located in
partitions, but not in un-partitioned or hidden sectors as this is the case with MBR).

Apple Boot Camp

Boot Camp is a special utility to help you set up a dual boot system (Mac OS X and 32-bit Windows XP/Vista) on Intel-
based Macs. It enables to securely re-partition your hard disk (resize an existing HFS+ partition to create a separate
partition for Windows) and then launch the installation process. With Boot Camp all the necessary drivers will be at your
disposal. Moreover after Windows has been installed it will serve as a boot manager to choose what operating system
to start up.

It is strongly recommended not to modify the hard disk configuration with Windows Disk
Manager. Otherwise it may lead to unexpected consequences, right up to BSOD and

A inability to boot in Windows XP/Vista. Please use our program to correctly update both
MBR and GPT.

64-bit Support

The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end user.
However that is not the case when dealing with servers processing large amounts of data with complex calculations of
very large numbers. That is where 64-bit architecture comes into play.

It can boast improved scalability for business applications that enables to support more customer databases and more
simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such as memory
allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses than a 32-bit processor.
With these resources, even a very large database can be cached in memory.

Although many business applications run without problems on 32-bit systems, others have grown so complex that they
use up the 4 GB memory limitation of a 32-bit address space. With this large amount of data, fewer memory resources
are available to meet memory needs. On a 64-bit server, most queries are able to perform in the buffers available to the
database.

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For instance, system-
level utilities and programs that provide direct hardware access are likely to fail. Our program offers a full-fledged
support of the 64-bit architecture providing fault-tolerant work for such system dependent modules as Hot Processing.

Copy Operations

Hard drive duplication nowadays is becoming highly popular among PC users. That is due to some definite advantages it
can offer. First of all, many people clone hard disks just to back up data for security reasons. The present day copy
utilities enable to successfully transfer all on-disk information including standard bootstrap code and other system
service structures, thus maintaining the operating system’s working capability. In case of a system malfunction, the user
can get the system back on track in minutes. No additional configuration is required, what is very convenient.

The second possible application is the upgrade of a hard disk to a new one. The capacity of a modern hard drive doubles
every two years, thus opening up new possibilities for software developers. As a result programs become more
complicated and require considerable amount of free space. One day the user realizes that there is no more free space
left on the hard disk and the only way out is to upgrade. Usually that means that besides purchasing a new hard disk,
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the user is to face a large re-installation procedure spanning several days of tedious work. But all of this can be avoided
just by copying the contents of the old hard disk to a new one proportionally resizing the partitions.

And the last but not least is the copying of hard disks for cloning purposes. It may be of great use when setting up
similar computers. There is no need for a system administrator to install an operating system from scratch on every one
of them. It is enough just to configure one and then clone it to the others.

Drive Partitioning

As you probably know a hard drive is to be split into one or more partitions, since it cannot hold data until it is carved up
and space is set aside for an operating system. Until recently most PCs used to have just one partition, which filled the
entire hard disk and contained an OS. The situation has changed however, thanks to new cost-effective high capacity
hard drives, thus opening up numerous possibilities for PC users, such as editing video, archiving music, backing up CD
images, etc. Huge increase in space is great, but it poses a number of problems, most important of which are effective
data organization and speed.

Large drives are always going to take longer to search than smaller volumes, and an operating system is going to have its
work cut out both finding and organizing files. It is for this reason that many people decide to invest in multiple hard
drives, but there is an easy solution — drive partitioning. Partitioning lets you divide a single physical drive into a number
of logical drives, each of which servers as a container with its own drive letter and volume label, thus enabling the
operating system to process data more efficiently. Besides partitioning makes it possible to organize data so that it is
easy to find and manage. You can set aside, for instance, 40 GB of a 160 GB hard drive for the OS, 70 GB for storing
video and another 50 GB for your favorite music collections to provide transparent data storage.

It is also worth mentioning to that with a hard drive properly partitioned, such routine operations as files de-
fragmentation or consistency check will not be that annoying and time-consuming any more.

By detaching the OS from the rest of the data you can tackle one more crucial issue — in case of a system malfunction,
you can get the system back on track in minutes by recovering it from a backup image located on the other partition of
the hard drive.

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while browsing the
Internet in Linux, 100-percent sure that no virus will attack your PC, drive partitioning is a necessity. In order to run
several OSs on a single hard drive you are to create a corresponding number of partitions to effectively delineate the
boundaries of each OS.

Windows Components
In the given section you can find all the information necessary to successfully work with the Windows version of the
product.

Interface Overview

This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being
made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are
accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program
can be tackled by reading this very chapter.

General Layout
When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and
dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration.
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The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and

functionality:

Volume letter: (C) Serial number: AC18-AEDA-18AD-D2
Volume label: [No lsbell Partition ID: (<07 NTFS
Type: Prmary NTFS version: 201
File system: NTFS Volume Size: 19 95GE
Root entries: 41582 Partition size: 3395GB —
Sectors per boot: 8 Used space: 36GB
Sectors per cluster: 8 Free space: 303GB

m Common

| Copyingand M Tasks Bar | ‘@ Move/Resize Partition | LILI
£

Parttion List
Name

el

Local Disk (C:)

|[] Basic Hard Disk 0 (VMware, ViMware Vitual S SCS| Disk Dev)
€ Local Disk () Volume letter- (C)

| Basic Hard Disk 0 (VMware, VMware Vitual S SCSI |

g Local Disk (C) |
339GBNTFS |

3]

v iz

() ) ) No changes. 4

1. Main Menu
2. Tool Bar

3. Virtual Operations Bar

4, Common Tasks Bar

5. Explorer Bar
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6. Disk Map
7. Partition List
8. Properties Bar

9. Legend Bar

10. Status Bar

A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them
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to simplify the interface management.

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout.

Main Menu

The Main Menu provides access to the entire functionality of the program. The available functions are as listed below:

MENU ITEM

FUNCTIONALITY

Tools

View Log Files

View logs on the carried out operations

Send Log Files

Compress and send the log to the Paragon Support Team

Setup Boot Manager...

Manage several operating systems on one computer

Recovery Media Builder...

Restore the system even when the current operating system cannot boot
anymore

File Transfer Wizard...

Transfer data from any media

Settings... Edit the general settings of the program
Exit Exit the program
Changes

Undo “the last virtual
operation’

Cancel the last virtual operation on the List of Pending Operations

Redo ‘the last virtual
operation’

Cancel the last undo virtual operation on the List of Pending Operations

View Changes...

Display the List of Pending Operations

Apply Changes Launch the real execution of virtual operations

Discard All Changes Cancel all virtual operations on the List of Pending Operations
Reload Disk Info Refresh the current information about disks

Wizards
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Express Create Partition...

Create an NTFS partition and make it ready for work

Create Partition...

Create a partition of any file system

Format Partition...

Format a partition of any file system

Delete Partition...

Delete a partition of any file system

Express Resize Partitions...

Increase free space on one partition by up-taking the unused space of an
adjacent partition

Undelete Partitions...

Recover an accidentally deleted partition

Merge Partitions...

Merge adjacent partitions of NTFS, FAT or FAT32 file systems

Redistribute Free Space...

Redistribute available disk space of existed partitions

Install New OS...

Make your system ready to install a new operating system

Back up Disk or Partition...

Create a sector-based archive of an entire hard disk or separate partitions

Restore...

Restore an entire hard disk or separate partitions from the backup image

P2P Adjust OS...

Make your system bootable on different hardware

Copy Hard Disk...

Create a hard disk copy

Copy Partition...

Create a partition copy

Hard Disk

Convert to Basic...

Convert a dynamic MBR disk containing simple volume(s) into a basic MBR disk

Convert to Basic MBR...

Convert a basic or a dynamic GPT disk containing simple volume(s) into a basic
MBR disk

Update MBR

Update MBR (Master Boot Record) of the selected hard disk

Change Primary Slots...

Modify the primary partitions enumeration for the selected hard disk

Edit/View Sectors...

View/edit sectors of the selected hard disk

Properties...

Get in-depth information on the properties of selected hard disk

Partition

Create Partition...

Create a partition

Format Partition...

Format a partition

Delete Partition...

Delete a partition

Move /Resize...

Move/Resize the selected partition
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Convert File System...

Convert file system of the selected partition

Assign Drive Letter...

Assign drive letter to the selected partition

Remove Drive Letter...

Remove drive letter for the selected partition

Hide Partition...

Make the selected partition unavailable for the operating system

Unhide Partition...

Make the selected partition available for the operating system

Mark Partition as Active

Make the selected partition bootable by default

Mark Partition as Inactive

Make the selected partition non-bootable by default

Change Cluster Size...

Change cluster size of the selected partition

Change Volume Label...

Change volume label of the selected partition

Change Serial Number...

Change serial number of the selected partition

Downgrade NTFS version...

Decrease version of the selected NTFS partition

Change Partition ID...

Change identifier of the selected partition

Make Partition Primary...

Make the selected partition Primary

Make Partition Logical...

Make the selected partition Logical

Test Surface...

Test surface of the selected partition/block of free space

Check File System
Integrity...

Check the selected partition for possible file system errors

Edit/View Sectors...

View/edit sectors of the selected partition

Properties...

Get in-depth information on the properties of selected partition

View

Layouts Manage the Launcher layout with several predefined profiles

Toolbar Manage the Tool Bar representation: show / hide standard and navigation
buttons, text labels and large icons

Status Bar Display the Status Bar

Common Tasks Bar

Display the Common Tasks Bar

Disk Map Legend

Display the Disk Map legend

Properties and Commands

Display the Explorer Bar

Disk Map Location

Select whether the Disk Map will be located on the top of the main window or
at the bottom
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Help
Help Open the Help system (you can also do it by pressing F1)
About Open the dialog with information about the program

Q The Main Menu contents available at the moment may vary depending on the selected
object.

Tool Bar
The Toolbar provides fast access to the most frequently used operations:

BUTTON FUNCTIONALITY

Create an image of a hard disk or
partition

Resize two adjacent partitions

Copy a hard disk

Defragment the selected partition

Open the Help system

< N

Virtual Operations Bar

The program supports previewing the resulting layout of hard disks before actually executing operations (so-called
virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations
immediately, but places them on the List of Pending Operations for later execution.

The Virtual Operations Bar enables to manage pending operations.

BUTTON FUNCTIONALTY

&_:j Cancel the last virtual operation on the List of Pending Operations
6‘\ Cancel the last undo virtual operation on the List of Pending
Operations

& Display the List of Pending Operations

@ Launch the real execution of virtual operations
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‘Z\;((’ Cancel all virtual operations on the List of Pending Operations

Virtual mode is an effective way of protection from any troubles, since no operations will
be executed until clicking the Apply button for confirmation, thus giving a second chance to
weigh all pros and cons of this or that particular operation. The program politely reminds
the user that there are unsaved changes by showing the following window:

A i) There are unsaved changes.

. 0 .
Please use “" Apply command to commit them and 2 Discard command to

pemmanently undo the changes.

You can view changes history via . View Changes command and temporaty

undo of redo the operation by means of - Undo and " Redo commands.

[] Dont show this notification again

Common Tasks Bar

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program's

wizards.

The bar contains several tabs named Basic Partitioning Tasks, Advanced Partitioning Tasks, Copy and Migration Tasks,

Backup Tasks, Tools and News and Documentation. Each of these contains a separate button bar which can be folded

by clicking it.

Basic Partitioning Tasks

E:Ff-‘:; Express Create

Starting the Express Create Partition Wizard to create an NTFS partition and make
it ready for work.

Q._g' Create Partition

Starting the Create Partition Wizard to create a partition of any file system.

@'g Format Partition

Starting the Format Partition Wizard to format an existing partition to one of the
file systems supported by the program.

&
Y& Delete Partition

Starting the Delete Partition Wizard to delete a partition of any file system.

Advanced Partitioning Tasks

=)
. Express Resize

iz

Starting the Express Resize Partitions Wizard to redistribute free space between
two adjacent partitions.

=
EE_T"‘_ Merge Paritions

Starting the Merge Partitions Wizard to merge adjacent partitions of NTFS, FAT,
FAT32 file systems.

ﬁ Redistribute Free Space

Starting the Redistribute Free Space Wizard to redistribute available disk space of
existing partitions.
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[ )
@ |Undelete Partitions

Starting the Undelete Partitions Wizard to recover accidentally deleted partitions.

Copy and Migration Tasks

[@3] Copy Hard Disk

Starting the Copy Hard Disk Wizard to copy a hard disk.

£
[ Copy Partition

Starting the Copy Partition Wizard to copy a partition.

o> P2P Adjust 05

Starting the P2P Adjust OS Wizard to make your system bootable on different
hardware

Backup Tasks

ﬁTy Back up Disk or Partition

Starting the Sector Backup Wizard to create an archive of a hard disk or separate
partitions.

[E Restore Disk or Partition

Starting the Restore Wizard to restore a hard disk, separate partition, or files from
the backup image.

Tools

- File Transfer Wizard

Starting the File Transfer Wizard to transfer data from any media. Besides it
provides access to Paragon backups as regular folders to browse through their
contents or copy required files.

@!3 Boot Manager Wizard

Starting the Boot Manager Setup Wizard to easily manage several operating
systems on one computer.

h.:i Install new 05 wizard

Starting the Install New OS Wizard to install a new operating system.

Help and Documentation

Y\ g Partition Manager™ Help

Launching the help system (you can also do it by pressing F1).

'\ﬁ About Partition Manager™

Opening the page which contains information about the program. This page will
be displayed in the Explorer Bar.

Disk Map

The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at the top or at the

bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map

Location).

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with

rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the

file system of the appropriate partition.
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Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

Local Disk (C:)
4395 GB NTFS

Large-sized bars display the following information about physical disks:
e Manufacturer,
e Model.

Small-sized bars display the following information about logical disks:
e Serial number,
e Drive letter,
e Totalsize,
e File system.

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. The program
offers to choose from several types of the disk layout scaling. It's done especially to increase the program usability. For
instance, if you’ve got a high capacity hard drive containing both very large (more than 100 GB) and rather small (less
than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the
linear type) you won’t be able to see small partitions at all, but thing strips. On the other hand, if the proportional disk
layout is critical for you, the linear type is exactly what you need.

Nevertheless there’s a compromise solution — linear scaling with the minimal limit to small partitions. So if a partition is
too small it will remain readable.

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type.

« Linear
Linear Scaling Min Width

N

Lirnee Extd ReizerFS

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will
automatically display detailed information on it.

The drag-and-drop functionality is not available when the logarithmic type of the disk
layout is selected.

Explorer Bar
The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays
reference information including:

e The help system;
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e General information on the product including its name, version and a list of helpful links;
e Detailed information about disks selected on the Disk Map;
e Volume Explorer utility;
e Disk Editor utility.
According to these categories the Explorer Bar has several tabs:
e Disk View, which offers the user the following options:
- Partition List to get a clear-cut picture of the current state of the system hard disks/partitions;
- Disk Editor to view/edit sectors of the selected partition/hard disk;

- Volume Explorer to browse and export contents of the selected partition/hard disk;

- Properties to view detailed information on the selected partition/hard disk in the bright graphical form.

You can switch between these three components by clicking tabs on the left side of the
Explorer Bar.

e Help, which contains the program help and general information on the product.
You can access the desired information by clicking on the appropriate tab.

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the
company's website to look through important technical notes or download the latest updates without having to close
the program.

The program help is also HTML-oriented. You can read it and follow external links from to get additional information.

To easily navigate through browsed pages, the program provides the following functionality:

BUTTON FUNCTIONALITY

'-:E-;‘é} Return to the previously browsed
page

'-a_d;f} Open the next browsed page

% Stop loading the current page

Refresh the contents of the current
page

Partition List

The Partition List is another helpful tool that enables you to get a clear-cut picture of the current state of the system
hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list there is the
possibility to call the context-sensitive popup menu with available operations. Besides, the program provides detailed
information on all hard disks/partitions found in the system including the following properties:
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- Name,
- Volume label (if exists),
- Partition type (Primary/Extended /Logical),
- File system type,
- Size,
- Amount of used and unused (free) space,
- Start/End cylinder,
- Start/End head,
- Start/End sector
- Free size in sectors/bytes
- Active/Inactive attribute
- Hidden/Unhidden attribute

You may customize outlook of the Partition List by clicking on the arrow icon on the top right side of the panel.

%) Pleaze select properties to display.
Please select properties you would ke 1o display in the Disks and Partitions view

Hame
Size (sactors
F5 Size (sactions

Usad (sactors)

Start |sactons

b e el b ] e e e

= m
* B
]
Ll

&
]
st

By marking a checkbox opposite the required item you can choose whether to display it or not. Besides, you can change
its order by pressing the Move up or Move down buttons.

If you don’t need the Disk Map, please click the shown below icon to disable it:
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Digk Map I%

Basic Hard Disk 0 (VMware, VMware Virtual 5 SCS5I1 Disk Dev)

Local Disk (C:)
39.9GB NTF5

Properties Bar
The Properties Bar provides information on the selected at the moment partition/hard disk:

For a hard disk

Model,

Serial number,

Type of hard disk (basic or dynamic),

Total size (in GB),

Information on geometry of the disk (amount of sectors per track, heads and cylinders).

For a partition

Drive letter assigned to the disk,

Volume label (if available),

Type of the logical disk,

File system (represented by the color of the graph and the selected bar),

e Total size, used space and free space (in GB or MB).
Besides you can modify practically any partition property by clicking on the required value.

Legend Bar
The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with
the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the

Explorer Bar.

The program distinguishes between the following types of known file systems:
- FAT16/32,
- NTFS,
- Linux Ext2/3/4,
- Linux ReiserFsS,

- Apple HFS.
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Status Bar
This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to.

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar.

Settings Overview

The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections,
which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By
selecting a section from the list, you can open a set of options.

To get a detailed description to any setting, control, or field of the program just click the
hint button and then the object you need.

General Options

%, Edit settings [-7 (3]
Backin Seace cotions A General options
Copy and backup options
Hot processing options [V Enable data loss protection
CD/DVD recording options Choose this option to ensure that no data will be lost f system unexpectediy
Parttioning options goes down (because of power shortage etc )
Operation dependency options [ Enable Inttial Backup reminders
Vitual mode options _ Choose this option to enable Intial Backup reminders. Inttial Backup
Fie system conversion options guarantee the safety of your data by backing up all on-disk information
E-mail options nciuding standard bootstrap code and other system service structures before
Defragmentation options performing any critical partitioning operation,

This section contains a set of general options that will be taken into account during any operation carried out with the
program:

e Enable data loss protection. Mark the checkbox to make the program work in the fail-safe mode (also referred
to as the data-loss protection mode), which ensures reliability for operations by maintaining a special journal. In
case of a hardware malfunction, power outage or an OS failure happened in the middle of a data-sensitive
operation (resize, move, merge, redistribute, change cluster size, etc.), the program will ask to insert the
bootable recovery media and automatically complete the interrupted operation, thus reviving the corrupted
partition.

A It is strongly recommended to enable this option.

e Enable Initial Backup reminders. If this option is marked, the program will automatically offer to make a backup
before accomplishing any critical partitioning operation, thus minimizing the risk of data loss.
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Backup Image Options
D, Edit settings (7 )
. ckup image options
p image op
Copy and backup options
Hot processing options [V Control archive integriy
CD/DVD recording options Choose this option to allow wrting of speciic data that wil later be used
Partioning options during restore to check the archive integrty. k can slow down the backup
Operation dependency options operation,
Virtual mode options

[V Set image file names automatically

Fie system conversion options ,
E-mail options Choose this option to automatically name files in complex archive.
Defragmentation options - o lavel

[ Fast compression ~]

Slight compression. Provides good speed with the signficant image size.

Image spit
[V Enable mage spitting
Choose this option to enable spliting the archive to several fies

Madmum spiit size: |2000 MB 5

OK Cancel

This section contains a set of options that will be taken into account during rest

e Control archive integrity. Mark the checkbox to guarantee that all back

3-5% less time.

e Set image file names automatically. Mark the checkbox to make the program automatically set a file name for

every volume of a complex backup image. Otherwise you will need to d
operation.

e Compression level. From the pull-down list you can select the desired compression level for backup images that

will be used by default.

e Enable image splitting. Mark the checkbox to automatically split every backup image to volumes of a particular

size.

ore operations:

up images created with the program are
100 percent flawless. If you decided not to control the archive integrity, the backup operation would take about

o it manually during the backup

Splitting images enables to tackle problems caused by a maximum fi
some file systems.

le size limitation of

e Maximum split size. With the spinner control you can specify a maximu
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Partitioning Options

9, Edit settings (7 =
General options . T -
Bockain taaas coliios { @ Partitioning Options
Copy and backup options
Hot processing options [T Enable 64 KB clusters for FAT16
CD/DVD recording options Choose this option to enable 64 KB clusters for FAT16 partitions. With this
setting. you will be able to create FAT16 partitions with capacity up to 4 GB.

Operation dependency options Please note that only Windows NT family systems wil be able to access
Virtual mode options such partions.
Fie system conversion options Confimations

E-mai options [V Ask for volume label before partition delete
Defragmentation options
[~ Ask confimation when converting FAT 1610 FAT32

OK Cancel

This section contains a set of options that will be taken into account during partitioning operations:

e Enable 64 KB cluster size for FAT16. Mark the checkbox to enable 64KB clusters for FAT16 partitions. Thus you
will be able to create FAT16 partitions up to 4GB in size

Due to the maximum cluster size of 32KB for Windows 95/98/ME or MS DOS, FAT16
partitions larger than 2GB are not reliably accessible under these operating systems.

e Request confirmation before partition deletion. Mark the checkbox to activate an additional security
mechanism. Thus when going to delete a partition you will be automatically requested to enter its label.

e Request confirmation when converting FAT16 to FAT32. Mark the checkbox to automatically request
confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversion
is the only way out to accomplish the operation. For instance, you are going to migrate your system to a larger
hard disk with the proportional resize of existing partitions, what is very convenient. As a result you can get
original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no

way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition
operation involving an extra upsizing.
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General Copy and Backup Options

9, Edit settings 7 |3
Backin uigh $ General copy and backup options
Copy and backup options
Hot processing options [T Partion raw processing
CD/DVD recording options Copy/Backup each partition sector by sector. All sectors will be processed
Parttioning options one by one {even unused sectors). Requires more time to complete the
Operation dependency options operation.
Virtual mode options
Fie system conversion options r Perfonn‘ al copy
E-mail options This option is intended for copying only changes on the hard dsk since a
Def oo previous copy operation. The program performs comparison between 3

previous copy of the hard disk and s cument state. Only sectors that are
different will be written to a new copy.
[V Skip OS audiary files.

Choose this option to skip OS awodiary fles (ike pagefie sys, hberfi sys etc ).
This wil reduce operation time and backup image size.

OK Cancel

This section contains a set of options that will be taken into account during copy and backup operations:

e Partition raw processing. Mark the checkbox to copy a partition in the sector-by-sector mode to successfully
process unknown file systems. However it is not recommended to enable this option when working with
supported file systems as it takes more time to accomplish the operation.

o Perform incremental copy. Mark the checkbox to only copy changes on the hard disk from the moment of the
last copy operation. The program will perform comparison between a previous copy of the hard disk and its
current state. Only sectors that are different will be updated, thus considerably decreasing the amount of data
to write.

o Skip OS auxiliary files. Mark the checkbox to skip OS aukxiliary files (like pagefile.sys, hiberfil.sys, etc.), thus
reducing the operation time and the resulted size of the backup image.
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CD/DVD Recording Options

), Edit settings R <=
General options - -
Bockiin Magn ailns @ CD/DVD recording options
Copy and backup options
Hot processing options [T Bum every CD/DVD disk to the end
CD/DVD recording options Choose this option allow the disk to be copied by third pary tools.
Parttioning options Recordng speed
Operation dependency options ‘
Virtual mode options | Select speed automatically ~|
Fie system conversion options | Aito recording speed. Choose this option to alow the recorder to choose the
E-mail options best speed.
Defragmentation options
Boot options

Specify a bootable ISO image to place on CD or DVD along with backup
data:

I \..\ISO\bootcd iso Browse l

Specify how you would like to boot from CD or DVD:
| Boot from any CD or DVD ~|

1S0 image folder

I / Browse

Pleasa select 3 folder to place 1SO images to when CD or DVD 1SO maker is
used

oK | cace |

This section contains a set of options that will be taken into account during CD/DVD burn operations:

e Burn every CD/DVD to the end. By default, the program does not create 1ISO 9660 compliant burning sessions,
as it processes data on-the-fly and can only estimate the resulted session size. That’s why no third party tool will
get access to the recorded data. To tackle the issue, mark the checkbox to make the program create a standard
Disk-at-Once session. It may slow down the burning process, as every CD/DVD will be recorded up to the end,
no matter how much actual information to contain.

e Recording speed. The user may define how fast a CD/DVD will be recorded (minimum, normal and maximum).
Besides there is an automatic mode when the program will set the most appropriate speed for every CD/DVD.

e Bootable ISO image. That’s the image to be placed together with the backup data. By default, the program
offers its own bootable ISO image, which contains a Linux/DOS recovery environment. However, the user is free
to use any bootable ISO image.

e CD/DVD boot capability. The program enables to choose whether any recorded CD/DVD will be bootable, or
only the first one for a session, or without that function at all.

e Folder where the ISO image is to be placed. When the user decides not to physically burn a CD/DVD, but create
an I1SO image file, this very folder will be used to contain these images.
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Hot Processing Options

S, Edit settings [-7 [

General options . )
Backup image options % Hot processing options

Copy and backup options

¥ Enabl hot processng

CD/DVD recording options

Hot processing technology
Parttioning options
Operation dependency options | Microsoft Volume Shadow Copy Service ~|
Virtual mode options Microsoft Volume Shadow Copy Service is a relisble technology designed
Fie system conversion options to back up volumes being locked by numerous active transactions of VSS
E-mail options supporting applications. Microsoft VSS technology requires over 300 MB
Defragmentation options of free space on any mounted NTFS volume for temporary data. This

technology is provided for Windows XP and newest Windows versions,
but unavailable for old versions of Windows (S8/ME/NT/2000)

Addtional options
" Aways use hot processing
(¢ Use hot processing only when partition is locked
Hot processing temporary drive;
[c =]
Number of attempts to start VSS: 3 5
Timeout between attempts fn seconds): [120 <
[V Switch between Hot Processing technologies

OK Cancel

In this section you may configure the hot processing mode:

e Enable hot processing. Mark the checkbox to enable the so called hot data processing mode that is specially
designed to process data without restarting your operating system.

e Hot processing technology. From the pull-down list you can select the required hot processing technology.

e Always use hot processing. Select the option to process partitions without making them locked. Thus you will
be able to keep working with them as usual.

o Use hot processing only when partition is locked. Select the option to use the hot processing only when
partitions are locked and cannot be processed without restarting the computer. Please keep in mind, that once
you start any operation on a partition in this mode, it will automatically be locked by the program, thus you
won't be able to keep working with it as usual.

e Hot processing temporary drive. Here you can select a disk drive that will be used to store the temporary hot
backup data (by default — C:).

e Attempts to start VSS. Here you can set how many attempts to start Microsoft VSS the program is to do before
automatically rebooting the system and accomplishing the operation in a special boot-up mode.

o Timeout between attempts (in seconds). Here you can set a time period between different attempts to start
Microsoft VSS.
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o Switch between hot processing technologies. Mark the checkbox to automatically switch between Paragon Hot
Processing and Microsoft VSS if one of them is unavailable at the moment.

E-Mail Options

%, Edit settings 7 )=
General options B = - ,
Buckin Seace cotlosd E-mail options
Copy and backup options
Hot processing options Specify your e-mail account options:
CD"IDVD recording options Outgoing mail server (SMTF): [—
Parttioning options
Operation dependency options User e-mail address:
Virtual mode options l-—
Fie system conversion options SMTP port number. 2
W' My outgoing server requires authentication
Defragmentation options
User name: [
Password: I
Specify e-mail notification oplions:
V¥ Send E-Mail notfication on apply
To: r
[T Send mail in HTML format
[T Send complete report after applying operations
I_ ;’. NG grapnical view Of UNe AisK SUD-System Desore 3nNa e apply
Select the operations you would like to be notfied about
OK Cancel

This section contains a set of options that will be taken into account during the Send log files and Send e-mail
notification operations:

e Outgoing mail server (SMTP). To send messages by using the built-in mail client, it is necessary to have access to
a computer running an SMTP (Simple Mail Transfer Protocol) server. All outgoing messages are first sent to the
SMTP server, which in its turn delivers them to the required recipients. The address may be represented as a
traditional Internet host name (e.g.: mail.com) or as an IP numeric address (e.g. XXX.XXX.XXX.XX).

e User e-mail address. Specify an e-mail address that has been assigned by the Internet Service Provider or
organization's e-mail administrator.

e My outgoing server requires authentication. Activate the option to allow the program to make authentication
on the server before sending messages.

- User name. Enter the name that will be used to log in to the e-mail account.
- Password. Enter the password that will be used to access the mail server.

¢ Send e-mail notification on apply. Specify an e-mail to send notifications on the carried out operations.

Copyright© 1994-2010 Paragon Software Group. All rights reserved.



44
- Send mail in HTML format. Activate the option to create messages in the HTML format instead of plain text.

- Send complete report after applying operations. Activate the option to create an in-depth report on the
carried out operations and send it after performing the last operation.

- Send graphical view of the disk sub-system before and after apply. Activate the option to allow the program
to attach two pictures of the disk layout made before and after the operation is completed.

By clicking the link at the bottom of the window you can jump to the Operation
Dependency Options.

VAN

Operation Dependency Options

9, Edit settings 2 -

General options

Backup image options
Copy and backup options
Hot processing options
CD/DVD recording options

Operation dependency options

Please select a task to be camed out when one or more of the following
operations are commited

Parttioning options Pedorm the task: | Send e-mai notffication v |
:
Virtual mode options Operation ] =
Fie system conversion options F’—' Adjust OS to boot on new hardware

E-mail options [V Adust OS to boot on vitual hardware

vV Boot record comection

v Change NTFS version

[V" Change SID

v Check file system

v Compact SMFT

v Convert Dynamic Disk to Basic
v Copy partition

f’7 Copy partition with files exclusion

Defragmentation options E Backup partition or disk

Select al l Clear all Restore defaults |

oK |

This section contains a set of options that will be taken into account when the Send e-mail notification on apply function

is enabled. By marking/unmarking a checkbox opposite the required operation you can choose whether to receive an e-
mail notification on its completion or not.

A You won't be notified if an operation requires the system restart.
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Virtual Mode Options
& Edit settings R =
General options ﬁ .
Backip buage ocf Virtual mode options
Copy and backup options
Hot processing options r~Operations mode
COVDVD recording options ¥ Allow vitual mode
Parttioning cptions Set this option on to camy out all the operations virually, You will be able
Operation dependency options to commit the changes or rollback all of them or the last one. if you
switch this option off, the operations wil be camied out immediately.
Fle system conversion oplions
E-mail options [T Oose prograss dialeg automaticalky
Defragmentation options Set this option on to automatically close the progress dialog after committing
the changes

0K Cancel

In this section you may configure the virtual mode:

e Allow virtual mode. Mark the checkbox to enable the virtual mode. It is an effective way of protection from any
troubles, since no operation will be executed until confirmation, thus giving you a second chance to weigh all
pros and cons of this or that particular operation.

A We strongly recommend you to enable this mode.

e Close progress dialog automatically. Mark the checkbox to automatically close the progress dialog after
accomplishing operations.

File System Conversion Options

% Edit settings f?_, )
Bckiip Minos dalli File system conversion options
Copy and backup options
Hot processing options Select a time zone:
CO/DVD recording options | (GMT) Greenwich Mean Time: Dubin, Edinburgh, London. Lisbon ~|
Parttioning options
Operation dependency options  Select language for file names:
Virtual mode options [Engtsh (CP-850) ;]
E-mail options This language will be used to specfy national symbols in fie names.
Defragmentation options

[T Confim settings before NTFS <-> FAT/FAT32 conversion,

Choose this option to make the program to allow to customize these settings
each time when convering file systems

OK Cancel

This section contains a set of options that will be taken into account when converting FAT and NTFS file systems. By
default, the program takes locale (regional) settings from the system. Problems might occur however because of
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different standards for file names and file time stamps (Created, Modified and Last Access Time) of NTFS and FATxx file
systems.

To tackle problems of that kind you can manually set:

o Time zone to use during the convert operation. NTFS keeps file timestamps in GMT (Greenwich Mean Time)
while FAT uses a fixed local date and time. The program takes proper account of these differences and enables
to adjust timestamp values.

A An incorrectly chosen time zone might lead to inability to launch certain software.

e Language for file names to use during the convert operation. NTFS stores file names in Unicode while
FAT/FAT32 uses ANSI to save short file names (also called the DOS aliases). The codepage information is
required for the correct conversion of non-English file names from Unicode to ANSI and vice versa.

An incorrectly chosen codepage will certainly result in corruption of non-English file
‘ : k names.

e Request confirmation of settings before NTFS < - > FAT/FAT32 conversion. Mark the checkbox to automatically
display the local settings dialog to check and modify (if necessary) the default parameters before launching the
convert file system operation.

Defragmentation Options

%, Edit settings 7 s
General options F . -
Blcki Siaos ol ¥ Defragmentation options
Copy and backup options
Hot processing options Defragmentation mode
CD/DVD recording options I Safe mode fecommended) ~|

Parttioning options
Operation dependency options |~ IoW but reliable. In this mode the program requires free space on the
Vitual mode options defragmented at the moment pastition to guarantee protection of your data in
: ' case of a power outage, hardware malfunction or a system falure
te system conversion options

E-mail options

OK Cancel

In this section you may set the preferable defragmentation mode:

e Fast mode. Partitions will be defragmented rather fast (a 10-30% gain depending on the fragmentation level),
but a power outage, hardware malfunction or a system failure during the operation might lead to the data loss.

o Safe mode. To guarantee protection of your data during the operation, the program will allocate some free
space (not less than the on-disk largest file) on the defragmented at the moment partition to make a duplicate
of every processed file. Thus we strongly recommend you to use this very mode.
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Getting Information on Disks and Backup Images
The program provides some helpful tools to get information on the properties of disks and peculiarities of existing
backup images.

Viewing Disk Properties
The main tool to view in-depth information on the properties of hard disks is the Disk Map. It represents the actual state
of the computer’s hard disks.

Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized bars. The small-
sized bars represent logical disks (partitions). When you select a large-sized bar, the Explorer Bar displays information
about the disk in a bright, graphical form.

| Basic Hard Disk 1 (FUJITSU MPF3102AT)

Type: Basic Hard Disk Drive
Total size: 95GB
Sectors per track: £3
Heads: 255
Cylinders: 1245

Create an image of the entire disk
Back up 3l the data this hatd disk containg. All the paitiions on this disk will be added to the archive,

Restore an im: of the entire disk
Warning: This operation wil delete all the data on this haid disk. Al the pattitions will be replaced with cnes from
the image you have chasen. You may also be asked to restaet your computer during thes operation

a2
&
&

Copy the entire hard disk
Create a copy of the entire haed disk
Al the patitions on this disk wil be copiad on the specified targat disk,

The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form of a
circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the right you may
see a table, which contains the following information:

e Type of hard disk (basic or dynamic),
e Total size (in GB),
e Information on geometry of the disk (amount of sectors per track, heads and cylinders).

Below there is a list of available wizards. If you click a corresponding record the appropriate wizard will be started. All
default values for the operation parameters will correspond to the disk’s settings. The list of wizards contains a detailed
description of tasks that can be performed by the wizard. This nullifies the possibility of selecting the wrong wizard.
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| Logical Disk (G:)

Volume letter: [G:) Serial number; 7493EA8F
Volume label: FAT32-LINLX Partition ID: 0:08 FAT32
Type: Primary Total size: 68GB
File system: FAT32 Used space: 57GB
Sectors per boot: 36 Free space: 1GB
Sectors per cluster: 8 Activity. Inaclive

Hidden state: Not hidden

A ‘] Create an image of the logical disk
8 Back up all the data this logical disk contains.

Restore the logical disk from an imaqe
ég Warning: This operation will delete all the data on this logical disk and replace them from the image you have
T chosen. You may also be asked to restart your computet during this operation.

C? Copy the selected partition
e Create a copy of the paitiion. A new partition wil be created and all the data will be copied there.
- You can create an exact copy. of copy only the area that is occupied by data.

When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display information on it as
well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in
accordance with the volume ratio of the used space to the free space (the light colored sector). The table on the right
will contain the following information:

e Volume label (if available),

e Type of the logical disk,

o File system (represented by the color of the graph and the selected bar),
e Total size, used space and free space (in GB or MB).

Below there is a list of wizards, which may be called for this disk. All default values of parameters will correspond to the
disk settings.

Viewing Image Properties
General information on backup archives can be obtained with the help of the Restore Wizard:

Using the Restore Wizard
There are several ways to launch the Restore Wizard:

e Inthe Main menu: select Wizards > Restore...
e |n Common Tasks bar: click the Restore item of the Wizards menu

e Select a hard disk/partition and then click the Restore an image of the entire disk/Restore the logical disk from
an image link on the Explorer Bar page.

At first, the wizard displays the Welcome page — simply click the Next button at the foot of the dialog window.
The next page refers to Browse for Archive.

You can find the required image in the browser-like window.
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("5 Restors Wizard [
Browse lor Archive
Flease select an srchive bo nestore
Lookin: [[5] Local Dusk [T} | 2w
Mame Sire | Debe -
= L,LMMKJ]
£ arc_2 1041003057578 2002010 50834 PW
gPociew Rl
- | ac_TEST &720/2010 8:15:14 PM
= | Program Fles 4720720010 5:18:27 P
+- Ji TEMP 41572010 10:36:10 PM
- Ji Users AN5201043512PH
- ) Windows £/1572010 10:32:40 PM
b L WORK 4202008 1364pM 7]
Fles of type: [ Avchive fles £l
Archive Fle Detals
Hame: Local Disk (C:)
Commant: Mo commment
Wik labed: Mo label]
Fis system:  NTFS Totsl size:  399GB
Usad spaca: 95G8 Frea space: 30 GE
Fi C/are_NEW /are_NEW FEF
To continue, click Next
ciock [ Mets | canen |

The section below (i.e. Archive File Details) displays a short description of the selected image, including:
e Information on a type of the archive contents (whether it is sector-based or file-based),
e Whether the archive is compressed or not,
e Whether the archive is password protected or not,
e The date, when the archive was created.

Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or map network
drives by clicking the appropriate buttons.

The next page (i.e. What to restore) displays detailed information about the contents of the archive.

Copyright© 1994-2010 Paragon Software Group. All rights reserved.



50

(" Restore Wizard |
What to restore
Please select an archive Eem to restore :
Flease selact one of the object (s) o restore:
hame Type Fie system | Size Lised
[=] Basic Hard Disk 1 (Unknown Modell  Infemal Hard Disk Drive 10GE
5 Local Disk () Primary Linec Swap2 5098 MB 4HE
o B Local Disk () Primary Lino: B3 14GE S81MB
i (@ New Volume () Primary NTFS 24GE 3561 MB
#- [ NEW VOLUME (E) Primary FAT3Z 14GB 4HEB
PArchive Details
Hame: Local Disk (*)
Viokume label: [No latesl]
File system:  Linux B3 Total size:  1.4GB
Used space: 58.1 ME Frew space: 1.3GE
To select where to restore the selected obiect(s). click. Nexd Data size to restore: 1.4 GB
<Back [ Net> | Cancel

If you want to restore the image contents, click the Next button. In order to cancel, click the Cancel button.

Data Backup and Rescue
In this chapter you will find all the information necessary to establish a reliable data protection system.

Creating Backup Images
We have already mentioned that the most prevalent way to protect valuable data is to create backup copies (backup
images in terms of the program) of it.

Startup
There are several ways to start the Sector Backup Wizard:

Express Launcher
e Click the Backup and Rescue button and then select Backup.
Launcher
e Inthe Main Menu: select Wizards > Back up a Disk or Partition...
e Onthe Common Tasks Bar: click the Back up a Disk or Partition item of the Wizards menu.
e Inthe Toolbar: click the Back up a Disk or Partition button.

Setup
The wizard offers the following steps to accomplish the backup operation:

o The object to back up. You can back up either an entire disk or separate partitions of the disk (primary,

extended or logical). In case of backing up an entire disk, you’ve got the possibility to include into the image
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such disk elements as the Master Boot Record (MBR) and the first track of the hard disk. This can be very helpful
for serious disk recovery procedures.

Name Type R~
= G My Computer My Comprter
= [l [7] Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dev) Intemal Hard Disk Drive
= [l 75 First Hard Disk Track First Track
@A Svoserbonfocod % .
€ Local Disk (C) Primary N
[7] Basic Hard Disk 1 (VMware. VMware Vitual S SCSI Disk Dev) Intemal Hard Disk Drive
£ First Hard Disk Track First Track
(&7 Master Boot Record MER

e Backup destination. The wizard allows saving backup archives to local or network drives, to physical partitions
(without drive letters assigned), or burning them to CD/DVDs. You need to select a destination, taking the
estimated archive size and available space on the backup destination into account.

There are several ways the Wizard can store your data. Please salect how would you like to save the
archinve:

" Buerni the data te CD ar DVD.

e Name and location of the resulted image. Provide a file name for the new image and its exact location. The
program automatically offers an easy to understand name containing the date and the time of the archive
creation, which can anyway be modified.

Select & folder where archive should be placed and speciy archive name. Archive name will be used as a
sub-folder where backup data files will be stored
Archive location: |Gio/arc_test/ L .

e Size | Date
=1 ] My Computer

4[] Local Disk (C))

#- [5] Local Disk (E)

1 [5] Archives G

+ jm&gﬂ:&[\\mﬂ'l1£’r‘#:'[z:'
1~ L] Matwork

Archive detais

Archive name are_tes)|

Estimated archive size: 2 MB
Space available on backup destination: 38 GB

The program automatically calculates size of the future archive and informs the user about
space available on the selected destination.

e Archive Comment. You can add some additional description to the archive that will later help to distinguish it
from the others.

Plaase enter a shod comment bo describa the archive

{\. o comment
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In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to mark the appropriate option on the second page of the wizard. When it is
marked, the next page enables to define:

e Whether the archive integrity will be controlled.

Checking archive integrity enables to guarantee that all backup images created with the
A program are 100 percent flawless. Nevertheless if you decided not to control the archive

integrity, the backup operation would take about 3-5% less time.

e Whether image file names will be set automatically in complex archives.
e Compression level for the backup image (including the No compression variant).

e Whether the archive will be split (if yes, you can set the maximum size for the archive files).

Splitting images enables to tackle issues caused by a file size limitation of some file
systems.

e Whether the archive will be protected by password.

e Whether the selected disk (or the selected partition) will be copied in the sector-to-sector mode (including
unused sectors as well).

e Whether the OS auxiliary files (pagefile.sys, hyberfil.sys) will be included in the backup image.
e Recording speed when the user wants to burn the backup image onto CD/DVDs.
e |SO image folder where the archive that is to be recorded on a disc, is placed.

o Whether the operation will be performed without rebooting the system. The program needs to reboot the
system in order to have exclusive access to processing data. In a Windows environment this is difficult to
achieve because even when all the other applications are closed, the system service programs are still running.
However, there is a way to avoid rebooting. The mode of processing the backup operation without rebooting is
named Hot Processing. You can also define specific parameters for the Hot Processing mode.

Result
After the backup operation is completed you receive an image of the selected disk (or the selected partition). This image
is placed into the specified destination, its features defined by the wizard.

Available operation scenarios:

e Backing up a hard disk or partition to external media (CD/DVD)

e Backing up a hard disk or partition to a network drive

e Backing up a dual boot Mac to an external USB drive

Restoring System and Data
The program includes a convenient and reliable restore wizard. With its help you can restore all types of backup images
created with the program. It provides easy to understand instructions to configure and perform all the necessary
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settings. Moreover you can get an in-depth description to any setting, control, or field of the wizard just by clicking the
hint button and then the object you need.

Startup
There are several ways to start the Restore Wizard:

Express Launcher
e Click the Backup and Rescue button and then select Restore.
Launcher
e Inthe Main Menu: select Wizards > Restore...
e On the Common Tasks Bar: click the Restore item of the Wizards menu.
e Inthe Toolbar: click the Restore Wizard button.

Setup
The wizard offers the following steps to accomplish the restore operation:

e A backup image to be restored. The Browse for Archive page enables to find a backup image you need.

You can find the required image in the browser-like window. The section below (i.e. Archive File Details) will also
display a short description of the selected image.

Lookin: [[5] Local Disk (C) Y BxE
Name Size | Date 1=l
= [5] Local Disk (C)
% | arc_210410030357578 4/20/2010 8:08:34 PM
- P </20/201054240PH
J, ,arc_TEST 4/20/2010 8:15:14 FM
+ . Program Files 4/20/2010 5:18:27 PM
- |, TEMP 4/15/2010 10:36:10 PM
i ) Users 4/15/2010 4:35:12FM
5 ) Windows 4/15/2010 10:32:40 PM
. L WORK 4/20/2010 B:13:44 PM ﬂ
Files of type: | Archive files =]
Archive File Details
Mame: Local Disk (C:)

Comment: Mo comment
Volume label: [Mo labed)

File system: NTFS Total size:  339GE
Used space: 95.95GB Free space: 30GB
File: C:v/arc_NEW/arc_NEW PEF

Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or map
network drives by clicking the appropriate buttons.
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A To know more on the subject, please consult the Viewing Image Properties chapter.

Sector Backup Restore

e Data to restore. You’ve got the option to restore not only the entire archive, but separate items of it (the so
called selective restore functionality) by marking checkboxes next to the data items you need.

Please select one of the object(s) to restore:

Name Type Fle system | Size Used
2 [5] Basic Hard Disk 1 (Unknown Model) intemal Hard Disk Drive 10G8
& Local Disk () Prmary Linx Swap2  509.8 MB 4KB
? Local Disk (1) Prmary Linux B3 14GB S581MB
= (@ New Volume (F) Prmary NTFS 24GB 3563MB
- . '/'
Y voges
+ | System Volume Infoem
7 [ENEW VOLUME (E) Prmary FAT32 34GB 4KB
Archive Details
Name: New Volume (F:)
Volume label: New Volume
He system: NTFS Total size: 24GB
Used space: 3563 MB Free space: 2GB
To select where to restore the selected object(s). click Next Data size to restore: 132.8 KB

e A place to restore. Selecting the destination, please note - all contents on the disk selected for restoring
purposes will be deleted during the operation.

Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dev)
I ©) Local Disk (C:)
499.9GB NTFS
Basic Hard Disk 1 (VMware, VMware Virtual S SCSI1 Disk Dev)

|
' @) Local Disk (E2) ©) Local Disk.... Q) - I l @) (Unalioc..
34GBFAT32 24GBNTFS 14G.. 22GB

To help you get a clear-cut picture of the operation outcome, the program allows inspecting the resulted disk
layout.

Restoring Partition:

o Size of the restored volume and free space before and after it on the disk.

Geometry Restore Options

Please specfy the size of the restored parttion 2470 | 36 MB-2470 MB
Pleasa specfy size of free space before the parttion: 0 4 OMB-2434MB
Pleasa specfy size of free space after the parttion 0 * OMB-2434 MB

o Drive letter assignment after restore. The pull-down list contains vacant drive letters that can be associated
with the restored partition.

Parition Restors Options
Aasign the following drive letter: | F El
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Restoring Hard Disk:

e Copy data and resize partitions proportionally. If this option is activated, the program proportionally changes
the size of partitions keeping their relative order intact. The option can be useful when restoring to a larger hard
disk.

e Perform surface test. Define whether the surface test will be accomplished during the operation or not.

Your hard disk after the changes

Basic Hard Disk 1 (VMware. VMware Vidual S SCSI Disk Dey)
@ oL Disk () l ©) Local Disk ) I I ©) (Unalloc
34 4;‘;::’.“::‘ 2AGBNTES 146G 22GE
Hard Disk Restore Options
Copy data and resize paritions proportionally

In this mode, the Wizard changes the size of partitions in the same proportion, with keeping intact their
relative order. This option can be usaful in restring an image of hard disk to a larger one.

Pedform suface test

Set this option f you want the Wizard to pesform the suface test on the target hard disk. In this case, £ the
program finds bad and unreliable sectors & will mark them as unusable ones

All contents on the disk selected for restoring purposes will be deleted during the
operation.

Result
The wizard will restore the archived data, and make it available to use in the operating system.

To make a Win2K+ operating system bootable on different hardware, please additionally
complete the P2P Adjust OS Wizard.

Available operation scenarios:

e Restoring a system partition from external media (CD/DVD)

e Restoring a system partition from a network drive

e Restoring a system partition from a local drive

e Restoring a dual boot Mac from an external USB drive

e Copying of data from the corrupted system disk to another hard disk

e Burning of data from the corrupted system disk to CD/DVD

e Copying of data from a backup to the corrupted system partition

e Restoring separate files and folders from a backup

Copy Tasks

In this chapter you will find all the information necessary to make a copy of a hard disk or a separate partition.
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Cloning Hard Disks

You can clone a hard disk of any file system. During the hard disk copying process, the program moves controlling
records of used partitioning scheme, the bootstrap code and on-disk partitions. That’s why this operation cannot be
substituted by simply copying all on-disk partitions.

The program offers the Copy Hard Disk Wizard that can help to clone a hard disk.

Copy Hard Disk Wizard

The Copy Hard Disk Wizard is a traditional-like wizard. By going through its steps, you configure all the necessary
settings to launch the copy operation. To minimize the possibility of making any mistake, the wizard provides auxiliary
information on every single option. Moreover you can get an in-depth description to any setting, control, or field of the
wizard just by clicking the hint button and then the object you need.

A You need at least two hard disks to carry out this operation.

Startup
There are several ways to start the Copy Hard Disk Wizard:

Express Launcher
e Click the Copying and Migration button and then select Disk Migration.
Launcher
e Inthe Main Menu: select Wizards > Copy Hard Disk...
e Onthe Common Tasks Bar: click the Copy Hard Disk item of the Wizards menu.
e Inthe Toolbar: click the Copy Hard Disk button.

Setup
The wizard offers the following steps to accomplish the copy hard disk operation:

e The hard disk to copy. Select a hard disk you want to copy.

On this page, you can choose a hard disk you would like to copy. All partitions from this hard disk will be copied
to the destination you will choose on the next page.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

I @) Local Disk (C:)

499 9 GB NTES

| Basic Hard Disk 1 (VMware, VMware \nnua[%s SCS! Disk Dev)

@) Local Disk (E) l ©) LoclBasic Hard Disk 1 (VMware, VMware Virtual S SCSI D
34 GBFATAZ 2AGENTFS 4G, || [ENZZGE

o The target hard disk. Select a hard disk (if several) where all data of the source disk will be copied to.
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Select a target hard disk. Al data from the source hard disk will be copied there. During copy operation, target
disk content wil be deleted

' Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

[Basnc Hard Disk 0 (VMware, VMware Virtual S SCSI Disk De-.')]

Q_))Locd[)«sk(C)

e Copy parameters. The wizard enables to specify the following options:

Choose copy options that sult best your task
Copy options:
{ HOD raw cooyA
Parttions raw copy
Pesform incremental copy
Change masks for files to exclude from copy
Resize options:
Remove free blocks between paritions
Copy data and resize partitions proportionally

Mark the checkbax to copy the hard disk in the secfordysectormode, thus ignorng s
=, information structure (e g. unallocated space or unused sectors of existing parttions will be
\l) processad as well). This can help to avoud problems with hidden data created by cetan
apobc&m or the system admnistrator. However, & will take more time to accomplish the

Copy options

- HDD raw copy to copy the hard disk in the sector-by-sector mode, thus ignoring its information structure (e.g.
unallocated space or unused sectors of existing partitions will be processed as well). This can help to avoid
problems with hidden data created by certain applications or the system administrator. However, it will take
more time to accomplish the operation.

- Partition raw copy to copy the on-disk partitions in the sector-by-sector mode to successfully process
unknown file systems. However it is not recommended to enable this option when working with supported file
systems as it takes more time to accomplish the operation.

- Perform incremental copy to only copy changes on the hard disk from the moment of the last copy operation.
The program will perform comparison between a previous copy of the hard disk and its current state. Only
sectors that are different will be updated, thus considerably decreasing the amount of data to write.

Resize options

- Remove free blocks between partitions not to keep blocks of free space between partitions on the targeted
hard disk.

- Copy data and resize partitions proportionally to make the program proportionally change the size of
partitions keeping their relative order intact. The option can be useful when upgrading the hard disk to a larger
one.

Verification options

This section allows you to define whether the Surface and/or the Writing verification tests will be accomplished
during the operation.
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Result
After the operation is completed, you receive a fully functional duplicate of the existing hard disk.

To make a Win2K+ operating system bootable on different hardware, please additionally
complete the P2P Adjust OS Wizard.

Available operation scenarios:

e Migrating system to another hard disk (Clone HDD)

Cloning Partitions

You can duplicate partitions to protect oneself from downtime in case of a system malfunction or for cloning sample
partitions. The program enables to duplicate all partition data including files, the exact structure of directories and file
system metadata (location of files, security information, access quotas, etc.).

The Copy Partition Wizard will help you copy a partition of any file system. To minimize the possibility of making any
mistake, the wizard provides auxiliary information on every single option. Moreover you can get an in-depth description
to any setting, control, or field of the wizard just by clicking the hint button and then the object you need.

Startup
There are several ways to start the Copy Partition Wizard:

Express Launcher
e C(lick the Copying and Migration button and then select Copy Partition.
Launcher
e Inthe Main Menu: select Wizards > Copy Partition...
e Onthe Common Tasks Bar: click the Copy Partition item of the Wizards menu.
e Inthe Toolbar: click the Copy Partition button.

Setup
The wizard offers the following steps to accomplish the copy partition operation:

e The partition to copy. Select a partition you want to copy.

On this page you can choose a volume to copy

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dey)

l ©) Local Disk (C:)
4939 GB NTFS

Basic Hard Disk 1 (WMware, VMware Virtusal S SCS1 Disk Dey)

I @) Local Disk (E2) I ©) Local Dis... Q) - I . ©) (Unallo
" 34GBFATR2 24GBNTFS | 14G.. 22GB

e Destination disk. Select a hard disk with enough unallocated space to perform the operation.
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The wizerd will create 3 copy of Local Disk (F:)from Basic Hard Disk 1 (Viware, VMware Virtual 5
SC51 Disk Dev)

The copy will be created on Basic Hard Disk 3 (VMware, VMware Virual 5 SCS1 Disk Dev)
Fleasa sslact where to create a copy:

Basic Hard Disk 3 (VMware, VMware Virdual 5 SC51 Disk Dev)

I &) (Unallocated)
19.9GB

The program enables to copy a partition to a block of free space, which is smaller than the
partition itself, taking into account only actual amount of data.

o Copy parameters. The wizard enables to specify the following options:

Your hard disk after chamnges

Basic Hard Disk 3 (VMware, VMware Viduad 5 5051 Disk Dev)

I ) (Unallocated)

Where to place a copy
Please specify the size of the new partiion 1824 T 39 MB - 20473 MB

Please speciy size of free space before the pariion: S DMB - 20434 MB
Please speciy size of free space afterthe patition: 16843 & 0 MB - 20,426 MB.

- Partition size. Define the size (in Mb) of the copied partition.

- Free space before. Define the position (in Mb) of the copied partition relative to the beginning of the available
range of disk space.

- Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of disk
space.

Partition size and position may also be defined by using the drag-and-drop technique. To do
that, just carry out the required operation on the Disk Map.

Result
After the operation is completed you receive a fully functional duplicate of the existing partition.

To make a Win2K+ operating system bootable on different hardware, please additionally
complete the P2P Adjust OS Wizard.

Boot Management
Our program enables to easily manage several operating systems on one computer with the help of the Boot Manager
Setup Wizard. Among the key features of the wizard the following should be mentioned:

e Up to 16 operating systems on one PC;
e Secure adding/removing of the Boot Manager startup record to/from the MBR;

e Auto Boot option to automatically start up the previously chosen OS after a certain time period;
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Hiding of any primary partition except selected at the moment.

Express Launcher

Click the Boot Management button and then select Boot Manager.

Launcher

Setup

In the Main menu: select Tools > Setup Boot Manager...

On the Common Tasks Bar: click the Boot Manager Wizard item of the Wizards menu.

The wizard offers the following steps to accomplish the operation:

Result

Hiding other primary partitions. By marking this checkbox the program will automatically assign the hidden flag
to all primary partitions of the hard disk(s) except the one selected to boot. This will help to avoid any problems
when dealing with different operating systems or different versions of one and the same OS, as they will be
unaware of each other.

Boot menu options. In this section you can switch between the following modes:

- Normal mode. Choose this mode to display the boot menu every time the computer starts up and define a
timeout on the expiry of which the program will automatically select the previously chosen item of the menu.

- Hidden mode. Choose this mode not to display the boot menu until pressing a hot key. For this mode you
should define a hot key used to enable the Boot Manager and a time period in seconds the startup message will

be displayed.

V| Timeout for booting last used configuration 15 seconds
Hidden mode
Time to display the BootManager stadup message

“hao ~ for ot nct Mananar
Choose a hot key for startup BootM anage

Deactivating/Configuring the Boot Manager. These two options will only be available once the wizard has been
completed and launched again. Select the Deactivate option to remove the Boot Manager from the MBR
(Master Boot Record) or Configure to modify the previously set parameters of the startup process.

o | Configure

Choosa this option to antar Settings page. You will be able to configure BootManager appearancas and Boot

A
]

After the Boot Manager Setup Wizard is completed the program updates the original record in the MBR to get control of
the booting process and to be able to display the boot menu.

Available operation scenarios:
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e Creating Dual Boot Systems

Partition Management
In this chapter you will find all the information necessary to carry out partitioning operations supported by the program.

Basic Partitioning Operations
Here you can learn how to accomplish basic partitioning operations (create, format, delete).

Creating Partitions
The program provides the ability to create a new partition by using the DOS partitioning scheme. This operation can be
accomplished either with the Create Partition Wizard or the Create Partition Dialog.

Besides there's the Express Create Partition Wizard that will analyze your disk subsystem to help you create an NTFS

partition in the most appropriate place of your hard disk by up-taking all the unallocated disk space (if any) and/or an
innocuous slice of the unused space of an adjacent partition, and then make it available in the system by assigning a
drive letter.

Restrictions
1. Do not use the Create Partition function in order to undelete the last deleted partition.

2. The program cannot create new partitions on Dynamic Disks. The current version of the program supports only
hard disks that use the DOS partitioning scheme (in Windows 2000 and XP these disks are named Basic Disks).

3. According to the rules of the DOS partitioning scheme, the following combinations of partitions cannot be
created:

- Two Extended Partitions on one hard disk
- Five or more Primary partitions on one hard disk
- Ifthereis an Extended Partition on the disk, only three Primary partitions are allowed

4. The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free
space on an existing partition to a new partition.

Express Create Partition Wizard Startup
There are several ways to start the Express Create Partition Wizard:

Launcher
e Inthe Main menu: select Wizards > Express Create Partition...
e Onthe Common Tasks bar: click the Express Create item of the Wizards menu.

Create Partition Wizard Startup
There are several ways to start the Create Partition Wizard:

Express Launcher
e Click the Partitioning button and then select Create Partition.
Launcher
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e |nthe Main menu: select Wizards > Create Partition...
e Onthe Common Tasks bar: click the Create Partition item of the Wizards menu.

Dialog Startup
In order to start the operation you should take the following steps:

Launcher
1. Select a block of free space on the Disk Map;
2. Call the Create Partition Dialog to set up the operation. There are several ways to do it:
e Select in the Main Menu: Partition > Create Partition.

e (Call the popup menu for the block of free space (right click of the mouse button) then select the menu item:
Create Partition.

Express Create Partition Wizard Setup

Thanks to a highly intelligent work algorithm, the wizard requires minimal involvement in the operation, thus you only

need to choose a method you find the most suitable to create the partition (if several available), which actually differ in
the amount of space to allocate. For easy perception, you can see the resulted disk layout on the disk map by selecting
this or that mode.

The result you wil get after applying the changes

Basic Hard Disk 0 (VMware, VMware Virtual S SCS| Disk Dev)

I @) Local Disk (C:) I @) data {Z:) l @) New V

Please select the method of new partition creation
Smart Mode (Usa 182.1 GBto craate a partition ) More nfo
o | Advanced Mode | (Usa 108 5 GB o create a padtition ) More nfo

The number of available methods depends on your disk layout.

A To learn more on the way the wizard works, please click the corresponding link on the first
page of the wizard.

Create Partition Wizard Setup
The wizard offers the following steps to accomplish the operation:

e Partition destination. Select a hard disk (if the computer has several hard disks) and then choose position for
the future partition on the disk: at the end (preferable), at the beginning or somewhere in the middle between
other partitions.
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O this pags you can Salact hard disk and tha placs when (0 creabe & new patiion

Basic Hard Disk 0 (VMware, VMware Virtual 5 5C5] Disk Dev) -

I ) Local Disk (C7) I ) data ()

B2 3 EE NTES 217 GE NTFS
Basic Hard Disk 1 (YMware, VMware Virtual 5 5C51 Disk Dev)

I @) Local Disk (%) L

Basic GPT Hard Disk 2 (WMware, VMware Vilual 5 SCS51 Dizk Dev)

I h. I E_,l {Unallocated)

Thc pnr'lltll:n il be created "-trt] F |

Lise the buttons to mowve the mancer or drag madcer by mouse. A new partition will b

the markeris

&
o
&
[
=]
[

1

—

A

By default, the program allows you to create a new partition only as the last primary or as
the last logical drive within the extended partition. However, by activating the advance
mode on the first page of the wizard you can remove this restriction that in its turn might
result in some boot problems.

Partition size. There is no restriction on size of the future partition, merely depending on space available on the
hard disk.

If there is not enough free space in one block, the wizard enables to redistribute free space, joining all free
space blocks together into one united block and moving partitions when necessary. If the total amount of free
space is still not enough, it is possible to split a fragment of space from one of the existing partitions, thus
resizing it.

Your hard diskz before the changes

|Basic GPT Hard Disk 2 (VMware. VMware Vitual S 5CS1 Disk Dev)

. I I @) (Unallocated)

Yeur hard disk after the changes

Basic GPT Hard Disk 2 (VMware, ViMware Virlual 5 5051 Disk Dev)

I I @) Local Disk (%)

A

If a partition to resize is locked and cannot be processed, the wizard makes the system
reboot to create the partition and then automatically boots the system again. (The
rebooting mechanism is different for different versions of Windows.)

You can also choose whether the future partition will be primary or logical by marking the appropriate
checkbox.

Partition properties. On the next page of the wizard you can set a number of additional parameters:
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Your hard disk: after the changes

Basic GPT Hard Disk 2 (VMware, VMware Virtual 5 5C51 Disk Dev)

I I qJ New Volume (E:)

Wolume |abel: | New Volume

Assign the following drive letter- | E ':l

- Partition type. From the pull-down list select a file system the newly created partition will be formatted to,
otherwise the partition will remain unformatted (so that it will not be ready to use).

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

- Surface test level. Define the level of the surface check to make the program find bad and unstable sectors and
mark them unusable in the file system metadata.

Dialog Setup
Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes
button to confirm the operation.

(-9 JeEsa)
Are you sure you wanlt lo create a new parlition on disk 37
You are about to create a new parition in (Unallocated). 19.9 GB arca. Flease select size.
position and fils system of the new pasition.
Basic Hard Disk 3 (VMware, VMware Virual 5 SC51 Disk Dev)
I 1) New Volume (H:) I
19.9GB NTFS
Create new parttion as: Primary parttion [
Plaase spacify new partibion size:; 20479 - TMB-20473 MB
Please speciy size of free space befors the parition: 0 * OMB - 20,465 MB
Please specify size of free space afterthe patition: 0 % OMB-20472 ME
Flease sedact file system for new partition: | NTFS EI
Flease snter new volume label: Naw Voluma
Flaasa spacify dive letter H EI
%) [More options l Yes ][ Mo I

e Define whether the partition will be Primary, Extended or Logical. You can choose the desired partition type
from the pull-down list. As a matter of fact, the available alternatives fundamentally depend on the selected
block of free space - within the Logical free space, only Logical partitions can be created; Within the Primary free
space, both Primary partitions or the Extended Partition can be created.

e Partition Size. Define the size (in Mb) of the new partition.

o Free space before. Define the position (in Mb) of the new partition relative to the beginning of the block of free
space.
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o Free space after. Define the amount of trailing free space (in Mb) at the end of the new partition.

Partition size and position may also be defined by using the drag-and-drop technique. To do
A that, just carry out the required operation on the Disk Map. The virtual operations are to be
available.

o File system for new partition. From the pull-down list select a file system the newly created partition will be
formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use).

o Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

e Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on
the chosen file system, the following options become available:

| Use D5 buk in fomat routine
Flaase selact numbar of sectors per cluster: | 8 [=]
Please select number of sectors per boot

Plaase salact number of oot entnas
xﬁﬂm defaults
e Use OS built-in routine. Mark the option to restrict the available values according to the used OS.

o  Whether the surface test will be performed. Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

o The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

e The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

e The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

A Number of available options depends on the selected file system type.

Result
After the operation is completed you receive a fully functional partition.

Available operation scenarios:

e Creating a new partition to detach operating system from the rest of data

Copyright© 1994-2010 Paragon Software Group. All rights reserved.



66

Formatting Partitions
Any partition should contain some file system to be used for keeping data. The process of installing a file system is
commonly known as formatting. A huge variety of file systems have been developed these days.

Supported File Systems
The program provides the ability to format partitions of the following file systems:

- FAT12 & FAT16
- FAT32

- NTFS

- Ext2

- Ext3

- Ext4

- Linux Swap v. 2

This operation can be accomplished either with the Format Partition Wizard or the Format Partition Dialog.

Wizard Startup
There are several ways to start the Format Partition Wizard:

Express Launcher
o Click the Partitioning button and then select Format Partition.
Launcher
e Inthe Main menu: select Wizards > Format Partition...
e On the Common Tasks bar: click the Format Partition item of the Wizards menu.

Dialog Startup
In order to start the operation you should take the following steps:

Launcher
1. Select a partition on the Disk Map;
2. Call the Format Partition Dialog to set up the operation. There are several ways to do it:
e Select in the Main Menu: Partition > Format Partition.

e (Call the popup menu for the selected partition (right click of the mouse button) then select the menu item:
Format Partition.

Wizard Setup
The wizard offers the following steps to accomplish the operation:

e Partition to format. Select a hard disk (if the computer has several hard disks) and then the required partition to

format.
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O ¢ s VoLl can chaas sl e Yo WO ' fa
On this page, you Can Cho0se a volume you WOuld ke to format

Basic Hard Disk 0 (VMware, VMware Vitual S SCS1 Disk Devy)

‘l @) Local Disk (C:) I @) data Z)

2823 GB NTFS | M 217GBNTFS

Basic Hard Disk 1 (VMware, VMware Virtual S SCS| Disk Devy)

l ©) Local Disk (*)
433.5GB NTFS

Basic GPT Hard Disk 2 (VMware, VMware Virtual S SCSI Dysk Dev)

I I (7)) (Unallocated)

A As a result of this operation contents of the selected partition will be lost.

e Partition properties. On the next page of the wizard you can set the following partition parameters:

Your hard disk: after the changes
Basic Hard Disk 0 (WVMware, Viware Vidual 5 SCS1 Disk Dey)

I @) Local Disk (C:) l @) data (Z:)

olume labal: | Mew Valuma

- Partition type. From the pull-down list select the desired file system type. In fact, the program displays only
those file systems that can correctly be placed to the selected partition, taking its capacity into account.

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to mark the appropriate option at the foot of the page. When it is marked, the
next page enables to define:
7][Use O buit in fomat routine |
Plaase sslact sectors par Clustar
2 [+

e Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS.

o  Whether the surface test will be performed. Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

e The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.
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e The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

e The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

A Number of available options depends on the selected file system type.

Dialog Setup
Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Format

button to confirm the operation.

e
= 4’ Are you sure you want to format volume (F:)?

You are about to format volume (F:) [No label]. NTFS. Your computer may
no Jonger boot or work comectly

Please salect new file system Lﬂﬂ__?]
Please enter new volume label: | New Volume

¥) More options l Format | | No

o File system. From the pull-down list select the desired file system type. In fact, the program displays only those
file systems that can correctly be placed to the selected partition, taking its capacity into account.

e Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on
the chosen file system, the following options become available:

J| Use OS5 bult in format routine
Plaasa sslact mumber of sectors per cluster: | 128 _ﬂ
Plaasa salact number of sectors per boot ;

Plaasa salact number of oot entries:

Restore defauls |

e Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS.

e  Whether the surface test will be performed. Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

e The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

o The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

o The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.
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A Number of available options depends on the selected file system type.

Result
After the operation is completed you receive a fully functional partition formatted to the specified file system.

Deleting Partitions

With the Delete Partition Wizard or the Delete Partition Dialog you can delete a partition on a hard disk partitioned with
the DOS partitioning scheme. Unlike the majority of other utilities (Windows Disk Manager included), the program can
not only remove references to the deleted partition from the Partition Table, thus making it unavailable for the
operating system, but also enables to irreversibly destroy its data. This feature will guarantee security of your personal
information.

Wizard Startup
There are several ways to start the Delete Partition Wizard:

Express Launcher
e Click the Partitioning button and then select Delete Partition.
Launcher
e Inthe Main menu: select Wizards > Delete Partition...
e Onthe Common Tasks bar: click the Delete Partition item of the Wizards menu.

Dialog Startup
In order to start the operation you should take the following steps:

Launcher
1. Select a partition on the Disk Map;
2. Call the Delete Partition Dialog to set up the operation. There are several ways to do it:
e Select in the Main Menu: Partition > Delete Partition.

e (Call the popup menu for the selected partition (right click of the mouse button) then select the menu item:
Delete Partition.

Wizard Setup
The wizard offers the following steps to accomplish the operation:

e Partition to delete. Select a hard disk (if the computer has several hard disks) and then the required partition to
delete.
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On this page. you can choose 3 volume you would ke to delete

Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dey)

.wl.ocdl)ak(C:) .(_))dda(Z:)
2823 GB NTFS 217 GB NTFS

Basic Hard Disk 1 (VMware, VMware Virtual S SCS1 Disk Dev)

I ©) Local Disk (°) -
433.9GB NTFS

Basic GPT Hard Disk 2 (VMware, VMware Virtual S SCS1 Disk Dev)

I . ©) (Unallocated)
5698 GB

/ ! You are sbout 1o destroy a bootable partition!

A As a result of this operation contents of the selected partition will be lost.

e Merge free blocks. As a result of the operation you may get several blocks of the unallocated space on the hard
disk. So choose whether to merge them all and place at the beginning of the disk or at the end by selecting the
required operation from the pull-down list.

Merge fres blocks options
Do mot marps fres blocks s, |:|

Marge fraa blozks & the and o the disk

Merpe fres blocks at the beginning of the disic

Dialog Setup
Initially the program suggests you just to remove references to the selected partition from the Partition Table.

-~ =)

#7. Are you sure you want to delete volume (F:)?

w You are about to delete volume (F:) [No label], NTFS. Your computer may
no longer boot or work comectly

1[0 ot ask vohume lsbel next tme |

e Enter the volume label to confirm deleting. To confirm deletion of the selected partition, enter its Volume
Label. The current volume label is displayed above.

e Do not ask volume label next time. Mark the option to inhibit confirmation next time you start the dialog.

Result
By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the

modification of the disk layout.

Advanced Partitioning Operations
Here you can learn how to accomplish advanced partitioning operations (merge, redistribute free space, undelete, etc.).
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Merging Partitions
The Merge Partitions Wizard enables to consolidate the disk space, which originally belongs to two adjacent partitions,

into a single, larger partition. The order, in which two partitions have been chosen, is important since all contents of the
second selected partition will be placed in a folder on the resulted joined partition.

The program provides the ability to merge only NTFS, FAT16 or FAT32 partitions.

Startup
There are several ways to start the Merge Partitions Wizard:

Express Launcher

e Click the Partitioning button and then select Merge Partitions.
Launcher
e Inthe Main menu: select Wizards > Merge Partitions...

e Onthe Common Tasks bar: click the Merge Partitions item of the Wizards menu.

Setup
The wizard offers the following steps to accomplish the operation:

e The partition to expand. Select a partition, the size of which you need to increase by up-taking contents of an
adjacent partition.
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Basic Hard Disk 0 (VMware, VMware Vitual S SCS1 Disk Devy)

| @) Local Disk (C:) I'@ data (Z:)
| W 222 9Ge NTFS Z1ZGBNTFS

e The partition to merge with. Choose the second partition for the merge operation, the contents of which will be
placed in a folder on the resulted joined partition. By default, the program offers an easy-to-understand folder
name to store files of the second partition, which however can be customized.

Selact an adacent patition 10 merge with the tangst pantion, This pantion wil be mergad 1o the one you have

selectad on the previous page. The content of the second parttion will be placed in & folder inside the resulting
parttion

Basic Hard Disk 0 (VMware, VMware Vintual S SCS1 Disk Dev)

l @) Local Disk (C:) l ©) data (Z))

5B NTFS 217 GB NTFS

Specfy a folder name t0 keep content of the selected parttion

Foldar Nama  merged
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order, in which two partitions have been chosen, will result in inability to boot the

: Be particularly careful when selecting system partitions to process, since the incorrect
operating system.

Result
After the operation is completed the disk space of the two adjacent partitions will be consolidated.

Redistributing Unused Space between Partitions
This operation can be accomplished either with the Express Resize Partitions Wizard or the Redistribute Free Space
Wizard.

Express Resize Partitions Wizard
The Express Resize Partitions Wizard enables to easily increase free space on one partition by up-taking the unused
space of an adjacent partition of your hard disk.

Startup
There are several ways to start the Express Resize Partitions Wizard:

Express Launcher
e Click the Partitioning button and then select Resize Partitions.
Launcher
e Inthe Main menu: select Wizards > Express Resize Partitions...
e Onthe Common Tasks Bar: click the Express Resize item of the Wizards menu.

Setup
The wizard offers the following steps to accomplish the operation:

e Adjacent partitions to resize. Click on the left partition of the pair of partitions you need to redistribute the
unused space between, as the right one will be selected automatically.

The wizard wil resize space between Local Disk (C:) and data (Z:) on Basic Hard Disk 0
(VMware, VMware Virtual S SCSI Disk Dev)

Select left panition from a par of adacent pantitions you would ike 1o rasize. Right adacent parttion will be
selacted automaticaly

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dey)
l ©) Local Disk (C:) l Q) data (Z)

282 3GB NTFS

e Resulted size of partitions. Redistribute the unused space between the partitions with the slider or manually by
entering the required value.
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Please specfy new sizes of selected padtions

Selected pant of Basic Hard Digk 0 (VMware, VMware Virtual S SCS| Disk Dey)

l ) Local Disk (C:) l (7 data (7))

a
Left volume size Right volume size

28377¢{MB ¥ MB | 22221M8 & MB

Result
After the operation is completed the unused space between the specified partitions will be redistributed according to

your needs.
Available operation scenarios:

e Increasing size of a system partition by taking unused space of an adjacent partition

e Resizing partitions of Apple Boot Camp

Redistribute Free Space Wizard

The Redistribute Free Space Wizard helps to increase free space on one partition by up-taking the on-disk unallocated
space and the unused space of other partitions. By default, the wizard adds to the target partition all existing blocks of
the free space. Besides you can specify partitions to act as a space donor. The wizard will automatically recalculate
positions of the partitions and move their contents to new locations.

Startup
There are several ways to start the Redistribute Free Space Wizard:

Launcher
e Inthe Main menu: select Wizards > Redistribute Free Space...
e On the Common Tasks bar: click the Redistribute Free Space item of the Wizards menu.

Setup
The wizard offers the following steps to accomplish the operation:

e Partition to enlarge. Select a partition, the size of which will be increased at the expense of other partitions.
Blocks of the free space (if any) will be automatically added to the target partition.
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Choosa 3 volume to expand

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

l @) Local Disk (C:) ©) data (Z:)
829 GB NTFS 217GB NTFS

1) Capasty of the volume (C:)is 282.9 GB. The wizard can expand this volume up to 485.3 GB at the
expeance of other volumas

How wil the wizard expand the voluma?

e Partition to donate. Choose any partition(s) (not only adjacent) to donate free space.

Select volumes to take space from. Free space from that vokume will be used to enfarge the volume you have
salected on the previous page

| Volume Fle system | Type | Capacty | Usedspace | Free space | U Free
[O@z) ~~~~~ NTFS  Pmay 217GE  146GB  2023GB 94

L) There is no unslocated space on the hard disk you have selected. The wizard can only expand the
volume (C:) at the expence of some other volumes. Please click the chack box nest to any volume to take
free space from

e Partition size. By default, the program leaves 50% of the unused space on a partition and removes another 50%
to add it to the target partition. However, the size to take can be customized by moving the slider or by
manually entering the exact value.

Yiour diskc after the changas:

 Basic Hard Disk 0 (VMware, VMware Virtual 5 SCS1 Disk Dev)
Iglma&mr; wdaa{?]

TFS 1152 GB NTFS

See-::l"-e'.'. size:

392.371.86 M| 289.776 ME - 496.975.28 MB
i) Curent volume size: 384,17 GB

The volume size has been increased on 101.1 GB

Result

After the operation is completed free space of the specified partition will be increased by up-taking the on-disk
unallocated space and the unused space of other partitions.

Undeleting Partitions

When simply deleting a partition (without additional wiping) disk management software only removes references to it in
the Partition Table, thus leaving the possibility to recover it later.
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The program enables to find and recover these partitions. A restored partition will be fully functional, as long as other
partitions were not created, moved or exceeded the disk space occupied by that partition. That is why the program
offers this function only for blocks of free space.

The operation can be accomplished with the Undelete Partition Wizard.

Startup
There are several ways to start the Undelete Partition Wizard:

Setup

In the Main Menu: select Wizards > Undelete Partitions...
On the Common Tasks Bar: click the Undelete Partition item of the Wizards menu.

Select a block of free space on the Disk Map and click the Recover Lost Partitions item on the page that appears
in the Explorer Bar.

Call the popup menu for the block of free space (right click of the mouse button) then select the menu item:
Recover Lost Partitions...

The wizard offers the following steps to accomplish the undelete partition operation:

Free blocks to scan for lost partitions. Choose a free block from a tree-like list of available hard disks.

Click: the check box nest to sy haed disk drive or free block you want to examine

Name Type
=l My Computer Wy Compuier
¥ [5] Basic Hard Disk 3 (Viware, Vidware Vitusl § SCSI Disk Dev) Irtemal Hard Df

i -
Foe s

The summary sze of fragment (3) to analyze is 19.9GB

Search method. By default, the wizard selects the fastest search method for your operating system. In most
cases that will do to find any accidentally deleted partition. However if you're under Windows XP for instance
(the Conventional Search option is selected), but the deleted partition you're looking for has been created with
the Disk Management utility under Vista, the wizard won't be able to find this partition, unless you manually
select the appropriate option (Quick Search for Partitions Created by Vista or Later OS). Moreover if the wizard
still fails to find the partition you need, you can select the Thorough Search option to scan every single sector in
the specified search area to get the most accurate results.

Choose how to look for the deleted partitions:
_AQutek search for partitions. created by Vista or later OS
@ Conventional search
Thorough search
¥ Show file systems search options
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To know more on the available search methods, please use the context sensitive hint
system.

o File system filter. By default, the wizard will search for all known file systems. However, by clicking on the
appropriate option on the second page of the wizard, you can specify only those file systems you need.

2 Hide file systems search options
| Al known file systems |
FAT and FAT32 file systems
V| NTFS file system
Uinux B42 and B3 file systems
05/2 HPFS file system
Other funkisted) file system
To begin search, cick Next

e A partition to undelete (if several). By default, the program searches records of any deleted partition ever
existed on the selected block of free space. So you can get several partitions to choose from.

E; Search delsted partitions from sector: 40 1o sector 27HH

The following pariitions have been found:

-T-hs:pmn Type .Eapam Used Space [ % Used
TNTFS Primany 199GEB 853 MB 0
[ Stop seanch ]

Most likely the required partition will be found first. If so, you may abort the search operation by pressing the
Stop search button.

Result
After the operation is completed you receive a fully functional partition.

Installing a New Operating System

Getting your computer ready to install a new operating system, especially when it is going to be an additional OS in the
system, is a rather complicated task that implies quite a number of operations, from allocating space to create a new
partition (resize, redistribution of free space) to formatting of the newly created partition to a particular file system and
checking its surface for bad sectors to avoid possible data loss. Operating systems today are being supplied with basic
tools of partitioning that only enable to create a partition (in case there is enough unallocated space on the disk) and
then format it to the specified file system type. Our program offers a handy Install New OS Wizard to easily carry out all
the necessary operations to install a new operating system.

Startup
There are several ways to start the Install New OS Wizard:

Express Launcher
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e Click the Boot Management button and then select Install New OS.

Launcher
e |nthe Main menu: select Wizards > Install New OS...

e On the Common Tasks bar: click the Install New OS item of the Wizards menu.

Setup
The wizard offers the following steps to accomplish the operation:

e Partition to install a new operating system. The program offers two ways of installing a new OS, i.e. to create a
new primary partition for it or use an existing one.

Whete would you ke to rstall an operating system?
(&) | want to create & new pamary parition to install 0S

A new partiion will be cieated by using unallocated space of your hard disk or unused space of esting
pastitions. It iz the most preferable way as no system of user’s data will be affected duning the instalabon
process.

() | want to use an existing pemary partition to instal 0S.

In case creabon of a new primary partiion is not possible (there are already four primary partitions on the
disk) of not desirable, you are free to select any of existing pamary partitions. Please note that al data on
the selected partition will be deleted ¥ you choose to format it latet in this wizard Besides make sure no
operating system has alleady been mstalled on that partibon.

A Only primary partitions can be used to install an operating system.

- In case the first option has been marked, the wizard enables to specify:

A hard disk (if several) where a new partition will be created. Thanks to an advanced program engine it is
possible to use unallocated space of the disk (if any) and unused space of existing partitions to create a new
partition;
O thez page wou can choose a hard disk [ sevveral] whene pou would e bo create a new primany partition

E-Ilatin Hard Dizk 0 [Maxtor 7250P0)

W) ] l @) |
j I 153, GE MTFS % 37

Tobal sipe; 1939 GB

71
Basic Hard Disk 1 [ST3160815A5) gfrf 1]6_2?%33
.{_J).. @) 0] @) [E:)
19 £34GBNTFS B& GE NTF5

To avoid any possible problems, the new partition will in no way be created as the first
partition of the disk which already contains at least one partition.

And its size. If there are blocks of the free space on the disk, the wizard will merge them all and allocate the
resulted space for a new partition in the first place. If not, it will take 50% of the unused space of an adjacent
partition. However, the size to take can be customized by moving the slider.
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W'ou can select esther a block of unallocated space from the disk or an sasting parbiion fos whach the wused
space will be used 1o create & new partition

Basic Hard Digk 0 [Maxtor A 250P0)

l@ﬂ Iww
1821 GB NTFS 51.6GE Mot

New wolume - cument size iz 51.6 GB
Mir Vohume Size: 0 Bytes Max Volne Se: 1565 GE

- In case the second option has been marked, the wizard enables to choose an existing primary partition to
install a new operating system.
On this page you can choose an exitting primary partition where pou would like o install 3 new opetating system
Basic Hard Disk 0 (Maxtor 7Y250P0)
[ B
30 163.3 GB NTFS & 3378

Total size: 163.3 GB
Basic Hard Disk 1 (ST3160815AS)  [Used: 77.2 GB

Free: 86.1 GB
I Q) -- I w (D)
196 634 GB NTFS

W) (E)
66 GB NTFS

A Your computer may fail if any other OS has already been installed on the selected partition.

e Partition properties.
ez, | wanl to format the pastition

artition typec | BRNTFS w
Azsion the following dive letter: TR ~
Suface testlavel | Home v

- Partition type. From the pull-down list select the desired file system type. In fact, the program displays only file
systems that can be correctly placed to the selected partition, taking its capacity into account.

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.

- Surface test level. Define the level of the surface check to make the program find bad and unstable sectors and
mark them unusable in the file system metadata.

e OS Label. Enter a label for the selected partition in the textual field. It will later be used for the drive
identification.

05 labels vall be dizplaved in the Boot Manages’s slaitup merm bo help you boot the requied operating
syshem,

05 labet windows 7]
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Result
As the final step the wizard will offer you to insert a distributive CD/DVD of the new operating system and restart the
computer to launch the installation procedure.

previously installed operating systems. Please launch the Boot Manager Setup Wizard after

t The program will update your MBR, so most likely you won’t be able to start up any of the
the installation has been completed to fix this issue.

Available operation scenarios:

e Creating Dual Boot Systems

Moving/Resizing Partition
The Move/Resize Partition function allows you to resize or change location of any partition without destroying its data.

In order to move/resize a partition you should take the following steps:
Launcher
1. Select a partition on the Disk Map.
2. Call the Move/Resize Partition dialog to set up the operation. There are several ways to do it:
e Select in the Main menu: Partition > Move/Resize Partition...
e On the Explorer bar: click on the current total size value.

e Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or on the
Partition List, then select the menu item: Move/Resize Partition...

3. Define parameters of the operation.

@\ Are you sure you want to move/resize system volume (C:)?
1 You are about to move,/resize NTFS volume [No label), (C:)

Basic Hard Digk 0 (VMware, VMware Virtual S SCSI Disk Dey)

I ) Local Disk (C:)

2828 GB NTFS

Volume size 283776 MB % || 11.823 MB - 283,781 MB

Free space before. 037 MB $|w| Obytes -277.850.73 MB
J

Fres space after. 485 MB * || Obytes -277,850.76 MB

¢ Volume size. Define size (in Mb) of the modified partition.
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e Free space before. Define the partition position (in Mb) relative to the beginning of the available range of
disk space.

e Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of disk
space.

e Sector to sector move. Mark the checkbox to move the partition in the sector-by-sector mode to process its
unused space as well. This can help to avoid problems with hidden data created by certain applications or
the system administrator. However, it will take more time to accomplish the operation.

Partition size and position may also be defined by using the drag-and-drop technique. To do
that, just carry out the required operation on the Disk Map. The virtual operations are to be
available.

When resizing a FAT16 partition beyond the 2GB limit (maximum file system size), the
partition will automatically be converted to FAT32.

The program enables to enlarge NTFS partitions (system, locked) without rebooting
Windows and interrupting its work, providing 100 percent guarantee that your data is kept
intact.

4. The operation will be performed immediately after confirmation.
Available operation scenarios:

e |ncreasing size of a system partition by taking unused space from any other

e Shrinking a system partition to increase size of a data partition

Converting File System

With our program you can change type of the used file system without destroying its data. While performing the
operation, it first checks the current file system for consistency and then verifies whether the on-partition data meet the
requirements of the desired file system or not. After having passed the testing, the program re-organizes the file system
metadata and user files.

The program enables to convert the following file system types:
- FAT16 > NTFS, FAT32
- FAT32 > NTFS, FAT16
- NTFS > FAT16, FAT32
- Ext2 > Ext3
In order to convert a file system you should take the following steps:
Launcher
1. Select a partition on the Disk Map.

2. Call the Convert File System of Partition dialog to set up the operation. There are several ways to do it:
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e Selectin the Main menu: Partition > Convert file system...
e On the Explorer bar: click on the current file system type.

e Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or on the
Partition List, then select the menu item: Convert File System...

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the
Convert button to confirm the operation.

o e
% Are you sure you want to convert system volume (C:)?
\
1 You are about 1o convert fle system on volume (C:) [No label), NTFS

Your computer may no longer boot or work comactly

e New file system. From the pull-down list choose a file system you would like to convert to. Actually the
program only displays variants available for the operation, taking into account the current parameters of the
selected partition and limitations of the used file system.

e New cluster size. Define the cluster size for the partition. This parameter can have a profound effect on the
overall performance. In a nutshell, larger clusters waste more space, but generally provide for slightly better
performance, because of less fragmentation. So be particularly careful with it.

The cluster size value is expressed in sectors per cluster. To get it in Kbytes, please divide it

A into half.

You may only decrease the current cluster size.

e Surface test level. Define the level of the surface check to make the program find bad and unstable sectors
and mark them unusable in the file system metadata.

4. The operation will be performed immediately after confirmation.

Changing Cluster Size

Cluster size is one of the crucial parameters of any file system. Its value implicitly affects the performance of the files
input-output activity since it defines the size of the file system metadata. Besides, the so-called waste space factor also
depends on the cluster size.

In order to change the cluster size of a partition you should take the following steps:
Launcher
1. Select a partition on the Disk Map.
2. Call the Change Cluster Size dialog to set up the operation. There are several ways to do it:

e Select in the Main menu: Partition > Modify > Change Cluster Size...
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e On the Explorer bar: click on the current sectors per cluster value.

3. Define the cluster size for the partition. This parameter can have a profound effect on the overall performance.
In a nutshell, larger clusters waste more space, but generally provide for slightly better performance, because of
less fragmentation. So be particularly careful with it.

-2 s
Are you sure you want to change cluster size for partition (C:)?
: Cumert cluster 526 13 8 sectors. 4 KB (4,096 Bytes) Smaler clusters may

o P " 1 ~n of 4 -
provide more effective usage of disk space

Ploase erter new cluster si26 In sectors _

The Cluster Size value is expressed in Sectors Per Cluster. To get the Cluster Size in Kbytes,
divide it into half.

4. The operation will be performed immediately after confirmation.

Making Logical/Primary
The program allows you to include a primary partition in the extended partition.

In order to change a partition type you should take the following steps:
Launcher
1. Select a primary or logical partition on the Disk Map.
2. Call the Make Partition Logical/Primary dialog to set up the operation. There are several ways to do it:
e Select in the Main menu: Partition > Modify > Make Partition Logical/Primary.

e On the Explorer bar: click on the current partition type.

Are you sure you want to make the partition logical?
s You are about to make the paation (C:) [No label]. NTFS logica!

Yes No

The Make Primary > Logical option is only available when the selected partition is adjacent

f to the extended partition and vice versa.
The Make Primary > Logical option of the system partition will result in inability to boot the
operating system.

The operation will be performed immediately after confirmation.

Changing Partition Attributes
This chapter explains how you can change partition attributes (Active flag, Hidden flag, Partition ID, Volume Label, etc.).
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Mark Partition Active/Inactive
The program enables to set an active/inactive flag for primary partitions of a hard disk. By default, an operating system
will boot only if its partition is active or bootable.

In order to mark a partition active/inactive you should take the following steps:
Launcher
1. Select a primary partition on the Disk Map.
2. Call the Mark Partition Active/Inactive Dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Partition > Mark Partition as Active/Inactive.

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Mark Partition as Active/Inactive.

5~
é Are you sure you want to set the volume as active?

You are about to set the volume (F:) [No label]. NTFS as active. ¥ you already
have active volumes, this action might render your system unbootable

Yes j No

3. The operation will be performed immediately after confirmation.

There can only be one active partition on a hard disk, otherwise your operating system will
fail to boot.

Hide/Unhide Partition
The program allows you to hide/unhide primary and logical partitions. By default, an operating system does not mount
hidden partitions, thus preventing access to their contents.

In order to hide/unhide a partition you should take the following steps:
Launcher
1. Select a partition on the Disk Map.
2. Call the Hide/Unhide Partition Dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Partition > Hide/Unhide Partition.

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Hide/Unhide Partition.

3. The operation will be performed immediately after confirmation.

It is strongly recommended not to hide the system partition. Otherwise your operating
system will fail to boot.
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Set Label of a Partition
The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. It is
detectable by any partitioning tool and is used for notification purposes only.

In order to change a partition label you should take the following steps:
Launcher
1. Select a partition on the Disk Map.
2. Call the Change Volume Label dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Partition > Modify > Change Volume Label.
- Onthe Explorer Bar: click on the current volume label.

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Change Volume Label.

3. Enter a label for the selected partition.

Co- e

Are you sure you want to change label on volume (F:)?
- Please speciy a volume label for easier recognition of your volume

Please enter new volume label:  New Volume

| Yes [ Mo

4. The operation will be performed immediately after confirmation.

Change Partition ID
Partition ID is a file system identifier. It is saved in the Partition Table and is used to quickly detect a partition of the
supported type. By manually changing its value, you can manipulate accessibility of partitions.

In order to change a partition ID you should take the following steps:
Launcher
1. Select a partition on the Disk Map.
2. Call the Change Partition ID dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Partition > Modify > Change Partition ID...
- Onthe Explorer Bar: click on the current partition ID.

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Change Partition ID...

3. Setanew ID for the selected partition.
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==k
Q Are you sure you want to change system ID of the partition (F:)?

Cumert system 1D is Ox07 NTFS. Changing system 1D might prevent some
operating systems from working with the parition.

©) | Please select predefinad 1D from the kst: |
<07 NTFS =
Please enter ID manually

e Predefined ID. Select from the pull-down list the required ID.

e Enter ID manually. With the spinner control set the required ID value. It has to be a 1-2 digit
hexadecimal number.

4. The operation will be performed immediately after confirmation.

Change Serial Number of a Partition
FAT16, FAT32, and NTFS file systems include the Serial Number parameter. A partition's serial number is saved in the
boot sector. Its value is generated while formatting.

The program enables to modify the serial number parameter for FAT16, FAT32, or NTFS partitions without re-
formatting.

In order to change a serial number you should take the following steps:
Launcher
1. Select a partition on the Disk Map.
2. Call the Change Partition Serial Number dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Partition > Modify > Change Serial Number.
- Onthe Explorer Bar: click on the current serial number.

3. Enter a new serial number for the selected partition. It should contain 8 hexadecimal figures (0..9 or A..F). The
operation cannot proceed until you enter all 8 symbols.

N ==
*f,’@ Ame you sure you want to change serial number of volume
; {F:)?
Your compuler may no longer boot o work comectly
Fleasa anter new senal numbser in hesadecimal format
ZEDE-TD16-D87C-0051|
[ Mo

4. The operation will be performed immediately after confirmation.
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Hard Disk Management
In this chapter you will find all the information necessary to carry hard disk operations supported by the program
(Update MBR, Convert to Basic, Change Primary Slot).

Updating MBR

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the standard
bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virus attack or a
malfunction of boot management software.

In order to update MBR of a hard disk you should take the following steps:
Launcher
1. Select a hard disk on the Disk Map.
2. Callthe Update MBR dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Hard Disk > Update MBR.

- Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, then
select the menu item: Update MBR.

1 Are you sure you want to update master boot record?

—t Cument MBR contents for hard disk number 0 will be lost after this operation. Your
computer may no longer boot comectly

| pm—

| Yes ; | No

3. The operation will be performed immediately after confirmation.

Converting Dynamic MBR to Basic
The program allows you to convert a dynamic MBR disk containing simple volumes into a basic one while keeping its
contents intact.

In order to convert a dynamic MBR disk into basic you should take the following steps:
Launcher
1. Select a dynamic MBR disk containing simple volumes on the Disk Map.
2. Call the Convert to Basic dialog selecting in the Main Menu: Hard Disk > Convert to Basic...

3. Set the required number of primary partitions if necessary. According to the DOS partitioning scheme a hard
disk can have up to four Primary partitions. If there is an Extended partition on the disk, only three primary
partitions are allowed. That is why if a dynamic disk contains several simple volumes the program enables to
choose the number of primary partitions. The rest of them if any will automatically be converted to logical disks
within the Extended partition.

Copyright© 1994-2010 Paragon Software Group. All rights reserved.



87

BN =<
% Convert dynamic hard disc to basic?

¥ the disc has more than four simple volumes, the first three of them will become
peimary partitions, and the rest will be converted to the logical ones

The hard disk after convent
Basic Hard Disk 3 (VMware, VMware Virtual S SCS| Disk Dey)

l New Volume (H:)

The resulting basic hard disk can have no more than 1 pemary parttions
Please salect how many pemary parttions the basic disk should have

o

The program can only process dynamic disks containing solid simple volumes (without
extension).

Converting GPT to Basic MBR
The program allows you to convert a basic or a dynamic GPT disk containing simple volumes into a basic MBR disk while
keeping its contents intact.

In order to convert a basic or a dynamic GPT disk into a basic MBR disk you should take the following steps:
Launcher
1. Select a basic or a dynamic GPT disk containing simple volumes on the Disk Map.

2. Call the Convert to Basic MBR Hard Disk dialog selecting in the Main Menu: Hard Disk > Convert to Basic MBR
Hard Disk...

3. Set the required number of primary partitions if necessary. According to the DOS partitioning scheme a hard
disk can have up to four Primary partitions. If there is an Extended partition on the disk, only three primary
partitions are allowed. That is why if a GPT disk contains several volumes the program enables to choose the

number of primary partitions. The rest of them if any will automatically be converted to logical disks within the
Extended partition.
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ER
%\ Convert the basic GPT hard disk to a basic MBR hard disk?

, ¥ there are more than four volumes on the disk, only the first three may become
primary, and the rest - logical

The hard disk after convent

Basic Hard Disk 3 (VMware, VMware Virtual S SCSI Disk Dey)
I l New Volume (H:)

The resukted hard disk should have at least 1 primary pastition(s)
Please salect how many primary panitions you need

2

l—Convm | | No

The program can only process dynamic GPT disks containing solid simple volumes (without
extension).

Changing Primary Slot
Different operating systems apply different approaches to enumeration of the primary partitions.

In Linux:

In Linux, every partition has a special symbolic name that encodes a hard disk containing a partition, and a partition
itself. Partitions are addressed and accessed by using their symbolic names. Symbolic names are automatically
generated by Linux in accordance with the order of hard disks in BIOS and the order of partition records in the Partition
Table. Thus changing enumeration of the primary partitions can lead to changing of paths to some important resources.

In DOS:

The last versions of MS-DOS use a rather sophisticated algorithm for a drive letter assignment. A drive letter, which is
assigned to a partition, depends on the order of records in the Partition Table. Thus changing enumeration of the
primary partitions affects the drive letters assignment. In early versions of MS-DOS, it could even lead to the
unavailability of a partition.

The program provides the ability to change enumeration of the primary partitions. This feature will allow you to fix
problems concerning an inappropriate order of partitions.

In order to modify enumeration of the primary partitions you should take the following steps:
Launcher
1. Select a hard disk on the Disk Map.
2. Call the Change Primary Slot dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Hard Disk > Change Primary Slot.

- Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, then
select the menu item: Change Primary Slot.
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?- el
Are you sure you want to change primary slots order?
You are about to change pemary siots order on Basic Hard Disk 1
(VMware, VMware Virtual S SCSI Disk Dev). Your computer may no
longer boot comeactly
Siot No | Object type | Fie System ' Volume label
0 Primary FAT32 [No label]
Primary Linux B3 NEW VOLUME
3 Prmary Unux Swap2 [No label]
@] (&)
Name Local Disk (F:)
Volume label: [No label]
Total size 24GB File system: NTFS
Usad space: 363 MB Free space: 23GB
Stat sector: 7261380 End sector: 12321854
| M 1
| J

In the opened dialog you can see the current enumeration of the primary partitions of the selected hard disk in
the Partition Table. To help you distinguish partitions from one another, the program provides the following
parameters for every partition:

- Slot

- Volume

- Partition type
- File system

- Partition size
- Volume label

There are two buttons on the right to move the selected partition up and down within the primary part of the
Partition Table.

The operation will be performed immediately after confirmation.

Extra Functionality
This chapter describes the supplementary functionality available in the program.

View Partition/Hard Disk Properties
The program enables to obtain in-depth information on the properties of hard disks and partitions. Besides the general

information, such as capacity, used space or file system type it provides the possibility to get info on hard disk geometry,

cluster size, exact partition location, etc.

There are several ways to get properties on a partition/hard disk:

Launcher

1.

Choose a partition/hard disk on the Disk Map, then select in the Main Menu: Partition/Hard Disk > Properties...;

Copyright© 1994-2010 Paragon Software Group. All rights reserved.



90

2. Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the Disk Map, then
select the menu item: Properties...

= =

-9 [|mES)
' [Geneal AFieSﬂamHo lAdvmood »

Local Disk (C:)

Volume: label:  [No lsbel)
File system: NTFS
Type: Prmary
Capacity: 43533GB
536.868,814,848 Bytes
1.048.571,904 Sectors
Used by data: 53GB(1%)
10,016,497 664 Bytes
19,563,472 Sectors
Free space: 4306GB (39%)
526.852,317,184 Bytes
1.029.008,432 Sectors

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get
information you need.

Volume Explorer

Volume Explorer is a special tool to browse and export contents of the local mounted/unmounted volumes formatted to
FAT16, FAT32, NTFS, Ext2FS, Ext3FS, ReiserFS file systems. Besides it enables to access Paragon backups as regular
folders to explorer their contents or to retrieve certain files.

Launcher

To launch the Volume Explorer you should click Disk View tab in the Explorer Bar and then choose Volume Explorer:
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Disk View |ue|p|

=1 Name Size I Moddfied
4 -1 CD/DVD Drives
=0 Hard Disks
= [5] 1. VMware, VMware Vitual S SCSI Disk Devi  40GB
=-@P1. Pimary NTFS (C) 39.9GB
-] SRecycle Bin 4/15/2010 3:40:55 PM
4/20/2010 7:08:34 PM
4/20/2010 7:42:40 PM =
4/20/2010 7:15:14 PM
4/15/20104:11:30 PM
11/2/2006 5:02:03 AM
4/20/2010 4:18:27 PM
4/19/2010 12:40:49 AM
4/20/2010 9:24:08 PM ~|

|»

Call the popup menu for the selected file/folder (right click of the mouse button) to export it to some other location
(local or network drive, etc.).

e

%, Select » destination folder for the export operstion
Look in: [E] Local Disk i£) E] B % ¥

o) [

Available operation scenarios:

e Restoring separate files and folders from a backup

File Transfer Wizard

File Transfer Wizard is designed to make such operations as copying of separate files/directories or burning of them to
CD/DVD as easy and convenient as possible. It may be of particular use in case of a system malfunction, caused either by
a virus attack or files corruption, in order to get the system back on track again. Besides it provides access to Paragon
backups as regular folders to browse through their contents or copy required files.

Startup
There are several ways to start the File Transfer Wizard:

Express Launcher

e Click the Backup and Rescue button and then select Transfer Files.
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Launcher
e Select in the Main Menu: Tools > File Transfer Wizard.

e Select the Transfer Files item of the Wizards menu on the Common Tasks Bar.

Setup
The wizard offers the following steps to accomplish the transfer operation:

e Place to look for files/directories. Select a source disk from the pull-down list in the left pane of the page. The

program enables to process both mounted and unmounted (without drive letter assigned) partitions. Besides it
is possible to map a network drive.

Source

[5] Local Disk ) ’} o X ¥

N () DVD RW Drive (D) s

[5] Local Disk (E)

[5] Local Disk F)

(5] New Volume (H) £
@) Physical parttions

vy NEW VOLUME, Disk 1
CI] Network places 9

CI] Natwork -

e Object(s) of operation. Choose files/directories you want to copy and place them to Clipboard by pressing the
Add button. To delete a file/directory from the Clipboard, select it in the Clipboard pane and press the Remove

button. You can also create a new folder, rename or irreversibly delete existing files/directories of the left pane
by pressing the appropriate buttons.

Clipboard Source
Name Source Path |=] Local Disk (F) E] e X ¥
|images F/images/

Name -
1 O oG By

%, hibedil sys
%, pagefie sys
» [ somecmd cmd
¢ DVD RW Drive (D)
45 | Local Disk (E)
[F] Locat Disk (F)

l_

3 System Volume Information
Total data size: 132.8 KB

A Files/directories deleted from the Clipboard remain intact on source disks.

e Destination to store the object(s). The File Transfer Wizard allows copying data to local or network drives, to

physical partitions (without drive letters assigned), or burning them to CD/DVDs. Choose the way the data will
be stored.
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There are several ways the Wizand can store your data. Plese select how would you lie to save the data:
@ | Save data to local/natwork diives. |
Crvenwribe dsting files
Save data to physical pariions
Bum the data to CD or DVD.

e Revision of changes. The Transfer Summary page provides structurally divided information on all the actions
made in the wizard. Check the changes and come back to any step of the wizard (if necessary) by following the
required hyperlink.

Please overview the transfer options. You can retum to the comesponding page and change the options by cicking on title

hypedinks

Obiacts to transfer
Object(s) selected: 1
Total data size: 1328 KB (136,024 Bytes)

Transfer destination
Destination path- C/
Space available on destination: 4906 GB (526,821,834 752 Bytes)
Overwrite existing files: No

Result

After the operation is completed the required data will be placed into the specified destination.
Available operation scenarios:

e Copying of data from the corrupted system disk to another hard disk

e Burning of data from the corrupted system disk to CD/DVD

e Copying of data from a backup to the corrupted system partition

e Restoring separate files and folders from a backup

Mount Partition
The program enables to assign or remove drive letters of existing formatted partitions.

Assign Drive Letter
In order to mount a partition you should take the following steps:

Launcher
1. Select a partition on the Disk Map.
2. Call the Add Drive Letter dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Partition > Assign Drive Letter...

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Assign Drive Letter...

3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for this
parameter. So you may just press the Yes button to confirm the operation.
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"\\\ Assign a drive letter?

1 This allows access to the volume by using the drve letter assigned. The
assignment is not recommended £ the volume contains a file system not
supported by your operating system

Assign the folowing drve letter: NN ~ |

However you can manually define the required letter by selecting it from the pull-down list of available drive
letters.

4. The operation will be performed immediately after confirmation.

Remove Drive Letter
In order to un-mount a partition you should take the following steps:

Launcher
1. Select a partition on the Disk Map.
2. Call the Remove Drive Letter dialog to define appropriate settings. There are several ways to do it:
- Select in the Main Menu: Partition > Remove Drive Letter.

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Remove Drive Letter.

3. The operation will be performed immediately after confirmation.

Modifying drive letter of the system partition will result in inability to boot the operating

2 system.
After having processed partitions with installed software, some programs may not run
properly.

Downgrade NTFS Version
With our program you can decrease version of an existing NTFS partition. This feature can be particularly useful when,
for instance, dealing with different versions of the Windows NT family operating systems.

In order to start the operation you should take the following steps:
Launcher
1. Select a partition on the Disk Map.
2. Callthe Downgrade NTFS Version dialog to set up the operation. There are several ways to do it:
e Select in the Main menu: Partition > Modify > Downgrade NTFS Version...

e On the Explorer bar: click on the current NTFS version.
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e Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or on the
Partition List, then select the menu item: Downgrade NTFS Version...

3. Decrease version of the selected NTFS partition by selecting the one you need from the pull-down list.

[ E eS|
"#s.  Are you sure you wanl to downorade NTFS version for
2} volume c:y?
Cument NTFS version is 3.01 - Windows XP

Select new NTFS verson: [P L =

Yas Mo

4. The operation will be performed immediately after confirmation.

Test Surface
The program enables to test surface of existing partitions and blocks of free space for bad or unstable sectors. If found
any it automatically marks them unusable in the file system metadata, thus minimizing the risk of data loss.

In order to start the surface test you should take the following steps:
Launcher
1. Select a partition or a block of free space on the Disk Map.
2. Call the Test Surface dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Partition > Test Surface...

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Test Surface...

3. From the pull-down list choose the level of the surface check.

| sl
2 =X

% Test surface of volume (C:)?

Testing volume surface allows 1o find bad blocks and other problems

Please select 3 suface testlevel: [ ~ |
| Yes ‘ No

4. The operation will be performed immediately after confirmation.

Check File System Integrity
The program allows you to check integrity of a file system. It can be used to detect possible file system errors before
performing any operation on a partition.

To start the system integrity check you should take the following steps:

Launcher
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1. Select a partition on the Disk Map
2. Call the Check File System Integrity dialog to set up the operation. There are several ways to do it:
- Select in the Main Menu: Partition > Check File System Integrity

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select
the menu item: Check File System Integrity.

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the
Yes button to confirm the operation.

0
2. Check volume (C:) [No label]. NTFS for errors?

1 Please note that check operation needs exclusive access to the volume, You may be
asked to restart your computer to complete the operation

Check disk options:
| Scan for and attempt recovery of bad sectors |

e Scan for and attempt to recover bad sectors. Mark the checkbox to additionally process sectors marked
bad in the file system metadata for the purpose of their possible recovery.

4. The operation will be performed immediately after confirmation.

Edit/View Sectors

With the built-in Edit/View Sectors tool the program enables to view/edit sectors on existing partitions/hard disks
providing the possibility to directly access and modify sectors, save and restore sectors from specified files, navigate
through the system metadata, etc.

In order to edit/view sectors of a hard disk/partition you should take the following steps:
Launcher
1. Select a hard disk/partition on the Disk Map.
2. Call the Edit/View Sectors dialog to set up the operation. There are several ways to do it:
- Click the Disk View tab and then choose Disk Editor.
- Select in the Main Menu: Partition/Hard Disk > Edit/View Sectors.

- Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the Disk Map,
then select the menu item: Edit/View Sectors.
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Edit sexciors on Basic Hard Disk 0 (VMware, YMwan: Virtual 5 5051 Disk Dev)
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A Careless use of the Edit Sectors function may result in the irreversible data corruption.

Send Log Files

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of
having difficulties with handling the program, you, with the help of this very function, can address the company support
engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in
order to tackle the encountered problem. Information of that kind is stored in Log files.

In order to send log files to the Paragon Support Team you should take the following steps:
Launcher

1. Callthe Send Log Files dialog in the Main Menu: Tools > Send Log Files;

2. Provide a customer name and a product serial number;

3. Give a detailed description on the encountered problem.
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Send log files

2 Send log files,

— Please enter short description of your problem and send log files to support

Cusst oemer Mams
John Smith
Serial Number
(¥ de-654ac-a4%c-Tdaf-237a2|
Content of inquiry
Heip!

By clicking the Send button the built-in mail client will generate a template request with attached compressed log files
and then send it to the Paragon Support Team.

Log Files
Log files are simple textual files that can be opened by any text editor. There are several log files automatically
generated by the program:

Stubact.log Contains in-depth information on parameters and performance of all operations
carried out by the program

Pwlog.txt Besides brief overview on operations it also contains detailed information about the
state of all hard disks®

Cdb.log Contains low-level information on the CD/DVD devices used in the system

BioNTlog.txt It is an OS-dependent supplementary log file derived from Bioxx.dll. It may contain

or valuable information on Windows family operating systems
Bio95log.txt

Log files do not contain any confidential information on the operating system settings or
the user documents.

A The Send Log Files function is only available when outgoing mail server (SMTP) and the user
e-mail address are properly set. To learn more about it please consult the Settings
Overview chapter.

View Logs

With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as possible, all
the information is structurally divided, besides there is the possibility to see the disk layout before and after an
operation, what is very convenient.

In order to view logs on carried out operations call the View Logs dialog in the Main Menu: Tools > View Log Files
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Started 3732009 at 124012 AM. Finished at 12.40:23...
Started 9732009 at 12-40045 AM. Frished at 12:41:21_.
Started 3732009 at 12-42:11 AM. Finished at 12:44:25 .
Started 9732009 at 12-45:04 AM. Frished at 12:45:12...
| Started 3732000 at 12-45:39 AM. Frished at 1:23:51 .
| Started 97272000 at 31740 AM. Fnished at 9:21:28 AM N eparations have baan found for the sslacted seasen.
| Started 37272000 at 33036 AM. Fnished at 3:47:04 AM
) Started 97272000 at 9:41:05 AM
1 Started 37272000 at 12-13:48 PM. Frished at 12:20:26...
| Started 97272000 at 12-20-26 PM. Frished at 12:24:46 .
) Started 37272000 at 12-24:46 PM
| Started 97272000 at 12-06:15 PM. Frished at 12:07:47...
@ Sarted 3722000 at 120747 PM. Frished at 12:21:18...
& Started 97272000 at 12-21:18 PM. Fnished at 12:30:15...
Sarted 3722000 at 1230015 PM. Finished at 12.31:33..
Started 97272009 at 12-31:33 PM. Finished at 12:41:47...

Sarted 3722000 at 124444 PM. Finished at 12.58:38...
& Started 9722009 at 1.08:03 FM

Disk System Configuration Before Season Desk: System Configuration After Session
Basic Hard Disk 0 (VMware, ViMware Vilual 5 SC51 Disk Dev) - OF Mmmnm.mﬂmsmlmml-m'
Igrtcrl .grtcrl
| NTFS | | NTFS
Basic Hard Disk 1 (ViMware, Viware Vilual 5 SCSI1 Disk Dey) - OF MMMIW.M&:WESESIMD&&]-M.
| o |
FREE FREE

Basic Hard Disk 2 (Viware, Viware Virual 5 SC51 Disk Dev) - OF MMMZM.%WSESIMM]-M.
[ — [
FREE FREE

Typical Scenarios
This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You can
find here useful recommendations and descriptions of operations.

Backup Scenarios

Backing up a hard disk or partition to external media (CD/DVD)
To back up an entire hard disk or a separate partition and then burn the resulted image to CD/DVD, please do the
following:

Launcher

1. Click the Back up a Disk or Partition item of the Wizards menu (any of the ways described earlier can also be
used here).

2. Onthe Wizard's Welcome page, click the Next button.

3. Onthe What to back up page, mark the appropriate option opposite a hard disk’s name or a partition’s name
depending on the chosen task.
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Click the check box next to any hard disk drive or partition you want to back up

Name Type -
= Gl My Computer My Computer
@ [7] Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dev) Intemal Hard Disk Driv
| #53 First Hard Disk Track Frst Track
] € Master Boct Record MBR |
B e | < ]
5 [7] 5] Basic Hard Disk 1 (VMware, VMware Vitual S SCSI Disk Dev)  Intemal Hard Disk Driv
| £ First Hard Disk Track First Track
] 7 Master Boot Record MBR
7 &P Local Disk (E) Prmary
] € Local Disk (1) Pramary
| L. Local Disk () Primary
] & Local Disk () Pramary

| I5] Basic Hard Disk 2 (VMware, VMware Vitual S SCS! Disk Dev) intemal Hard Disk Driv ~

The size of objects to back up: 499.9 GB
Estimated archive size 7.2 GB

You’ve got the option to modify the default backup settings by marking the appropriate
checkbox on this page.

4. On the Backup Destination page, select the Burn the data to CD or DVD option.

There are several ways the Wizard can store your data. Please select how would you like to save the
archive:

i~ Save data to local/network drives.

i | Bum the data to CD or DVD. |

5. Select a recordable device on the list of available CD/DVD devices and edit the archive name, if necessary.

Select a recorder to bum archive images to.

|

Name Disc types
& Optiarc DVD RW AD-7170A CO-R/RW; DVD-R/RW; DVD-RAM; DVD+R/RW
{4 CD Bumer Emulator CD-R/RW 7
[« DVD Bumer Emuistor DVD+R/RW

Archive detals

Archive name: BP030909 {No more than 8 symbols and only in English )

Estimated archive size: 4.4 GB

Please take into account the Estimated archive size value. It can give you a hint about the
number of CD/DVD discs required for the operation.

6. Add comments to your backup describing its contents.
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Plaase anter a shod comment to describa the archive

{\. Mo eamement

7. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the
Next button to start the backup process.

This operation can also be accomplished with the Linux/DOS or WinPE recovery
environments.

Backing up a hard disk or partition to a network drive
To back up an entire hard disk or a separate partition and then place the resulted image to a network share, please do
the following:

Launcher

1. Click the Back up a Disk or Partition item of the Wizards menu (any of the ways described earlier can also be
used here).

2. Onthe Wizard's Welcome page, click the Next button.

3. Onthe What to back up page, mark the appropriate option opposite a hard disk’s name or a partition’s name
depending on the chosen task.

Click the check box next to any hard disk drive or parition you want to back up

Name Type -
= Gl My Computer My Computer
W [7] Basic Hard Disk O (VMware, ViMware Vitual S SCS1 Disk Dev) intemal Hard Disk Driv
#5% First Hard Disk Track First Track
(£ Master Boct Record MBR |
BT ———— i
|5} Basic Hard Disk 1 (VMware, VMware Vitual S SCS! Disk Dev) intemal Hard Disk Driv
£53 First Hard Disk Track First Track
(£ Master Boot Record MBR
57 Local Disk (E) Pamary
| @ Local Disk (1) Pramary
Local Dk () Prmary
| € Local Disk () Prmary

[Z] Basic Hard Disk 2 (VMware, ViMware Vitual § SCSI Disk Dev) intemal Hard Disk Driv =

»

4
The sze of objacts to back up: 499.9 GB
Estimated archive size 7.2 GB

You’ve got the option to modify the default backup settings by marking the appropriate
checkbox on this page.

4. On the Backup Destination page, select the Save data to local/network drives option.

There are several ways the Wizard can store your dats. Please salect how wolld vou like to save the
archine:

" Bum the data to CD or DVD.

5. Map a network disk to place your backup image to:
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- Call the Map Network Drive dialog by clicking the appropriate button;

Select o folder whene archive should be placed and specify archive name. Archive name will be used a5
subfolder where backup data fies will be sloned

Pechive location: [Cofare_030909071551273/ 2 K 2

Nemd . Map Network Drive 5 ) P2

T Remate location mapping

Anstwork share - ||

Map to dive letter : |2 [
Make permanent connection

%) Connect as user K [ Cancel

- Click the standard browse button [...] to browse for the required network share or manually enter a path to
it;

- Define a letter from the pull-down list of available drive letters;

- Mark the checkbox to make this connection permanent. Otherwise it will only be available for the current

Windows session;

- Click the Connect as user button at the foot of the dialog page to specify a user name and password to
access the selected network share if necessary.

6. Edit the archive name if necessary.

Please specify the archive name. Archive name will be used as 3 subfolder where backup data files will
be stored

Archive detais

Archive name arc_030509071001085
Estimated archive size 44GB
Space avaisble on backup destnation: 38 GB

Please take into account values of the parameters Estimated archive size and Space
A available on backup destination - if the archive size exceeds the available space, another
network drive needs to be selected.

7. Add comments to your backup describing its contents.

Flease enter 3 shod comment to describe the anchive

F
Mo comment

8. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the
Next button to start the backup process.

This operation can also be accomplished with the Linux/DOS or WinPE recovery
environments.
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Backing up a dual boot Mac to an external USB drive
To back up a dual boot Mac (Mac OS X and Windows XP/Vista/7) and then place the resulted image to an external USB
drive, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery
2 environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Connect an external USB drive to the computer.

3. Restart the computer. It will be automatically started up into the Linux recovery environment (Normal Mode),
since it’s the only mode that provides support for Mac computers.

4. In the Linux launch menu select Partition Manager.

» Youcan create, delete and format hard disk
Paragon Parition Manager™ partitions using Paragon Partition Manager™,
which will stan now. Upon the star, please
select the drive and one of its partitions or its
free space. Then actvale the Panition’
pulkdown menu and select one of the

File Transfer Wizard partitioning operations.

Restore Wizard

hoH EF

€

Boot Comector

SN

Metwork Configurator

5|

Log Saver
View the mounted partitions

Stant the command line

Boi s

& Ejeat COD/DVD

Reboot the computer

)
@ Power off

5. Launch the Backup Wizard by selecting in the Main Menu of the program: Wizards > Backup Wizard.
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ard Disk Parition  Changes  [[U=ETRERY Help

opy Ha
! Basic Hard Disk 0 (v - Hard Disk

ion_... .
anCDc Restore W
...
Undelete Panitions ———
e | asic Hard Disk 0 Express Resize Wizard riual IDE Hard Drive,
o | TvetumeTrype - |[Used e
wariition. | || Basic Hard Disk 0 (S File Transfer Wizard
— Primar  Boot Correciar 29GE 167G
- 1 o Primar 792ME  204C
HNetwork Configurator

6. On the Wizard's Welcome page, click the Next button.

7. On the What to back up page, select your Mac hard disk.

[Fetained GPT Disko »| Model VMware Vinual IDE Hard Drive, Size 112 Gb

1 " Primary Appla HFS 549Gk 142Gk lecpard Mo
ion Primary NTF5 566 Gb 10.9 Gb [MNa label] Yes

8. On the Backup Destination page, select the Save data to any local drive or a network share option.

Please select how would you like 1o save the archive

%) Save data to any local drives or a network share

Choose this option if you wani i save your data o kcal
mounted or physical partition, 1o USB or FireWare exiernal
drives and 1o a mounted network share. You will be prompred o
choose a lcation you want 1o save the arhive w,

) Burn data to CO/DVD

Choose this option if you wan the Wiz ard w0 burn the archive w
CDor DVD. You will be prompted %o choose a CDor DVD RW
drive.

9. Select an external USB drive as a backup destination.
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Specify image file to create

Look in: [H (NTFS, 2 on Disk 1) (UFSD disk - 4bg |

L ] rchive

) SRECYCLE.BIN

I -Trashes

Blonsone,

) RECYCLER

I System Volume Inforem ation I D
1 ) head

-

[ Renamers) | [ Mewhider(Fn) | | Delete (F8) |
" File name: |rmg_l:n;| phd I | Save |

File type: |:....--::-- phi vl | Cancel

l < Back l Hexi = | I Cancel ]

10. Edit the archive name if necessary.

~ Backup destination -

Archive name

] HOD/Pan2yBackup StorageImg D0 pbi I[Ii

Space available on destination: 34.8Gb

Approximate archive size: 17.5 Gb

available on backup destination - if the archive size exceeds the available space, another

: Please take into account values of the parameters Estimated archive size and Space
drive needs to be selected.

11. Add comments to your backup describing its contents.

— Archive pexi comment -

Please enter backup comments 1o describe the archive

|Arcive 1mg_D0 pb, created: 200806.05 13:42 39 |

12. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the
Next button to start the backup process.

This operation can also be accomplished with the WinPE recovery environment or under
Windows.

Recovery Scenarios

Fixing MBR after a boot virus attack

Let’s assume that the MBR (Master Boot Record) of your hard disk has been corrupted as a result of a boot virus attack,
thus your system fails to boot.

To fix the MBR of your hard disk, please do the following:
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1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery

f environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

.5 Mormal HMode Hain recouvery
& Safe Mode env ironment

& Low-Graphics Safe Mode

= Floppy disk

= Hard disk 8 MBR

& Find 0Se=z on your hard disks

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select Boot Corrector. You can find it in PTS DOS as well.

. You can create, delete and format hard disk
Paragon Partition Manager™ partitions using Paragon Partition Manager™,
which will start now. Upon the sian, please
select the drive and one of its partitions or its
free space. Then actvale the Panition’
pull-down menu and select one of the

File Transfer Wizard partitioning operations.

Restore Wizard

S @+ £F

Boot Comector

Metwork Configurator

|

Log Saver

View the mounted partitions
Stant the command line
Eject CD/DVD

Reboot the computer

Paower off

QL3R [Ck

4. Onthe Wizard's Welcome page, select the Correct the Master Boot Record (MBR) option.
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Flease choo e the operation

() Search for Windows installations o correct
(®) Correct the Master Boot Record (MBR)

() Correct the partition beot record

() Medify partition parameters

() Correct boot parameers (boolini, BCD)

To begin, click Next.

5. On the next page choose the required hard disk from the pull-down list (if several) and then select the Update
the MBR executable code option.

Please choose the hard disk o correct boot problems:

Flease pointowut the operation o perferm:

(T} View the MER
(® update the MBR executable code

() Reorder primary panitions (change sks)

6. Confirm the operation.

! 1 Update the MBR executable code of the Basic Disk 0 (40.0 Gb)?

5 =

7. After the operation is completed click the Report button to see a well informative summary page. The program
also enables to store the resulted report. To do that, just press the Save button and choose the exact location in
the opened dialog.

Reporting

i You have successfully compheted boot correction. To view the repon
an the operations perdormed, click Report,

Operations pedormed:

Operation #1: Correct the Master Boot Record
Hard disk targeted: Basic Disk 0

Status: Succesalul

Dave and Tinve: 2009 Jan 14 Wed 140109

Report
Paragon Boot Correcior's Repan

8. Click the Finish button to close Boot Corrector.

Copyright© 1994-2010 Paragon Software Group. All rights reserved.



108
9. Reboot the computer.

Fixing Windows startup ability
Let’s assume that due to an unknown reason your Windows fails to complete the startup procedure. At first everything
seems quite OK, you can see the standard startup messages on the screen, but at some moment it hangs up.

To fix your Windows startup ability, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery

f environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

-+ Hormal Hode Hain recouvery

& Safe Mode eny ironment
& Low-Graphics Safe Mode

& Floppy disk

& Hard disk 8 MBER

& Find 0Se=s on your hard disks

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select Boot Corrector. You can find it in PTS DOS as well.
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i Youcan create, delete and format hard disk
Paragon Partition Manager™ partitions using Paragon Partition Manager™,
which will stan now. Upon the star, please
select the drive and one of its partitions or its
free space. Then actvale the Panition’
pulkdown menu and select one of the

File Transfer Wizard partitioning operations.

(:

L4

Restore Wizard

Boot Comector
Metwork Configurator
Log Saver

View the mounted partitions

ol B X6 ot

Stant the command line

0

Eject CD/DVD
Reboot the computer

Paower off

ea™

4. On the Wizard's Welcome page, select the Search for Windows installations to correct option.

Please choose the operation;

(&) search for Windaws installations i cormect
O Correct the Master Boot Record (MBR)

() Correet the panition baot recond

) modity panition paramesers

(Z} Correct boot parameters (boovini, BCD)

To begin, click Mext.

5. On the next page choose the required Windows installation from the list of found installations (if several), then
select the Edit the Boot.ini file option. If you’re not sure which installation you need, please use the Properties
button to get more info on the selected item.

Correct Windows installations

Pragram has searched for valid Windows installations an your
compuier, The results of the search you can see below, Status 5 refers
10 4 system partition (you can edit the Bootini file), B - a boot panition
(you can correct the System Registry).

N |Partiton |Status [System reat  [Type
1  DiskD, Partition 0 5+B  WINDOWS WinXP

Far the highlighted Windows installation, please

paint out the operation o perdorm:
) Carrect drive leters in the System Registry
(&) Edit the Boot.ini file

O Correctihe partition boot record

Adjust 05 o koot on new handware

Ta continue, click Mext
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6. Examine the file — maybe that’s where the problem is. If it contains a mistake, correct it by using the appropriate

buttons.

Edit the Boot.inifile on Hard Disk 0, Partition 0

[boot loader]

timeaut=10
defauit=mubif0idisk(DirdiskiDipantition IIWINDOWS

[operating sysems)
muulti {00 sk (0)rdisk (01 p anition( IWINDOWS ="Paragon VkiWare Windows XP Partition 01° fasdeiect 1

T S e —

i Edin ] [ insert the sample | | Add the sample ]

7. If the Boot.ini file does not contain any mistake, please return to the Correct Windows Installations page to
correct drive letters in the Windows System Registry.

Correct Windows installations

Program has searched for valid Windows installations on your
compuier. The results of the search you can see below, Status S refers
0 A Sysiem panition (you an edit the Boot.ini file), B - a boat panition
(you can correct the System Regisiry)

N |Panition |Stams [Sysem ot [Type
1 Disk0, Partition 0 5+B  WINDOWS Winxp

For the highlighted Windows installation, please

paint out the operation o perfarm:
(&} Correct drive leners in the Sysiem Regisiry
() Editthe Bootini file

() Correct the pariition boot record

Adjust 05 to boot on new hardware

To continue, click Mext

8. On the next page choose a hard disk from the pull-down list (if several), then the required partition. If you’re not
sure which installation you need, please use the Properties button to get more info on the selected item.
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Paritions Lis1 Leters Map

Below you can choose a hard disk drive and see all panitions on it Information about drive letiers
assigned 1o these panitions |s 1aken from the Sysiem Regisiry of the Windows installation selecied.

[Basic Disk 0 »| 40.0 Gb, VMware Virtual IDE Hard Drive
M [Type |actve |Fite Sysiem  [volume 1abel |Size |orive leners |
0  Primany Yes NTFS WinXP 30Gb =5
1 Primary Mo NTFS Application  9.8Gb E
?  Primary Mo BackupCapsul [Ho label) 100 Gb <Mone>
3 Primary Mo Free 17.2Ghb <Mones

9. Click the Edit Letters button to correct an existing drive letter or assign a new one in the Windows System
Registry.

Partitians List

it. Informaation about drive letiers
the Windows installation seleced.

- Lemers
Basic Disk D Drive
N [Type IO |Drive leners
0 Primary e 13 =hone>
1 Primary 133 E:
2 Primary Add |' Gh =MNone=
3 Primary — Gb  <MNones
Recommended to try - C:. If used,
you can release itin Leters Map.

Close

=

10. Once you’ve assigned the appropriate drive letter, close the dialog, then click the Apply button.

11. Confirm the operation.

iﬁ Apply the changes?

ety

[ v J[L ™ |

12. After the operation is completed click the Report button to see a well informative summary page. The program

also enables to store the resulted report. To do that, just press the Save button and choose the exact location in
the opened dialog.
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Report

Paragon Boot Correcior's Report
Cperations performed

Operation £1: Change dive leneis

Partition targeted: Hard disk 0, Panition 0
Info: System Root folder is ™" friputer, If
Status: Successiul hnd make
Daie and Time: 2009 Jan 14 Wed 16:14:16

B To go to the beginning, click here

13. Click the Finish button to close Boot Corrector.
14. Reboot the computer.

Restoring a system partition from external media (CD/DVD)

Let’s assume that your computer fails to boot because of a virus attack or corruption of some system critical files. But
you’ve got a backup of your system partition on a bootable DVD disc. That’s just enough to easily get your system back
on track again.

To restore your system partition from a backup image located on CD/DVD when the current OS is down, please do the
following:

1. Insert a CD/DVD disc containing the previously prepared backup image into a CD/DVD drive (the BIOS must be
enabled to boot the system from the CD/DVD device).

2 This scenario implies that you have got a bootable archive on your CD/DVD.

In case the backup image is stored on several CD/DVD disks, please insert the first one.

2. Restart the computer.

3. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

-+ Hormal Hode Hain recouvery
& Safe Mode environment

& Low-Graphics Safe Mode

& Floppy disk

= Hard disk 8 MER

& Find 05es on your hard disks
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A By default the Normal Mode will be automatically initiated after a 10 second idle period.

4. |nthe PTS DOS launch menu select the Restore Wizard. You can find the same wizard in Linux as well.

Provides Restore for hard disks/panitions. All

Paragon Pariition Manager™ drives (including NTFS) are already mounted
ase, d;, e, e, ltis possible w eject your
Restore Wizard DROM

File Transfer Wizard

Boot Comectar

& Dot P

Start the command line

Reboot the computer

0B

5. Onthe Wizard's Welcome page, click the Next button.

6. On the What to Restore page, you can see a list of available images (if several). Most likely the required archive
will be there too. If not, click the standard browse button [...] to find it. When you find your image, double click
on it to proceed.

~ Select Image 1
]I'"-:Zl iram_hic/BP280508 PBF |E|

You can sebect image from list below (on Double click):

* |Created on |Archive name
@ 2008 May 27 145255  anc_27050814520967 1 PRF

= 2008 May 28080334 BPIHEPRF

7. On the Image Properties page, make sure that you select the correct image by viewing the provided information
about the archive.
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- Panition préview

HTF5S WinXP ‘

Archive details 5
Type Image of the pafition

Archive name I /BP280508 PEF

Created H0E May 28 Wed 08103:54

File sysiem: NTFS

Drive letier; d

Vialume labe| WinXpP

Size (capacity) 30Gh (3216052224 b

Used space: 1.8Gb (50%)

Free space 1.2 Gb (39%)

Seciors/Clusier: 1 3

8. On the next page specify a hard disk, then one of its partitions to restore the image to (if several in your
computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we
actually need.

Basic Disk 0 -40.0 Gb

.‘zwm* |

[Basic Disk | sizednnchb
[N Jvolume [Type |Fite System |size [volume label  Jactive  |[Hidden | |
[ Primary NTFS 30Ghb WinxpP Yes Mo
1 o Primary NTFS a9 B8Gh Applic ation 2] Mo
2 Primary BackupCapsule 100 Ghb [Ho label] Mo Yes
I o= Primary Fres 17.2Gb Mo Mo

All contents on the partition selected for restoring purposes will be deleted during the
operation.

9. On the Partition Start and Size page you can change size of the partition and its location if necessary.

~ Paniion preview

NTFS WinXP

Mew size: (1859 - 3067) Mb

Mb

-
et
Free space before: (0 - 12208 Mb

3 foer ]
3 O
b ]

Free space aher: (0 - 1208 Mb

d

-~
w Mb

10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next
button to initiate the restore process.
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vewcangeson

Your partitions before operations:

I I - |

Your partitions afer sperations:

I - |

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list Suboperation progress

BRARRARANREREN |

1: Restore partition or disk

Operation progress

WAL 4
Time elapsed:  00:01:10 Time w0 finish 00:06:36

Copied so far:  290.0 Mb Read so far 366.0 Mb (5.7 Mb/s)
To copy L5SGb  Write so far 366.0 Mb (52.3 Mb/s)

Overall progress

TITITIT

Reswore Primary panition 0 (disk 0) from file: Z /BP280508 PBF
Data writing...

12. After completing the operation close the wizard, and then reboot the computer.

This operation can also be accomplished with the WinPE recovery environment.

A To make a Win2K+ operating system bootable on different hardware, please additionally
complete the P2P Adjust OS Wizard.

Restoring a system partition from a network drive

Let’s assume that your computer fails to boot because of a virus attack or corruption of some system critical files. But
you’ve got a backup of your hard disk on a remote backup server. That’s just enough to easily get your system back on
track again.

To restore your system partition from a backup image located on a network drive, please do the following:

1. Start up the computer from our WinPE recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery

f environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Once it has been loaded, read the agreement and then mark the appropriate checkbox to accept.
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License
Press Page Up and Page Down 1o scroll the text

End User License Agreement ‘I

Heinrich-von-Stephan-Sir. 5 ¢, 73100 Freiburg, Germany
and

You, &3 eng yser

If you accept the terms of the agreement, click the check Sox below

2 b agcept the tarms in the License Agreement ]

'
'n
o

-

Decline I

A If you do not agree with any conditions stated there, you won’t be able to use the program.

3. Once you accept the agreement, you will see the Universal Application Launcher. Select the Restore Wizard.
4. On the Restore Wizard's Welcome page, click the Next button.

5. On the Browse for Archive page you need to specify the required backup image. So you should take the
following steps to do that:

e Select Network as a backup destination;

Look: in: .’.'ef.'.'.cﬂ ‘:J ﬁ. %’ _d

G Disk Drives
pame | [ wrrr ) Stze | Date
=-HIN

[E] Application ()

8)CD Drve (E) PARAGON

& Boet (%2
W Backup Capsules

I Backup Capsule on Hard Disk 0
Bl Hetwork places

F“”’M

e Map a network disk where your archives are placed:

- Call the Map Network Drive dialog by clicking the appropriate button;
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Lookin: |Gl Hetwork x| B K Jttt
Hame Size | Date
w [T Bt ] )
20
—Remate location maporrg
Anetwor shars | |

Mag to drive letter : -

= Make pemanent connection
— A -
¥) Connect as user oK Cancal |

- Click the standard browse button [...] to browse for the required network share or manually enter a path
to it;

- Define a letter from the pull-down list of available drive letters;

- Click the Connect as user button at the foot of the dialog page to specify a user name and password to
access the selected network share if necessary.

A You can also map a network disk with Network Configurator.

e Choose the required archive in the browser-like window. The Archive File Details section displays a short
description of the selected image.

Name =— | Sza | Date _:]

+1- [5] Boet (X
=} [=] Net Backup Storage (\\server\usts'\axchange) (Z)

. AANENG TN ENAER PPy e
= c_280508103150968 28/2008 2:37:21 AM

28/2008 2:37:24 AM
AViaVVv L &S NN

non o

216KB
1GB 5/28/2008 2:37:10 AM

171 KB 5/28/2008 2:37:07 AM =]

Name Basic Hard Disk 0 (Unknown Model)

Comment: Backup of My Hard Disk

Type: Basic Hard Disk Drive

Total size: 40GB

File: Z:/arc_280508103150968/acc_280508103150568 PBF

6. The What to Restore page displays detailed information about the contents of the archive. Select the required
item to restore. In our case it is the first partition of the disk.
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Pleasa salact one of the obyect(s) to restore:

Nym Type File system | Size
J Basic Hard Disk 0 (Unknown Model) Basic Hard Disk Drive 40GB
‘ Primacy NTFS 25Ge 2GB
Primary NTES 3.7G8 Z‘Z gMB

—Archive Detais
| Name: Local Disk (*)
Volume label: WinXP
Fle system: NTFS Totalsize: 29GB
Usad space; 18GB Frea spaca: 11GB

7. Onthe Where to Restore page specify a hard disk, then one of its partitions to restore the image to (if several in

your computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we
actually need.

Plaasa salect a place you would ike 1o rastore the archive 1o, Note that £ you selact an existing hard disk or
parttion, ts content will be deleted and replaced with the one from the archive.

[ Basic n-}fmfk 6’&;4...,; Virtual IDE Hard f)r_m)
©) Applicati... || [ ) Backup C... Il ©) (Unallocated)
97GBNTFS || ¥ s9ce 17.2GB
Total size: 2.9GB
Used: 1.8G8
Free: 1.1G8

All contents on the partition selected for restoring purposes will be deleted during the
operation.

8. On the Restore Results page you can see the resulted disk layout. Besides there’s the possibility to change size
of the partition and its location if necessary as well as assign a particular drive letter.

Your hard diek afterthe changes

[ Basic Hard Disk 0 (VMwm: Vmud IDE Hard Dnvc)

’l H '!)"W"cd' I ‘ «_a) ) Backup C... 1. @) (Unallocated) |
276 1 58CB [ 172 GE |

Logical Disk Restore Options

Piease specfy the size of the restored pariion: 3067 5] 1845 MB - 3067 MB

Plaase spacfy size of free space before the partition |Z 5. OMB-1217MB
Piaase specify size of fres space aftar the parition: IC 3. OMB-1217 M8

Assign the folowing drive letter Ivl

9. On the next page of the wizard confirm the operation by selecting the appropriate option.
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~Would you ke to apply your changes 7
(% | Yes. apply the changes physicaly. |
" Ho. st me ru«:u:"mn-.‘rarlmS

10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Restorng from archive

i
Time elspsed:  00:00:17
Tima remaining. 00:03:45

Opearations datals

- - - — ~ e T e
i) Restore Primary partition Q {Gisk 0) from file: Z-/arc_280508103150368/arc_280508103150568_000Cp.000

i) Data writing

< |21

[T Shutdown system on complete

Mark the checkbox at the bottom of the window to automatically switch off the computer on the successful

accomplishment of the restore operation.

11. After completing the operation close the wizard, and then reboot the computer.

This operation can also be accomplished with the Linux/DOS recovery environment.

To make a Win2K+ operating system bootable on different hardware, please additionally
complete the P2P Adjust OS Wizard.

Restoring a system partition from a local drive
Let’s assume that your operating system gives trouble after having installed brand new software. But you've got a
backup of the system partition on a local disk. That’s just enough to easily roll it back to the point when run smoothly.

To restore your system partition from a backup image located on a local disk, please do the following:
Launcher
1. Click the Restore item of the Wizards menu (any of the ways described earlier can also be used here).
2. Onthe Restore Wizard's Welcome page, click the Next button.
3. Onthe Browse for Archive page, specify the required archive:

e By clicking the Switch to File View link, you can find the required image in the browser-like window. The
section below (i.e. Archive File Details) will also display a short description of the selected image.
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Lookin: | [5] Local Disk (C) x| R Y
Mame Size | Date =l
%[5 Local Disk (C) -
#- |, arc_210410030357578 4/20/2010 8:08:34 PM
<P <2V 201082460 P
w- |, arc_TEST 4/20/2010 8:15:14 PM
+- J. Program Files 4/20/2010 5:18:27 PM
+- | TEMP 4/15/2010 10:36:10 PM
- | Users 4/15/20104:35:12PM  __|
- | Windows 4/15/2010 10:32:40 PM
- L WORK 4720201081244 P07
Fles of type: | Archive files =
Archive Fle Details
Mame: Local Disk (C:)
Comment : Mo comment
Volume label: [No label]
File system:  NTFS Total size:  39.9GB
Lsed space: 9.9GB Free space: 30GB
File: C-/arc_NEW/arc_NEW PBF

A To know more on the subject, please consult the Viewing Image Properties chapter.

4. Onthe Where to Restore page specify a hard disk, then one of its partitions to restore the image to (if several in
your computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we

actually need.

Please select a place you would like to restore the archive 1o, Note that f you select an existing hard disk or partition,

its content will be deleted and replaced with the one from the archive.

Basic Hard Disk 0 (VMware, VMware Virtual S SCS| Disk Dev)

@) Local Disk (C:)
499 9GB NTFS

e All contents on the partition selected for restoring purposes will be deleted during the

operation.

5. On the Restore Results page you can see the resulted disk layout. Besides there’s the possibility to change size

of the partition and its location if necessary as well as assign a particular drive letter.

‘Your hard disk: after the changes:

Basic Hard Disk 0 (VMware, VMware Vidual 5 SCS51 Disk Dev)

@) Local Disk (C:)

4959 GE NTFS
Geometny Restors Options
Plaase spacily the size of tha restored partition: 511998 | 87119 MB - 511938 MB
Please speciy size of free space before the parition: 0 | O ME - 503273 MB
Please specify size of free space sfterthe pastition: | 0 MB - 503273 MB
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6. Complete the wizard and then apply the pending changes.

7 s

Apply pending changes 7

[] Donot show thismessageagain | Yes || Mo |

7. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the
appropriate button to agree.

— )

System restart is required to complete the operation.
What would you like to do?

The operation Restore partition or disk needs exclusive access to the volume
C: and cannct be completed without system restart. After restart, the operation wil
contnue in boot ime mode. Do not tum off the computer until the
operation completes.

=
&> Restart the computer
Please confiem restart of your computer, The operation will be continued after
system restadt.

J

£ Retry

Manually close used fies and retry the operation

The operation cannot be completed without restart bacause some files are in use and
prevent exclusive access 1o the volume
What fies prevert gperation complebon?

8. Inthe Progress window you can see in real-time a detailed report on all actions carried out by the program.

Suboperation progress

Gparacon| '
) [FOFTWARE GEOUF] Restore partition or disk
] |
Hork time00:00:55 Time to finish00:00:26
Done: 521 HMEB Read: 532 MB(35.2 MB/s)
All: 8.71 GB Hrite: 532 MB(S3.2 MB/s)

Overall progress
- /] |

Loading Paragon Engine

Copyright Copuright 1388-2008 Paragon Technologie GabH. ALl rights reserved.
Please wait ...

Universal File Sustem Driver initialization...

Getting partitions info...

Flushing system buffers, please wait.. ... .o voininiiniiiieii i ieianann

Restore Primary partition O (disk 0) from file: G:/arc_system/arc_sustems.PBF
Data writing. ..

To avoid data loss, please do not reset or turn off the computer.
Dperation in progress... press 'ESC’ or 'Ctrl-C' to interrupt operation

After completing the operation the program will automatically reboot the computer.
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This operation can also be accomplished with the Linux/DOS or WinPE recovery

f environments.
To make a Win2K+ operating system bootable on different hardware, please additionally
complete the P2P Adjust OS Wizard.

Restoring a dual boot Mac from an external USB drive
Let’s assume that your Mac fails to boot because of a hard disk malfunction. But you’ve got a backup of your hard disk
on an external USB drive. Just replace the failed disk with a new one and carry out a bare metal restore.

To restore a dual boot Mac from a backup image located on an external USB drive, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery

2 environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Connect an external USB drive to the computer.
3. Restart the computer.

4. Inthe boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode that
enables to work with USB devices.

.5 Mormal HMode Hain recouvery
& Safe Mode env ironment

& Low-Graphics Safe Mode

= Floppy disk

= Hard disk B8 MBR

= Find 0Ses on your hard disks

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

5. In the Linux launch menu select the Restore Wizard.
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i Youcan create, delete and format hard disk
Paragon Partition Manager™ partitions using Paragon Partition Manager™,
which will stan now. Upon the star, please
select the drive and one of its partitions or its
free space. Then actvale the Panition’
pulkdown menu and select one of the

File Transfer Wizard partitioning operations.

(:

L4

Restore Wizard

Boot Comector

Metwork Configurator

Log Saver

View the mounted partitions
Stan the command line
Eject CD/DVD

Reboot the computer

Paower off

EO™ Boi®xb het

6. On the Wizard's Welcome page, click the Next button.

7. On the What to Restore page, click the standard browse button [...] to find the required archive. When done,
double click on it to select.

Select archive...

File type: |.'.:-.I| ve liles (" pbil vl l Eﬂ.l'll:!| I

= Back ezt = Cancel |

8. On the Image Properties page, make sure that you select the correct image by viewing the provided information
about the archive.
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Disk preview

Volume [Type [File System  |Size Jused [Volume label |
Basic Disk 0 (Size 112 Gb)

. Primary FATI1G 200 Mb 15.0 Mb [Ma label]

- Primary Apple HFS 549Gh 14.2Gb lespard

. Primary NTFS 566 Gh 109Gk  [MNolabel]
Archive details: e
Type: Image of the hard disk
Archive name: 90528 hddeo_vista/lea_vista pbi

“

Creaed 0B May 29 Thd 21:16:51

To contimee resiore process, chick Next.

9. On the next page specify a hard disk to restore the image to.

Basic Disk 0 (ViMware Virtual IDE Hard Driye) - 112 Gb

Basic Disk 1 (28)- 279 Gb
: NTFS ntfs4dbackup : NTFS 4bp

ﬂ Mode| Vidware Virtual IDE Hard Drive, Size 112 Gb

[Basi Disk o
N |volume |Type | File System |Size |volume label  [Active  [Hidden |
Basic Disk 0 {Size 112 Gb)
[ I Primary Frea 112 Gb Mo Mo

A All contents on disk selected for restoring purposes will be deleted during the operation.

10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next

button to initiate the restore process.

Vewchames on

Your partitions before operations:

- |

Your partitions after operations:

NTFS [No label]

Apple HFS leopard

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.
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Operations list Suboperation progress

I
1: Restore parition or disk 5 |
Qperation progress

Time elapsed:  00:00:16 Time o finish: 002624

Copied sofar: 1920 Mb Read so far 192.0 Mb(24.0 Mb/s)

To capy: 140 Gb  Write o far 192.0 Mb{38.4 Mb/'s)
Overall progress

Convening disk 0w GPT

Opening archive keo_vista_0000p 000..

Restore Primary partition O (disk 8) from file: /19052 8hddleo_vistaleo_vista_0000p 000
Data writing

Opening archive lea_vista_0001p 000

Restare Primary partition 1 (disk 00 from file: /r90528hddleo_vistalea_vista_0001p 000
Data writing...

Cancel

12. After completing the operation close the wizard, and then reboot the computer.

Copying of data from the corrupted system disk to another hard disk
To retrieve valuable information from your hard disk and copy it to another hard disk when the system fails to boot,
please do the following:

1. Connect the second hard disk to the computer.

2. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery

f environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

3. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

-+ Normal Mode Hain recouvery

& Safe Mode enuironment
& Low-Graphics Safe Mode

= Floppy disk

& Hard disk B MER

= Find 0Ses on your hard disks
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A By default the Normal Mode will be automatically initiated after a 10 second idle period.

4. |n the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.

E » - ‘ou can create, delete and format hard disk
%'a Paragon Partition Manager partitions using Paragon Partition Manager™,

which will stari now. Upon the siarn, please
select the drive and one of its partitions or its
free space. Then aciivate the ‘Paritlon’
pulldown menu and select one of the

File Transfer Wizard partitioning operations.

Restore Wizard

Boot Cormector
Metwork Configurator
Log Saver

View the mounted partitions

oil B X6 Dot

Start the command line

Q

Eject CD/DVD

Reboot the computer

Paower off

@a™

5. On the Wizard's Welcome page, click the Next button.

6. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.

Source

NTFS, 0 on Disk 0) (WinX® v

W My computer
™ / (Rootdin)
W MyComputer (My computer)
M /mnt (Mounted resources)
M /mnydisk (Local disks)
B W /media (Removable disks)
$ IDE CD/DVD (NECVMWa VMware IDE CDR1
- EYETeTT—
e D\ (NTFS, 1on 2isk 0) (Application)
e E\ (BackupCapsule, 2 on Disk 0) (UFSD di:
T nudr [~

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.
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Clipboard Source
™7 /mntdisk/hdal/Documents and Settin [‘ Jser ﬂ
7 iImnydiskhdal/Documents and Settin o A
L Application Data
) Cookies
L) Deskwop
@ ) E-Mail Database
@ ) Favorites
) Local Settings
J My Documents
) NetHood
) PrimHood
< > ) Recent v
Total data size: nja [ cax | [ Rename(F&) | [ Deew(ra |

Click the Calc button to estimate the resulted data size.

or a network share item.

Please select how would you like o save the data:

(% Save data to any local drives or a network share
Choose this option il you want 1o $ave your data o lbcal
mounted or physical panition, 0 USE or FireWare external
drives and to a mounted network share, You will be prompted o
choose a location you want i sawve the archive o,

) Burn data te COYDVD

Choose this option il you want the Wizand w burm the data o

CDor DVD. You will be prompied 1o choose a CD or DVD RW
drive.

9.
button [...].

Select path

| mntdiskhda? IEI

Space avallable on destination: 8.6 Gb

Totaldata size: nja

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the

operation.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.
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Operations list: Suboperation progress

‘l:Tronskr userdata (N NSRRI RSO NY)

Time elapsed:  00:00:03 Time w0 finish 00:00:00

Copied so far 17.0 Mb

Overall progress
...................................................... 1

Transfering “/mntdisk/hdal/Documents and Settings/User/E-Mail Database” o “/mnmdisk/hda2/E-Mail Data
Transfering "/mntdisk/hdal/Documents and Settings/User/My Documents® to “/mntdisk/nda2/My Document
All operations have been finished

12. After the operation is completed, close the wizard by pressing the appropriate button.

13. Turn off the computer.

A This operation can also be accomplished with the WinPE recovery environment.

Burning of data from the corrupted system disk to CD/DVD
To retrieve valuable information from your hard disk and burn it to CD/DVD when the system fails to boot, please do the

following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery

2 environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode that
enables to burn CD/DVD discs.

-+ Normal Mode Hain recouvery

& Safe Mode enuironment
& Low-Graphics Safe Mode

= Floppy disk

& Hard disk B MER

= Find 0Ses on your hard disks

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
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B » ™ ‘Youcan create, delete and format hard disk
::‘15 Paragon Partition Manager partifions using Paragon Partition Manager™,
- which will stant now. Upon the stan, please
. select the drive and one of its partitions or its
% Restore Wizard free space. Then actvale the Panition’

pulldown menu and select one of the
File Transfer Wizard partitioning operations.

Boot Comector
Metwork Configurator
Log Saver

View the mounted partitions

OiBRED

Stant the command line

0

Eject CD/DVD
Reboot the computer

Paower off

ea™

4. On the Wizard's Welcome page, click the Next button.

5. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.

Source

CA\ (NTFS, 0on Disk 0) (WinX® v

i My computer
' / (Rootdin
W MyComputer (My computer)
M /mnt (Mounted resources)
M /mnydisk (Local disks)
D W /media (Removable disks)
,} IDE CD/DVD (NECVMWa VMware IDE CDR1
B C)\ (NTFS,0 uy"flx-.b. 0) (WiInxXP I
S D)\ (NTFS, 10n 2isk 0) (Application)
e E\ (BackupCapsule, 2 on Disk 0) (UFSD dis

=R =

FPenam= (F5) D=ju= (F

6. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

Clipboard Source
1 /mntdisk/hdal/Documents and Settin [User G
57 /mnidisk/ndalDocuments and Settin . -~
L Application Data
) Cookies
) Desktop
@ ) E-Mail Database
@ i) Favorites
) Local Settings
) My Documents
) PrimtHood
< > ) Recent =
Total data size: nfa [ cax | | Rename(Fe) | [  Deew(ra |
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Click the Calc button to estimate the resulted data size.

7. On the Select Destination Type, choose the way the data will be stored. Select the Burn data to CD/DVD item.

Please select how would you like 1o $ave the data

()} Save dala ta any local drives or a network share

Chaose this option if you want o save your data o local
maunted or physical parition, o USB or FireWare external
drives and o a mounted network share. You will be prompied w0
choose a locathon you wanm o save the archive

(%) Burn data to CO/DVD

Choase this optian if you want the Wizard o burn the data o

CD or DVD. You will be prompted to choose a CD or DVD RW
drive.

On the Choose a Recorder page, select a recorder from the list of available devices and then set a volume label
by entering it in the appropriate field.

Sebect a recorder w0 burn data

Vendor |Product [Type |
Optiare DVD RWAD-T1704 CD-R; CD-RW, DVD-R
Valume |abel [my Dand |

9. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the
operation.

10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list Suboperation progress

1: Transfer user data L ]

Operation progress

(CIITITTITIITIT J

Time elapsed.  00:00:07 Time 10 finish: 00:00:16

Copied sofar: 5.0 Mb
To copy: 12.0 Mb

Overall progress

i’!:!_ﬂ:uuvllnunun[ ]

Creating compilation image

Used burner: DVD RWAD-7170A Vendor: Optiarc
Session opening

Data burning...

11. After the operation is completed, close the wizard by pressing the appropriate button.

12. Turn off the computer.

A This operation can also be accomplished with the WinPE recovery environment.
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Copying of data from a backup to the corrupted system partition
The system fails to boot since some files are damaged. If you have a backup of the system partition, you can recopy
these files to make the system be operable again:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery

f environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

-+ Mormal Mode Hain recouvery

& Safe Mode eny ironment
& Low-Graphics Safe Mode

& Floppy disk

& Hard disk 8 MBR

& Find 05es on your hard disks

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
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= . ™ ‘ou can create, delete and format hard disk
%E Paragon Partition Manager partitions using Paragon Partition Manager™,
which will stan now. Upon the star, please
Restore Wizard select the drive and one of its partitions or its

free space. Then actvale the Panition’

pulldown menu and select one of the
File Transfer Wizard partitioning operations.

Boot Comector
Metwork Configurator
Log Saver

View the mounted partitions

ol B X6 ot

Stant the command line

0

Eject CD/DVD

Reboot the computer

@a™

Paower off

4. On the Wizard's Welcome page, click the Next button.

5. Select a disk where the system backup is stored from the pull-down list in the right pane of the page.

Source

arc_28050B8134627531 w
=

I3 DIFF128565184 710000000

wée arc_2@0508134%27531 PBF

1= arc_280508134627531 pim

6. Double click on the required backup to open.

Source

[image (arc_2a0s08134627531 PBF) |
I [ 2
[ Dcu:ume%ls and Settings

I Program Files

I3 RECYCLER

I System Valume Information
1) WINDOWS

Q cfiles sv.igz

= AUTDEXEC BAT

/= NTDETECT COM

g boot.ini

3 nitkds a3
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7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

Clipboard Source

(7] WINDOWS /system (/mnidisk/hda2/8

[‘.‘.‘HL‘“Z JWS

) provisioning
) pss

) repair

) security

J srchasst
) sysem

) sysem32
) twain_32
& oog

= 001947_tmp
B ARy PIF

=)
=]

< >

Total data size: 904 Kb

Click the Calc button to estimate the resulted data size.

On the Select Destination Type, choose the way the data will be stored. Select the Save data to any local drive
or a network share item.

Please select how would you like o save the data:

(% Save data to any local drives or a network share

Choose this aption il you want 1o save your data w lbcal
mounted or physical panition, 1 USE or FireWarne external
drives and to a mounted network share, You will be prompted o
choose a location you want i sawve the archive o,

) Burn data to CO/DVD
Choose this option il you want the Wizand w burm the data o
C0or DVD. You will be prompied o choose a CD or DVD RW
drive.

9. On the Select Destination Path page, select your system disk to copy the data to by pressing the standard

browse button [...].

u“l“
INtServicePackUninstally

=

) AppPaich

) Config

) Connection Wizard

) Cursors

) Debug

) Downiloaded Program Files
) Driver Cache

I EHome

New foider (F7) |

File name:

| mintdisik/hdal WINDOWS

i
L]

File type:

Help

< Back
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10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the
operation.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list Suboperation progress

oo e s AL ELILI AL LLIRI IR AL RIRIAIIRARIIRIQLIRIIA]RId0IR]0] |

Time elapsed:  00:00:04 Time w finish: 00:00-00

Copied so far. 0.9 Mb

Crverall progress

Translering “AVINDOWS/system” 1o "/mnydisk/hdal WINDOWS fsystem” - lem 1 of 1
All sperations have been finished

12. After the operation is completed, close the wizard by pressing the appropriate button.

13. Turn off the computer.

A This operation can also be accomplished with the WinPE recovery environment.

Restoring separate files and folders from a backup
The program provides a very convenient option to access backup archives and restore only data you need (the so called
selective restore functionality). This operation can be accomplished either with the Restore Wizard, File Transfer Wizard

or Volume Explorer.

Restore Wizard
To restore separate files and folders from a backup image with the Restore Wizard, please do the following:

1. Start up the computer from our WinPE recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery

f environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Once it has been loaded, read the agreement and then mark the appropriate checkbox to accept.
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License
Press Page Up and Page Down 1o scroll the text

End User License Agreement ‘I

N Technolocgie GmbM
grammierung

Heinrch-von-Stephan-Sir, 5 ¢, 79100 Freiburg, Germany

and

You, &3 eng yser

If you accept the terms of the agreement, click the check Sox below

2 b agcept the tarms in the License Agreement ]

'
'n
o

-

Decline I

A If you do not agree with any conditions stated there, you won’t be able to use the program.

3. Once you accept the agreement, you will see the Universal Application Launcher. Select the Restore Wizard.
4. On the Restore Wizard's Welcome page, click the Next button.

5. On the Browse for Archive page choose the required archive in the browser-like window. The Archive File
Details section displays a short description of the selected image.

Look in I & Backup Capsue on Hard Disk 0 :] o X

Name | Size | Date A
T | F e NU/TOBITES20-Egce T30 /- T 2coWRSd i 20030/ U TERNE IZTTUPNT
mg_0_310708_072005875PBF 227KB 7/30/2008 3:20:10 PM
= Bl N{71cb6d16-4¥0-4dca-8367-1¥ 2ch (Fa532)200831070 7/30/2008 3:52:28 PM
mg_0_310708_075228187.PBF 227KB 7/30/2008 3:52:28 PM
1.7GB 7/30/2008 3:55:41 PM

mg_2_310708_075228187.FPBF 12GB  7/30/2008 3.57:46 PM |

Fles of type f,*r:?‘:‘.'e files ;]

r~ Archive Fle Datals
Name: Local Disk (%)
Comment:  [No commant is avaidable!
Volume labal: WnXP

Fla systam: NTFS Totalsize: 25GB
Usad space: 15GB Frae space: 10207 MB
Fla: “1¥2cb(fa5d2)20083107075228187/mg_1_310708_075228187.PBF

6. On the next page specify what you need to extract from the backup by marking checkboxes next to the required
data items. At the right lower corner of the window you can see the resulted amount of the selected data.
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Chick the check box next to any file or folder you want 1o restore from
Name |Type [ Sze |l

= @ Local Disk (7 Patition 23GB

Documents and Settings
© Al Usars

! Defauk User
= LocalSarvice

F
-
-
- [ 5 Network Service
3
-
*
*
+
*
-
-
*
+
:

o User =
I— 1 Applcation Data
[T £ Cookies
[T £ Deskiop

[_ | Favomes

@[ B Local Settings
r
w
r
-

3 NetHood

= CandTa ;]

To cortnue. chck Next Diata size to rastore. 1.7 KB

7. Onthe How to Restore page specify the way the selected data will be restored. In our case we’d rather restore
contents of the backup to its original location with replacing existing files as well.

Restore files to: I':'-‘;M locakion 'I

The: filess and fold -:':hm-m W ciace where they were archved rom.
"Mmmd:nrhgw TSRS I your computer

 Leave masting fiss
(% Raplace sasting flas

8. On the Restore Summary page review all parameters of the operation and modify them if necessary.

Pleass overview the nestorss options. You can retum to the comesponding page and changs the options by cliking
on tithe hypadinkcs.
Obiscts to Restors
Object (s) selected: 1
Total data size: 1.7 KE (1,742 Bytes)
Qriginal nestore destination
Destination path: Cu
Space available on deslination: 1 GE (1,037, 325,556 Byes)

9. On the next page of the wizard confirm the operation by selecting the appropriate option.

—~Would you les to 2pply your changes 7
i+ | Yes, apply the changes physicaly. |
- Nnummht

10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

11. After completing the operation close the wizard, and then reboot the computer.
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A This operation can also be accomplished under Windows.

Volume Explorer
To restore separate files and folders from a backup image with Volume Explorer, please do the following:

Launcher
1. Click the Disk View tab and then choose Volume Explorer;

ni:l-cue-]mp|

Name |Size | Modfied B
i+~ CD/DVD Drives
=[] Hard Disks
=l [5] 1. VMware, Viiware Vitual S SCSI Disk Devi  40GB
=485 1. Primary NTFS (C) P oI99GE
-] $Recycle Bin 471572010 3:40:55 PM
#-5] are_210410030357578 4/20/2010 7:08:34 PM
#-E5 are_NEW 4/20/2010 7:42:40 PM 1

-] anc_TEST 4/20/2010 7:15:14 PM

£ Boot 41572010 4:11:30 PM
+-[] Documents and Settings 11/2/2006 5:02:03 AM
(+1-57] Program Files 4/20/2010 41827 PM
#1-7] ProgramData 4/19/2010 12:40:49 AM
-] System Vohume Information 4/20/2010 9:24-08 PM |

2. Browse for the required archive and then open it by double click of the left mouse button.

ni:l-cue-]mp|

Name |Size | Modfied | B
i+~ CD/DVD Drives
=[] Hard Disks
=-[5] 1. Viware, VMware Vitual S SCSI Disk Devi 40 GB
-8 1. Primary NTFS (€) 199GB
-] $Recycle Bin 471572010 3:40:55 PM
-] are_210410030357578 4/20/2010 7:08:34 PM —
=] are_NEW 4/20/2010 7.42-40 PM
bl arc_NEW.DDT 19GB  4/20/2010 73203 PM
&[] arc_NEW.002 19GE  4/20/2010 7:37-04 PM
L[] ane_NEW.003 18GE  4/20/2010 7:42:40 PM
HTEREEE  13GB 42072010 7:2652 PM
i | | arc_NEW pm 829KB  4/20/2010 7:42-40 PM
-] arc_TEST 4/20/2010 7:15:14 PM |

3. Call the popup menu (right click of the mouse button) for a file/folder you need and then select the Export item.
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Disk View | Help |
=4 Name | Size | Modified A
4 -E1 CD/DVD Drives
=] Hard Disks
= [5] 1. VMware, VMware Vitual S SCSI Disk Devi  40GB
=@ 1. Pimary NTFS (C) 339GB
-5 SRecycle.Bin 4/15/2010 3:40:55 PM
4/20/2010 7:08:34 PM
4/20/2010 7:42:40 PM =
4/20/72010 7:15:14 PM
4/15/20104;11:30 PM
11/2/2006 5:02:03 AM
4/20/2010 4:18:27 PM
. 4/19/2010 12:40:49 AM
+]- (] System Volume Information 4/20/2010 9:24:08 PM ~|

4. Select a place on the disk where the file/folder will be extracted to.

Lockin: | [5] Local Disk () ] @ 8 2
@ Address:  |(Cf
_ DiskDrives | |  Date
=
& J. arc_images e )
@ | | o _new LTl |
Netwods Places i |, archdb SrH
& || archive_db YK
i |, Pedlogs F/a kT
& |, Program Fles 927
5 i Users 8%
£ |y Wi B
- |, Windows S22

5. Click the OK button to accomplish the operation.

The current version of the program does not enable to access file archives with Volume
Explorer.

Resize Scenarios

Creating a new partition to detach operating system from the rest of data

Let’s assume that you’re a rank and file user who is most likely to have only one hard disk with only one partition (the
only partition is always system). To secure yourself against a system malfunction or a virus attack you’ve got nothing to
do, but make a backup of the whole partition, which besides the operating system itself contains all your family photos,
favorite films and music, program distributives, whatever. As a result you’ll get a very huge backup image. You can easily
tackle this issue however by detaching your operating system from the rest of data.

To create a new partition on your hard disk, please do the following:
Express Launcher

Click the Partition Manager button and then Partition Manager in the Express Launcher.
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1. Click the Express Create Partition item of the Wizards menu (any of the ways described earlier can also be used
here).

2. Onthe Wizard's Welcome page, click the Next button.

3. Choose a method you find the most suitable to create the partition. The wizard is especially designed to
minimize your participation in finding an appropriate place for it and its resulted size. The only thing you’re to
do is to choose between several modes. The most relevant thing here is the amount of space that will be
allocated for that partition. For easy perception, you can see the resulted disk layout on the disk map by
selecting this or that mode.

The resutt you will get after applying the changes

Basic Hard Disk 0 (VMware, VMware Virual S SCSI Disk Dey)

l l Y New Volume (E:)

Flaase salact the method of new pantion craaton
Take all unallocated space at the end of the disk
©) | Smart Mode | ( Use 2433 GBto create a pattion ) More nfo

Advanced Mode (s 141 4GB 1o create a patton ) More nfo

The number of available methods depends on your disk layout.

A To learn more on the way the wizard works, please click the corresponding link on the first
page of the wizard.

4. That's basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do
with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.
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(R Express Create Partition Wizard =]
Creating the partition !
Thea Wizard is now creating the pantition =

?'L?-E*{-" = .-"7:?C. te Partition Wizard @3@

1 System restart is required to complete the operation.
« \ What would you like to do?

The operstion Move partition needs exclusve access 1o the volume C: and
Operstiol cannct be completed without system restat. Alter restart, the operation will continue in
) boot4me mode. Do not tum off the computer until the operation
completes.

> Restart the computer
Flease confim restart of your computer. The operation will be continued after
gystem rastart.

& Retry
Manually close usad filas and ratry tha operation

- The operation cannot be completad wihout rastan bacause some flas are in use and
St prevent axchsive access to the volume

What &

£ X X

5. Inthe Progress window you can see in real-time a detailed report on all actions carried out at the moment.

Suboperation progress

[ I
)SG Para Hove partition
[ |

HWork time00:01:53 Time to finish00:02:48
Done: 0.2 MB Read: 98 ME(1.0 MB/s)
AlL: 0 MB Hrite: 0.0 ME(O.0 MB/s)

Overall progress
] |
B R R e AL

Getting partitions info...

Flushing system buffers, please walt..ovsesscssnsnssrasssnasansnssananannnnns
Flushirng suystem buffers, pleass wait.

(Restart enabled)

Modi fying drive *: on hard disk O

Checking parameters ...

Checking files and directories ...

To avoid data loss, please do not reset or turn off the computer.
loperation in progress... press 'ESC' or 'Ctrl-C' to interrupt operation

After completing the operation your computer will be automatically restarted back to Windows where you can see the
newly created NTFS partition. Now you’ve got a place to keep your stuff apart from Windows.

Increasing size of a system partition by taking unused space of an adjacent partition

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming
applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent
partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more.
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To increase size of a system partition by taking unused space from an adjacent partition, please do the following:

Express Launcher

Click the Partitioning button and then select Resize Partitions.
On the Wizard's Welcome page, click the Next button.

Click on your system partition. By doing that, the wizard will automatically select an adjacent partition as well.
This partition will later act as a space donor.

The wizard will resize space between Local Disk {C:) 2nd New Volume (E:)on Basic Hard Disk O
(Whware, VMware Vitual 5 5C51 Disk Dev)

Selact laft partition from 2 pair of adacent paritions you would ke to resize, Right adiacent parttion will ba
selected automatically

Basic Hard Disk 0 f'\l'?dw.lnr_ VMware Virtual S SCS1 Disk |1|w]

nl I @) New Volume (E:)
4603 GB NTF5

A

If you’ve got more than two partitions on your hard disk and a partition you need to
increase is surrounded by other partitions, you’ve got the choice to choose which partition
will act as a space donor. Just click on the left partition of the pair, as the right one will be
selected automatically.

4.

Increase size of the system partition with the slider or manually by entering the required value. Please note,
when you change size of one partition the size of the other will be changed as well, thus redistributing the
unused space between the partitions.

Plazse spacfy new sizes of selactad pattons

Selected part of Basic Hard Disk 0 (VMware, VMware Virtual 5 5C5] ek Dev)

l l ) New Volume (E:)

Left wolume size Right volume size

464 MB B ME —] ameeme 12 me

5. On the next page of the wizard you need to confirm the operation by selecting the appropriate option.

The Wizard has not applied your changes yet. On this pags, you can ethar accept or
A reconsider the changes

Please note that £ you sccept the changes. the Wizard wil physically pefom ol the neccessary
operations and & will not be pessble to undo the changes

Rt may take some time to apply the changes. You may also be asked to rastat your computer duning this
process

Yes. spply the changes physicaly

©) | No. let me reconsider. |
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6. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do
with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.

/ System restard is required to complete the operation.
/= % What would you like to do?

_2

=

The cperation Redistribule partitions nesds axciusive acoess 1o the valuma C:
and cannat be completed without system restart. After restad., the operation wil
corinug in bocttime made. Do not tum off the computer until the operation
completes.

. Reslar the computer |
Plagss sardim restant of your computer. The aperstion will be continusd sfter |

frRem reRad

& Rty

Manualy closs used filas and retry tha oparation
Cancal

7. Inthe Progress window you can see in real-time a detailed report on all actions carried out at the moment.

Suboperation progress

Gparacon - -
) [SOFTWARE GROUF] Redistribute partitions
Work timeQ0:01:15 Time to finishO0:00:05
Done: 0,77 Hb Read: 72 Hb(4.0 Mb/s)
All: 0 Mb HWrite: 0.0 Hb(0.0 Mb/s)

Overall progress

[T TS SOOI O T F

Quick data mowling ...
Flushing system buffers, please wait.

Modi fying drive =: on hard disk O

Checking parameters ...

Scanning dir structure ...

Scanning data stroctiure (Rag be a fed minutes) ...
step 1 ...

step 2 ...

Jo not reset or turn off your computer - to avoid the data loss.
Jperation in progress... press 'ESC' or 'Ctrl-C' to interrupt operation

After completing the operation your computer will be automatically restarted back to Windows where you can see that
your system partition is bigger now.

Increasing size of a system partition by taking unused space from any other

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming
applications and system updates your system partition has started to suffer from the lack of free space. But one of your
partitions has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from any other on-disk partition, please do the following:
Express Launcher
Click the Partition Manager button and then Partition Manager.

1. Inthe main window select the required hard disk (if several) on the Disk Map.
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[E] Basic GPT Hard Disk 2 (Viware, VMware Vitual S SCSI Disk Dev)
B Local Disk ) o
€ (Unalocated) 473BFFBDA

< |

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)
'-I. l A‘" 1
| 10...
1u"

2. Choose a space donor partition and then call the context menu for it (right click of the mouse button) to launch

Data (F:) | I TEMP (G:)
200GB NTFS 160.3GB FAT3Z |

the Move/Resize dialog.

A I A Sl P = NE L

Disk View | Help |
SNeme S
— =] Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dev)
u
Format Partition...
% Delete Partition...
- Move/Resize Partition. .
Convert File System...

a Defragment Partition...
’ Defragment MFT...

’ Compact MFT...
Change Volume Label... |
Hide Partition B Loc
Mark Partition as Inactive ﬂ
ad
Make Partition Logical

Change Cluster Size...
Change Serial Number...
Change Partition ID...

Downgrade NTFS version... Sex
Change SID...

Test Surface...

Y5 CheckFile System Integrity KEl=

41. NTFs W Edit/View Sectors... o

Move or resize the sele.

Properties...

r

3. Inthe opened dialog shift the edge of the partition to the right by the drag-and-drop technique. While doing
this, free space from the partition will be released (displayed in aqua-green). You can also do it manually by
entering the exact size of free space. Click the Yes button to continue.
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Are you sure you want to move/resize volume (G:)?
You are about 1o move /resze FAT32 volume TEMP, (G:)

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)
©) (Unallocated) ’”’ ) TEMP (G))

535GH 100.7 GB FAT32

Volume size: 103.16733 M8 #[+] 86 MB- 164.156 MB
Free space before: £0.52335MB &[] Obytes- 16407009 M8
Free space after: [ Bytes *[=] Obytes - 164.070.09 MB

Seledthsop(mlomovepmmmlhadon\codmwdaa This allows you to keep
the parition’s content after move exactly as @ was, but will require more time

4. Now you’ve got a block of free space to add to the system partition. You cannot do it directly however, but by
carrying out a number of extra move/resize operations.

Bﬂclludﬂd(O(Vll'n VMware Virtual S SCSI Disk Dev)

\ Data (F:) . l TEM...
; 200GBNTFS 100.7.

5. Since the block of free space is within the extended partition, you need to take it out first. The program enables
to resize the extended partition only when there’s a block of free space adjoining its borders. In our case it’s
between two logical disks. So we need to move it. To do that, please select the first logical partition and then
call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.
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I A || TIVTR S 'Sl
Disk View | Help |
= Name R | saee
— =] Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dev)
3| B 5 20
Format Partition...
% Delete Partition...
.
Move/Resize Partition, .
Convert File System...
‘ Defragment Partition...
’ Defragment MFT...
’ Compact MFT...
Change Volume Label... I
| Parttion List Hide Partition g Loc
Llh,,,"e,,,,,, I— Mark Partition as Inactive
Basic Hard Disk 0 (VI £ : v
| Make Partition Logical
| (Disk Map Change Cluster Size... il
Buc Had [h* 0 ) Change Serial Number...
Change Partition ID...
| Local Disk C =
‘ M 35968 NTRS Downgrade NTFS version... Sex
Change SID...
Test Surface...
Y5 Check File System Integrity KEl=
- -
< |. e n Edit/View Sectors... e
: Properties...
Move or resize the sele -

6. At first shift the right edge of the partition to the right, then do the same with the left edge. Make sure the
partition size has been left unchanged.

Are you sure you want to move/resize volume (F:)?
You are about to mova/rasize NTFS volums Data, (F:).

Basic Hard Disk 0 (VMware, VMware Vidual S SCSI Disk Dey)

‘lg(malocaed) ']Igoua(&)
M sce 140.4 GB NTFS

Volume size: $38M.14 M8 &[] 94MB-26575¢ MB
Free space before: (121.52300MB  2[] Obytes - 265.700.04 MB
Free space after 0 Bytes *[] Obytes - 265.700.04 MB

[} Sactorto sactor move
Selact this option to move pattion areas that dont contan any data. This allows you to keep
the parttion’s content after move exactly as & was, but wil require more time.

7. Now you can resize the extended partition to take the block of free space out of it. Call the context menu for it
(right click of the mouse button) to launch the Move/Resize dialog.

8. Inthe opened dialog shift the edge of the extended partition to the right.
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% Are you sure you want to move/resize extended partition on disk 07

| Basic Hard Disk 0 (VMware, VMware Vitual 5 SCSI Disk Dev)

) i etocater) @) Data (F) @) TEMP (G)
LEigi 1404 GB NTFS 100.7 GB FAT32
Volume sze 2¢703860M8 _+ =] 247.038 MB - 362,969 MB

Frem space befors: | 121.530.34 MB ;lzl Olbytes - 12193054 MB
Fres space after 0 Bytes e E

actor o aector mave

Sedect this aption to mowe pardition amsas that don't contan any data. This allows you to keep
the partition’s content aftsr move sxactly a3 & was, but wil reguins mons tims.

9. The block of free space has been released.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)
Ap... (Unall...
100. 115GB

10. Now you need to move the second primary partition just the way we did it with the logical partition to make the
block of free space adjoin the system partition.

Data (F:) I TEM...
1404GBNT... || B 1007..

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

(Unall... ... Data (F:) TEM...
11968 100.. 1404GBNT... || ™ 1007, |

11. Finally increase size of the system partition. Call the context menu for it (right click of the mouse button) to
launch the Move/Resize dialog.

12. In the opened dialog shift the edge of the partition to the right, thus increasing its size.

’6 Are you sure you want to move/resize system volume (C:)?
T You are about 1o move/resize NTFS voluma [No label]. (C:)

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

I @) Local Disk (C:)
158.7GB NTFS

Volume size 162.547.31 MB #[] 11.680 MB - 162,543 MB

Free space before: 0.37 ME ¢[=] Obytes - 150,868 20 MB

Fres space sfter. 0 Bytes *+[=] Obytes - 150.260.33 MB
| Sectorto sector move

Select this option 10 move pattion areas that dont contan any data, This allows you to
keep the pandtion’s content after move exactly 3s & was, but will require more time

13. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to
confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual
Operations Bar.
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@ 7 =
Apply pending changes ?

[~ Do not show this message again fas Mo

14. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the
appropriate button to agree.

Shrinking a system partition to increase size of a data partition

Let’s assume you’ve got two partitions on your hard disk, the first one takes about 40% of all the disk space and is
exclusively used for Vista 64-bit, while the second servers as a data storage. One day you realize that your system
partition doesn’t need so much disk space, that’s what your data partition really requires at the moment. You can easily
tackle this problem with Paragon Linux/DOS Recovery CD.

To increase size of a data partition by taking unused space from a system partition, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery

2 environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

-+ Hormal Hode Hain recouvery

& Safe Mode environment
& Low-Graphics Safe Mode

& Floppy disk

& Hard disk 8 MER

& Find 0Se=s on your hard disks

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select Partition Manager. You can find it in PTS DOS as well.
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- Youcan create, delete and format hard disk
Paragon Partition Manager™ partitions using Paragon Partition Manager™,
which will stan now. Upon the star, please
select the drive and one of its partitions or its
free space. Then actvale the Panition’
pulkdown menu and select one of the

File Transfer Wizard partitioning operations.

(:

L4

Restore Wizard

Boot Comector
Metwork Configurator
Log Saver

View the mounted partitions

ol B X6 ot

Stant the command line

0

Eject CD/DVD

Reboot the computer

@ Paower off

4. Inthe main window select the required hard disk (if several) on the Disk Map.

%

Hard Disk  Partition Operations  Wizards  Help

_ Basic Disk 0 (Vidware Viegal - 120 Gb
nage af ha D: NTFS Data
ge of hard

| Disk from
isk.. [Basic Disk 0 | Model viware virual, Size 120 Gb
| |volume |Type |File System |Size |Used |Free
Basic Disk 0 (Size 120 Gb)
0 C Primary NTFS 444Gbh  81Gb  36.26Gb
1 Primary NTFS 7556 Gb 4.9 Mb 756 Gb

5. Choose your system partition and then call the context menu for it (right click of the mouse button) to launch
the Move/Resize dialog.

Basic Disk 0 (VMware Vinual) - 120 Gb

gg Create an image of partition... Al-B I

Burn an image of partition o CO/DVD...

N olume [Type Restore partition from image. .. AltR E
Basic Disk 0 (Size 1 Copy panitien AC
o C Prima 6.2
1 e PrIma o aie T
Farmal... Al-F
Dalete. . AlD
Wipe paniion, ., Al

Clear free space

Unmount... '!

Madify ¥
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6. Inthe opened dialog set a new size for the partition by moving the slider or by entering the exact value in the
appropriate field. While doing this, free space from the partition will be released (displayed in aqua-green). Click

OK to continue.

Partition preview

C: HTFS Vista 64

New size: (8323 - 45434) Mb

Free space before: (0 - 37111) Mb

=
-

Mb

Mb

Free space afier: (0-37111) Mb
412 | Mb

Ll

H 1) E

7. Now you’ve got a block of free space to add to your data partition.

Baskc Disk 0 (VMware Virtual) - 120 Gb
_ _

8. Choose the data partition and then call the context menu for it (right click of the mouse button) to launch the

Move/Resize dialog.

9. Move the slider to the right to increase size of the partition. Click OK to continue.

- Paniion préview

New size: (8- 102101) Mb

:.1& 102101 | Mb
Free space before: (0 - 102093) Mb
: c—r
Free space afier: (0 - 102083) Mb
] I L

10. Apply the pending changes.

Applying changes

& 2 pending operations
Apply changes 7
= Il
Undo all ||
[ Apply [ ” You have pending op

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.
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Operations list Suboperation progress
1: Mave partitsaon I
2: Move partitson Operation progress
(ed
Time elapsed:  00:00:58 Time o finish: 0L:35:42

Copied so far:  248.5 Mb Read so far: 365.9 Mb (7.8 Mbys)

To copy: 7.9Gb  Write so far: 251.2 Mb (46.0 Mbys)
Owerall progress

i
Data maving -
Creating new partitson _.
Moving drive idev/sdad on hard disk 0
Scanning data structure (may be a few minutes)
{Restart enabled)
Data blocks calculating
Quick data moving ... ~

Resizing partitions of Apple Boot Camp

Let’s assume you're a Boot Camp user who's got Windows XP as the second operating system. Initially allocated space
for the Windows partition has turned out to be insufficient for your current needs. The only way out is to take some
space from your Mac partition, thus redistributing the unused space between the partitions.

To increase size of the Windows partition by taking unused space from the Mac partition, please do the following:
Express Launcher

1. Click the Partitioning button and then select Resize Partitions.

2. On the Wizard's Welcome page, click the Next button.

3. The wizard will automatically select Windows (the NTFS file system) and Mac (the Apple HFS file system)
partitions of your Boot Camp configuration.

The vazaed vall iesize space betwesn Local Disk [°] and WinkP [C:) on Hetained Bazic GPT Hard
Digk 0 WMware Virtual IDE Hard Drive)

Select left partition from & pair of adjacent partkions pou would ke to resize. Right adiacent pastition wall be:
zelected automatically.

Retaned Bagic GPT Hard Disk 0 VM ware Virtual IDE Hard Drive]

I Itumlﬂiulr.l'] l I"-u'inb{Pll'_‘;]
54.8 GE Apple HFS EEEGENTFS

megabyte free block between Mac and Windows partitions made with Boot Camp. It’s just

: On the disk map you can also see the GPT service partition (called EFl) as well as a 128-
for your information.

4. Increase size of your Windows partition with the slider or manually by entering the required value. Please note,
when you change size of one partition the size of the other will be changed as well, thus redistributing the
unused space between the partitions.
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Please specify new sizes of selected pattiions.

Selected part of Hetaned Basic GPT Hard Disk 0 [VMware Yitual IDE Hard Drive)

I @) Local Disk () I ) WinXP (C:)
40,2 GB Apple HFS 71.1 GB NTFS

Left volume size: Right volume size:

41250MB T MB & 72835MB < MB

5. On the next page of the wizard you need to confirm the operation by selecting the appropriate option.

. The Wizasd has not apphed pous changes yet. On this page, wou can edher accept o
!E reconzider the changes.

Pleass note that if you accept the changes, the Wizard vill physically pedom al the neccessary
operations and # will not be possible to undo the changes.

It msay take some time to apply the changes. You may also be asked o restat pour computer dunng this
2=

‘whoudd pou Bke bo apply wour changes 7

6. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do
with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.

A\ Spstem restait is required to complete the operation.
/= ' What would you like to do?

The opesation Redizstribute partitions nesds ewcheive sccass to the volume C:
and cannot be completed wathout system restart. After restart, the operation vl
confinue in boot-time mode. Do not turn off the computer until the operation
completes.

|E Restart the computer '
Plaase confirm regtart of pour computer, The operation will be contnued alter
sysbam restan,

£ Retey
Marually close used fles and ety the operabon

7. Inthe Progress window you can see in real-time a detailed report on all actions carried out at the moment.
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Suboperation progress

6Pal'iElf.':'ml:II'l . "
) [SOFTWARE GROUP] Redistribute partitions
Work timed0:0l:15 Ting to finishO00:00:05
Done: .77 Hb Read: 72 Hb(4.0 Mb/s)
All: 0 Mb HWrite: 0,0 HB(0.0 Mb/s)

Overall progress

Quick data moving ...
Flisshing suysten buffers, pleass walt.

Hodi fuyimg delve ®: on hard disk O

Checking parameters ...

Scannlng dir structure ...

Scanning data structure (may be a fed ninutes) ...
step 1 ...

step 2 ...

Jo not reset or turn off your computer - to avoid the data loss.

Jperation in progress... press "ESC’ or 'Ctrl-C’ to interrupt operation
After completing the operation your computer will be automatically restarted back to Windows where you can see that
your system partition is bigger now.

Creating Dual Boot Systems

For Windows computers

Release of Windows Vista has given a new impetus to the problem of establishing a dual boot system. In this connection
we decided to consider two the most frequently used situations a rank and file user may face, i.e. Windows Vista +
Windows XP and Windows XP + Windows Vista. Please note that for reasons of better security and system
independence these operating systems will be installed on different partitions. That is why we need to hide the first
system partition before installation of the second OS.

Windows Vista + Windows XP

Suppose you have got Windows Vista coming with your brand new computer. Everything is great except one thing —
your favourite applications simply reject to work correctly on it. Software updates are expected to release in the near
future, but you cannot wait any more. Thus the best way out is to leave Windows Vista intact and install the time-
proved Windows XP.

Most likely you have only one hard disk with only one partition (the only partition is always system). To install the
second operating system you need to repartition your drive first, as it requires a separate primary partition. If this is the
case, you can do your job either with the Install New OS Wizard (a specially designed tool for that) or traditionally with a
number of the corresponding wizards and dialogs.

Install New OS Wizard

This scenario implies that operating systems will be installed on different partitions to
provide better security and system independence.

Express Launcher
1. Click Boot Management and then select Install New OS in the Express Launcher.
2. Onthe Wizard's Welcome page, click the Next button.
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3. Select the appropriate option to create a new primary partition on your hard disk.

YWhere would you ke to instal an operating system?

© |want 1o create a new pamary padition 1o install 0S

A naw parttion will be created by using unalocated space of your hard dsk or unused space of esting
pattions. It is tha most prefarable way as no system or usar's data will be affactad dunng the installation

process
| want to use an existing pAmary parttion to instal OS

I casa creation of 3 new pamary panition is not possble ghere are aiready four pamary parttions on the

disk) or not desirable, you are fres to salact any of exsting pamary panttions. Please note that all data on

the selected parttion will be deleted f you choose to format & later in this wizard. Besides make sure no

operating system has already been installed on that parttion

On the next page of the wizard, define size of the new partition. If the selected hard disk contains blocks of free
space, the wizard will automatically merge them all and allocate the resulted space to create the partition. If

not, it will take 50% of the unused space of an adjacent partition, thus resizing it.

You can salect ather a block of unalocated space of the disk or an axisting padition, unusad space of which wil

De sarved 10 Creale 3 new pantion

Basic Hard Drsk 0 (VMware, VMware Virtual S SCSI Disk Dev)

I ©) Vista )
158.7 GB NTFS

l ©) (Unallocated)

3412G8

{] MaxVolume Size: 3412GB

5. The next page enables to specify a file system and a number of additional parameters. Since we are going to
install Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to continue.

|| Vas, | want to formal the partition

Parttion type: | EINTFS 3
Assign the follywing drive latter: | E E]

Sufacetestlevel: | None [

On this page you can specify a number of additional parameters that can also be of help.
However here we pay attention to the most relevant to fulfill our task.

6. Enter alabel for the future partition in the textual field. It will later be used for the drive identification.

(05 labels will be displayed in the Boot Manager's startup menu to help you boaot the required operating
system.

05 label: |Windows ¥F|

7. The program will carry out all the necessary operations and then automatically restart the computer to initiate

the installation process.

If you’ve changed your mind on installing a new operating system, don’t insert its
distributive CD but press ESC when the following message appears:
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s any key to continue

up to boot from CD-DUD.

All the mentioned above operations can also be accomplished with the WinPE recovery

environment.

Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you can find

all the necessary information in documentation that comes with the product. However to avoid any problems,

we consider it necessary to draw your attention on the following issues:

- You need a bootable distributive CD of Windows XP to install it;

- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from CD first

or press F12 during startup to select a bootable device;

- Do not forget to select the newly created partition as destination.

Windows XP Profeszszional Setup

shows the and

on this

The following list
unpartitioned =

existing partitions
com |_Il||.|!1" &

Use the UP and DOWH ARROW kewyz to an item in the lizt.

on the d item. EHTER.

= To create a partition in the unpartitioned s @, Ppres

= To delete the selected partition, press D.

238591 HE Dizk B at Id B B on atapi [MBRI]

on

Partitionl

Boot Manl8

9. So if everything is OK, you’ve got to have by this moment Windows XP successfully installed. Your Windows

Vista however is still non-bootable. To fix this issue you need to launch the Boot Manager Setup wizard. To do

that, please install our program once again, but this time in Windows XP to activate Boot Manager.

JAN

Manager.

To avoid double installation, please use our WinPE recovery environment to activate Boot

10. Click Boot Management and then select Boot Manager in the Express Launcher.

11. Set up the Boot Manager wizard. The most relevant option here is the possibility to hide other primary

partitions except the one selected to boot and it is by all means should be activated to make Windows Vista and

Windows XP unaware of each other. The rest of the parameters offered by default will do in our case, so just

complete the wizard and it will automatically find the two operating systems and update the MBR.

Time to display the BootManager

Choosa a hot key for stanup Boot

configuration

startup message

Mananar
anage

15 seconds
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12. Now restart the computer to make sure you have got a dual boot system.

Traditional way

This scenario implies that operating systems will be installed on different partitions to
provide better security and system independence.

Express Launcher
Click the Partition Manager button and then Partition Manager.

1. Inthe main window select your hard disk on the Disk Map to make a block of free space on it.

Local Disk (E:)

: (E) Serial number:
o iabelt Partition 1D:
Prmary NTFS version:
NIES Volume Size:
32 Partition size:
8 Used space:
8 Free space:

Activity:
Hidden state

" > Move/Resize Partition
g Resze or Move patition

Format Padtition
@g This wizard halps you to fommat the salacted parttion

Basic Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Dev) ]

i’ Local Disk (E:)
4953 9GB NTFS

L}

2. Release some free space (not less than 10 GB to install Windows XP) from the partition. To do that, please call
the context menu for the selected partition (right click of the mouse button) and launch the Move/Resize dialog.
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|
o

P
© -
'/,é Are you sure you want to move/resize system volume (C:)?
You are about to move/resize NTFS volume [No label], (C:).

Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dev)

l ©) Local Disk (C:)
39.9GB NTFS

Volume size: [s0s5emME 2] ~] 18.261MB-40.958 MB
Free space before: [0.97 MB 2] 7] Obytes-2269335 M8

Free space after: [0 Bytes %] ~] Obytes-22689.77 MB

[T Sectorto sector move
Select this option to move parition areas that don contain any data. This allows you to
keep the parition’s content after move exactly as it was. but will require more time.

3. Inthe opened dialog shift the edge of the partition to the left by the drag-and-drop technique. While doing this,
free space from the partition will be released (displayed in aqua-green). You can also do it manually by entering

the exact size of free space. Click the Yes button to continue.

'f,o\ Are you sure you want to move/resize volume (E:)?
’ You are about to move/resize NTFS volume [No label), (E:)

Basic Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Dev)

. ©) Local Disk (E:) .."_.I @) (Unallocated)
262.3GB NTFS 2316GB

Vokume size 27¢.790514M8 =] 101 MB-511.553 MB
Fres space before: |0.37 MB ¢[=] Obytes -511.851.43 M8

Free space after: | 237.201.52MB  2[+] Obytes -511.883.61 MB

Sactor to sector move
Selact this cption to move padition areas that dont contain any data. This alows you 1o keep
the pattion’s content after move exactly as t was, bt will require more time

The Move/Resize dialog offers a number of additional parameters that can also be of help.
However here we pay attention to the most relevant to fulfill our task.

4. Now you have a block of free space sufficient in size to hold a new partition.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

Vista (C:) (Unallocated)
158.7GB NTFS 3412GB

’

5. Create a new partition to install Windows XP. To do that, please call the context menu for a newly created block
of free space (right click of the mouse button) and launch the Create Partition dialog.
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@ 7R =X~
Are you sure you wanl to create a new partition on disk 07

You are about to creste a new partition in (Unallocated). 18.3 GB area. Please select size,
paosition and file system of the new partition.

Basic Hard Dhak 0 (VMware, VMware Vidtual S SCSI1 Disk Dev)

18.3 GB NTFS

Create new parttion a5 <
Please specify new partition size: 188345 TMB-18.834 ME

Pleasze specly sze of free space before the pattion: |0 3: 0O ME - 18.826 MB
Please specify size of free space afterthe parttion: |0 3: 0 ME - 18.826 MB

Please select file system for new parttion: | NTFS -

Please enter new volume label: INEW Valume

Flease specify drive letier: E |

¥ More options Yes I | Mo

6. Define parameters of the future partition. By all means it has to be primary and since we are going to install
Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to continue.

Creste new pattion as [Primary postton [

Please specfy new pation size 343451 % 7MB-343.451 MB

Please specfy size of free space before the paditicn: |0 2 OMB-343437MB

Please specfy size of free space after the pattion 0 * OMB-343443 MB

Pleasa salact fils systam for new parttion: NTFS E]

Plaase enter new volums label New Voiums

Please spacfy dnve letter F E

¥) More options [ Yes ] [ No ]

The Create Partition dialog offers a number of additional parameters that can also be of
help. However here we pay attention to the most relevant to fulfill our task.

7. As aresult of the operation we have got a newly created FAT32 partition just enough in size to comfortably
work with Windows XP.

'Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)
| I Vista (C:) New Volume (F:)
158.7GB NTFS 341.2GB NTFS

8. Hide the Windows Vista partition to avoid writing any data on it during the Windows XP installation, as it is the
best way to provide system independence. To do that, please call the context menu for it (right click of the
mouse button) and launch the Hide Partition dialog. Click the Yes button to continue.
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) 7=
Are you sure you want to hide the partition?

You are sbout to hide parition (E:) New Volume, NTFS. Hiding the parition may
causa drive letters to be changed.

!

Yes Mo

A Hiding of the system partition will make OS non-bootable, what is quite normal.

9. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to
confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual
Operations Bar.

i~ "

@ 7=
Apply pending changes ?

[ Do not show this message again feg Mo

10. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the
appropriate button to agree.

After all the operations are completed you will not be able to restart the system, what is
quite normal. Nevertheless if you do try it, the following error will occur:

=55 terminated unexpectedly with a sta

All the mentioned above operations can also be accomplished with the WinPE recovery
environment.

11. Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you can find
all the necessary information in documentation that comes with the product. However to avoid any problems,
we consider it necessary to draw your attention on the following issues:

- You need a bootable distributive CD of Windows XP to install it;

- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from CD first
or press F12 during startup to select a bootable device;

- Do not forget to select the newly created partition as destination.
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Windows HP Professzional Setup
The following lizt zhows the existing partitions and
unpartitioned =5 o 15 computer.
Use the UPF and DOWH ARROW keys to select anm item in the list.
To zet up Windows XP on the zelected item, | ENTER.
a pavtitionm in the unpartitioned s=pace. press

» delete the zelected partition. press D.

238591 HE Dizk B at Id B on bu B on atapi [MBRI]

Partitionl < Boot Han
Fartitiond 5

A Installation of Windows XP will make Windows Vista non-bootable.

12. Launch the Boot Manager Setup wizard. As your Windows Vista is non-bootable any more, you need to install
our program once again, but this time in Windows XP to activate Boot Manager.

To avoid double installation, please use our WinPE recovery environment to activate Boot
Manager.

13. Click Boot Management and then select Boot Manager in the Express Launcher.

14. Set up the Boot Manager wizard. The most relevant option here is the possibility to hide other primary
partitions except the one selected to boot and it is by all means should be activated to make Windows Vista and
Windows XP unaware of each other. The rest of the parameters offered by default will do in our case, so just
complete the wizard and it will automatically find the two operating systems and update the MBR.

Time to display the BootManager statup message

s b ~r T ) o
Choosa a hot key for stadup BootManage

15. Now restart the computer to make sure you have got a dual boot system.

Windows XP + Windows Vista
If you’ve got Windows XP and are willing to try the latest Windows Vista but not sure your favorite applications will
flawlessly work on it, the best way out is to leave the time-proved Windows XP intact and install Windows Vista for

studying purposes.

As this very situation is very close to the previous one, please use the Windows Vista + Windows XP scenario. However
please take into consideration one more step you need to accomplish if you decide to use the traditional scenario:

1. Besides hiding of the system partition before installation of the second OS you need to make it inactive as well.
To do that, please call the context menu for it (right click of the mouse button) and launch the corresponding
dialog. Click the Yes button to continue;
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@ 2| =5
; Are you sure you want to set the volume as inactive?
'/—‘"" You are sbout to set the volume (C:) [No label], NTFS as inactive. You computer
may no longer boot comactly_

Reviving the system partition

In case you are not able or not willing to complete the mentioned above scenarios, but have already reached the point
when all changes are applied and everything is ready to install the second OS, please do the following to make your
system bootable once again (only relevant for the traditional scenario):

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery
2 environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe Linux launch menu select Partition Manager.

» You can create, delete and format hard disk
Paragon Partition Manager™ partitions using Paragon Partition Manager™,
which will start now. Upon the sian, please
select the drive and one of its partitions or its
free space. Then actvale the Panition’
pull-down menu and select one of the

File Transfer Wizard partitioning operations.

Restore Wizard

Boot Comector

Metwork Configurator

Log Saver

View the mounted partitions

Start the command line

BoiBxG Rt

Eject CD/DVD

[
!
\

N

Reboot the computer

Pawer off

e

3. Inthe main window select your non-bootable Windows partition on the Disk Map.
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[ Bask Disk 0 (Viware Virtual IDE Hard Drive) - 250 Gb

C: NTFS Vista
k

-~

[E'. aske Digk 0 ] = Model VMware Vinual IDE Hard Drive, Size 290 Gb
N [voleme |Type |Fise System |Size |used |Free |vielume Label
Basic Disk 0 (Size 250 Gbi
L Primary NTFS 200 Gb 1.7 Gb 199 Gb Vista
1 Primary FAT32 49.7Gb 4.9 Mb 496 Gb Mo label]

4. Unhide the partition by calling the context menu for it (right click of the mouse button) and then selecting

Unhide.
ud Disk 0 (Size 40.0 GB)
:_ Back Up Pariition... Al-B :: ZG:E ;:: g:
Burn Partifion on CDor OVD., ) ’
Restare Partition... Al-R
Copy Partition... Ale-C
Format Partition.., Alt-F
Delete Panition... Al-D
Move/Resize Partition... Al-Z
Convert File System...
Unmount...
Setinactive
m Change Cluster Size...
Test Surface Change Volume Label. .

Change Serial Number...
Change Partition 1D, ..
Change SID...

Check File System Integrity

EditView Sectors

Browse Partition... Make logical

Properies

Defragmentation...

Mavigate through "TAB' and |

IHI

Merge with ..

5. Only for the Windows XP + Windows Vista scenario you need to make the system partition active as well by
calling the context menu for it (right click of the mouse button) and then selecting Set Active.

e p 1 s A ran o

Farmat Partition. .. Alt-F
Delete FPartition... Al-D
Move/Resize Partition... Alt-Z
Conven File System... Unhide
Unmouni...

Set active
b

Change Cluster Size...

Change Valume Label...
Change Serial Number...
Change Partition 1D. ..
Change 5ID...

Test Surace...
Check File System Integrity

EdiyView Sectors

Make logical

D rmssorm Fimatitine
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6. You will be notified after the operations are completed.

Operations list: Suboperation progress

RSN AN ERE AR RN

1: Set panition flags

Operation progress

Time elapsed: 00:00:26  Time to finish

Cwverall progress

AENERENEEREENERENESNERNSNENNEREREENER

Rebuilding panitions info...
All operations have been finished

7. Restart the computer.

System Migration Scenarios

Migrating system to another hard disk (Clone HDD)
Let’s assume that you’ve bought a new hard disk. It’s faster and of much higher capacity than your current system disk,
so it’s quite natural you start thinking about system migration. We can help you do that.

To migrate your system from one hard disk to another, please do the following:
Launcher
1. Connect both source and destination disks to the computer.
2. Turn on the computer.
3. Click the Copy Disk item of the Wizards menu (any of the ways described earlier can also be used here).
4. On the Wizard's Welcome page, click the Next button.

5. On the Select Hard Disk to Copy page, select a source disk (a hard disk you want to copy).

On this page. you can choose a hard disk you would like to copy. All partitions from this hard disk will be copled
to the destination you will choose on the next page

Basic Hard Disk 0 (VMware. VMware Virtual S SCSI Disk Dev)
I @) Local Disk (C:)

439 SGBNTFS

| '

JMMMI(WW.W'UBWMSSCSIM&W) l

| : ;

‘ l @) Local Disk (E"‘Bastc Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Dtv)f""’ | |5
34 GB FAT3Z LR T% 22 G0

6. On the Select Target Hard Disk page, select a destination disk (a hard disk to copy contents of the source disk).
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Select a target hard disk. Al data from the source hard disk will be copied there. During copy operation, target
disk content will be deleted.

'Mmmum.mmusmlutmﬂ

|I @) Local Disk (C))

| 453 3.GB NTFS

Basic Hard Disk 2 (VMware, VMware Virtual 5 SCS| Disk Dev)

|. [_}J Archives (G:) @Bada.pl:mﬂe
41.9GE NTFS || 33GB

L] {Unalloq Basic Hard Disk 3 (VMware, Vihware Virtual 5 SCSI Disk Dw}]
4933 GE

A During the operation all contents of the destination disk will be deleted.

7. On the next page of the wizard, define the copy options. In our case we’d rather copy data with a proportional
resize to occupy the entire disk. Besides we recommend you to enable the surface test to make sure your new

hard disk is flawless.

Choose copy options that sut best your task:
Copy options:
[~] HDD raw copy
Parttions raw copy
[] Perdom incremental copy
Resize options:
Remove free blocks between parttions

Mark the checkbox to peoportionally change the size of panttions while keeping ther

relative order intact
Tip: This can be very convenient when migrating to a larger hard disk

8. On the Revise Copy Results page review all parameters of the operation.

Basic Hard Disk 1 (VMware, VMware Vitual S SCS1 Disk Dev)
@) Local Disk (E9) | ©) Local Dis... e I @) (Unallo_._
34 GB FATAZ 24GBNTFS 14G 22GB

Basic Hard Disk 3 (VMware, VMware Vitual S SCSI Disk Dev)
@) Local Disk (*) P @ local D g)."l .(_))(Undloal..
173 GB FAT3? 1205GB NTFS 712 134 6GB

Proportional resize - the copy will take 500 GB (100 % of tarpet disk space)
Min Copy Size: 627.5MB |
L“ Select the range of the disk space that wil be occupied on the destination disk with copied ]

U Max Copy Size: 500GB

partitions.

9. Complete the wizard and then apply the pending changes.
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i~ 5

%; Y O|[ER
Apply pending changes ?

[~ Do not show this message again fas Mo

10. When copying is completed, shut down the computer.
11. Disconnect (physically) the source hard disk.

12. Boot the computer from the destination hard disk.

To make a Win2K+ operating system bootable on different hardware, please additionally
complete the P2P Adjust OS Wizard.

Making system bootable on different hardware (P2P Adjust OS)

Let’s assume you had to migrate to a new hardware platform. You just connected your system hard disk to the brand
new PC and tried to start up the operating system - you do know for sure now that this operation had been doomed to
failure from the very beginning. With our program you can easily tackle this naughty problem.

But before you start, please make sure the following conditions are met:
e You've got drivers for the new hardware ready to use, not zipped or in .exe files.
e Your OSis unrolled on the new computer, not in a backup image.

To recover bootability after migrating your physical system to different hardware, please do the following:
1. Start up the computer from our WinPE media.

2. Once it has been loaded, read the agreement and then mark the appropriate checkbox to accept.

A If you do not agree with any conditions stated there, you won’t be able to use the program.

3. Once you accept the agreement, you will see the Universal Application Launcher. Launch P2P Adjust OS Wizard.

Our WinPE 3.0 based environment offers excellent hardware support. However in case it
doesn’t have a driver for your disk controller, your hard disks will be unavailable. Please
consult the Adding specific drivers scenario to know how to tackle this issue.

@ Sorry, the wizard cannot continue.
Wizard has falad to find any OS that can be modfied. Please note, the Wizard can

only work with Mcrosoft Windows 2000 and later

[ Qose |

( ;) Dapanding on your system configuration and hardware some disks can ba unavaiabla for

L/ the program

4. On the Wizard's Welcome page, click the Next button.
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5. From the list of all found Windows based operating systems (if several) select one you need to adjust to your
new hardware. If you’re willing to adjust them all, just re-launch this wizard for each.

05 Vokme Label Capacity |
E:'a"': ''''' s 2000 Local Disk () [Molabel] 1.9GB
= Windows XP Local Disk (D) [Nolsbel] 4.3GB

A The wizard can only work with Microsoft Windows 2000 and later operating systems.

6. Choose whether you’re going to add drivers for the new hardware to the selected operating system or not and
the way it’s to be done. Actually you've got three options:

o Upload drivers automatically from the provided driver repository. Generally together with new hardware
you get its drivers for different operating systems on removable media (mostly CD or DVD). By collecting all
these drivers in one folder you can let the wizard automatically pick and install only those required for your
0OS (recommended);

e Upload drivers manually. If you know exactly what drivers your operating system is lacking to successfully
start up, you can manually provide them for the wizard.

¢ Do not upload drivers. And finally you can just refuse providing 3" party drivers.

& Upload drivers automatically from the provided driver repository
Salact this option £ you'va got a foldar with multiple driver packages and want all requirad drivers
for the new hardware to ba nstalled automatically. Please note, only the nacessary dnvers wil be
nsetead 1o the selected 05

[ Upload drivers manuaily
Selact this option £ you know exactly what divers ame required to make the selected 05 bootable
on the new hardware.

> Do not upload drivers
Salect this option £ you don't want 10 insat 2rd pary divers to the selactad OS5,

We prefer the wizard to decide what drivers are to be installed.
7. Browse for a folder with drivers for the new hardware or type in a full path to it manually.

Pleass chooss a folder that containg INF fles:

|-"f programs ' Paragen Software' program’\Test_Deivers Browse..

8. Apply the changes by confirming the operation.
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' The Wizard has not applied your changes yet. On this page. you can eher accept or reconsider the

« \ changes.
Please note, f you accept the changes. the Wizard wil physically pedorm al operations. 50 you won! be able
to interrupt this process or undo the changes.

& may take some time to apply the changes. You may also be asked to restart your computer during this
process.
~Would you like to apply your changes ?

(= | Yes, sonly the changes physically. |

* No.lunsmmder

After the operation is completed your system will be bootable on the new hardware.

Hard Disk Optimization
To defragment an NTFS or FAT partition, please do the following:

Launcher

You must have administrator’s privileges to accomplish defragmentation of the system
partition.

1. Click the Partition Manager button and then Partition Manager in the Express Launcher.

2. Inthe main window, select a partition you want to defragment on the Disk Map.

[

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

Vista (C:) New Volume (F:)
158.7 GB NTFS [ 341.2GB NTFS
T ze: 158.7
Basic Hard Disk 1 (VMware, \*Uf:‘::‘l'l': 16588 7 GB e Bk Dev)
Local Disk (E) Free: 1473 GB jcated)
268.3GBNTFS | [P

3. Launch the Defragment Partition dialog by calling the popup menu for the selected partition (right click of the
mouse button) and then selecting the menu item: Defragment Partition...

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dey)

Vista (C)) Y
152.7GB NTFS n Analyze Fragmentation

a Defragment Partition..,
Basic Hard Disk 1 (VM S Dev)
! Defragment MFT...

;:::Gl::;g) ! Compact MFT...
Test Surface...
e o ;‘}; Check File System Integrity Dacley)
W ONTFS W FAT [ LBl

Properties...
<«

4. Inthe opened dialog define settings of the operation. To improve the performance we recommend you to mark
the Do not save content of the Pagefile.sys or (and) Hiberfile.sys checkbox as these files are only needed for
the current Windows session.
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Defragment volume (C-)7

Defragmantation may improve pedomancs of your system . For lockoad
volumes, however, this operation will regquine the system restar

Drectories placement

Put directones Leave as it [=]
Sort options

Soet by size Do riot sont [=]

Sort by modfication time: | Do not sort El

The Defragment Partition dialog offers a number of additional parameters that can also be
of help. However here we pay attention to the most relevant to fulfill our task.

5. Start the operation by clicking the Yes button.

Extra Scenarios for WinPE

Adding specific drivers
Our WinPE 3.0 based recovery environment offers excellent hardware support. Anyway you’ve got the option to add
drivers for specific hardware with a handy dialog.

To add drivers for specific hardware, please do the following:
1. Once you accept the agreement, you will see the Universal Application Launcher. Click Load Drivers.

2. Inthe opened dialog browse for an .INF file of the required driver package located on a floppy disk, local disk,
CD/DVD or a network share. Then click the Open button to initiate the operation

Look in; I [E] ga (oaanear (27) :J o K ¥
@ Name |Size | Dats Al
=k [=] ga [ amnver) (23
Dk Drives A A MTY 925/ 2007 68353 AM J
+ TrTRane 416/2009 3:15:50 AM
- ] 22408 T i
@ & 5] 4Natasha 121
Matwork Places A= [l Aocls_PM2008 7.
- Adus03 7
; Compatibility £
4 Davscan E
= -i'.'.'\c"':. 76
. aard oo _windk Japevista_b 11375 5 0% 10:31:34 PM
= [l Intal-ICH SMB52009 10:33:53 PM
=T ] Driver EA18/2008 10:33:53 PM
~| TETsr BEKE 812 1:21:12 AM
i o inf JSKE 91272008 1:21112 AM ~|

Flepame:  [asHCI
Fles of ype: | inf Sles |

oo | _cows |

A To know how to map a network share, please consult the Configuring network scenario.
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3. You will be notified on the successful accomplishment of the operation. Click Yes to load another driver or No to
close the dialog.

Driver "z-fadjustos/drivers/intel-ich/driver/iashci inf™ has
been loaded successhully. Would you like to load another
driver(s)?

Our WinPE 3.0 recovery environment is 32-based, thus you need to use 32-bit drivers for
injection.

Configuring network

If your local network has a DHCP server, a network connection will be automatically configured once our WinPE
recovery environment has been started up. Otherwise you will need to do it manually with a handy dialog by providing
an IP address, a network mask, default gateway, etc. Besides with its help you can easily map network shares.

To manually set up a network connection and map a network share, please do the following:
1. Once you accept the agreement, you will see the Universal Application Launcher. Click Configure Network.

2. Inthe opened dialog provide an IP address, a network mask, default gateway, etc. for your network device.

Ethemet adapter, | Inted(R) PRO/1000 MT Network Cornection =]

|F address

™ Obtain an |P address automatcaly, Renew Belease

(+ Lisa the folowing IF addness ;
IP Addreas : [2::: 1.208
Subnet Masc:  [255.255 24000

Difauk Gateway : [200.0 .1 .1 Agvanced... |
Loadfomtie | Sevetotie | ok | oy | coce |

3. Click the Network drivers tab to map a network share.

Drive | Natwork path ﬂm-hldﬂuthﬂul

Fi sarveras

4. Click Map Network Drive and provide all the necessary information to map a network share in the opened
dialog:
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Remote lecation mapping

Anetwoek share || _I
Map to dive lefter: | =

I Make permanent connerdion

¥) Connect ss user oK I Cancel |

e Click the standard browse button [...] to browse for the required network share or manually enter a path to
it;

e Define a letter from the pull-down list of available drive letters;

e Click the Connect as user button at the foot of the dialog page to specify a user name and password to
access the selected network share if necessary.

By clicking Disconnect Drive... you can delete an existing network share if necessary.

5. Click the Network identification tab to change a network name of your computer (generated automatically) and
a workgroup name.

6. By default, the wizard saves all network settings in the netconf.ini file located on the WinPE RAM drive, thus it
will only be available until you restart the computer. However, you can just once configure your network device
and then save this file to some other destination, for instance a local drive, and this way avoid constant re-
configuration, just by providing a path to it. So Click Save to file to save the netconfig.ini file to the required
destination.

Saving log files

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of
having difficulties with handling the program, you, with the help of this very function, can address the company support
engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in
order to tackle the encountered problem. Information of that kind is stored in log files.

To prepare a log files package, please do the following:
1. Once you accept the agreement, you will see the Universal Application Launcher. Click Log Saver.

2. Inthe opened dialog browse for the required location of the log files package or manually provide a full path to
it. Click Collect to initiate the operation.
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Path to the target zip file:

Zlogs 0S0710_132%.5p Browse

Csw ea |

JAN

Log files do not contain any confidential information on the operating system settings or
the user documents.

Troubleshooter
Here you can find answers to the most frequently asked questions that might arise while using the program.

1.

| try to run an operation, but the program claims my partition is in use and suggests restarting the computer.

There are a number of operations that cannot be performed while your partition is in use (or locked in other
words). Please agree to reboot your machine to make the program accomplish the operation in a special boot-
up mode.

| run an operation and restart the machine as required, but it just boots back into Windows without
accomplishing the operation.

Please run 'chkdsk /f' for the partition in question.
| cannot create a new partition on the disk.
There can be a number of reasons for that:

e The program cannot create a new partition on a dynamic disk, but only on a hard disk that uses the DOS
partitioning scheme.

e According to the rules of the DOS partitioning scheme, the following combinations of partitions cannot
be created:

- Two Extended Partitions on one hard disk;
- Five or more Primary partitions on one hard disk;
- If there is an Extended Partition on the disk, only three Primary partitions are allowed.

e The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert
a free space on an existing partition to a new partition.

| cannot copy a partition.
There can be a number of reasons for that:
- The source or target disk you select is a dynamic disk;

- 4 primary partitions (or three primary partitions and an extended one) already exist on the target disk.
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5. | need to copy a partition. But when selecting a place where to make a copy, | always get a crossed circle sign no
matter which partition is selected.

The program enables to copy a partition only to a block of un-partitioned space. If you don’t have a block of free
space on your hard disk, please delete or reduce an existing partition to accomplish the operation.

6. | cannot do anything with my USB flash drive. | get a crossed circle sign when trying to select any area on it.

Some USB flash drives don't have the MBR (Master Boot Record), that’s the cause of your problem. To fix the
issue please use the Update MBR function of our program or 'fixmbr' of the Windows installation disc to write a
standard code to your flash drive.

7. When trying to back up my system the program asks to restart the computer.
Most likely the Hot Processing mode is disabled. Please make it active in the program settings.

8. When backing up a partition with the VSS (Volume Shadow Copy Service) mode, the program throws "VSS could
not be started for processed volume".

Most likely you try to back up a FAT32 partition, which is not supported by VSS. Please use the Paragon Hot
Processing mode instead.

9. | cannot back up my hard disk to an external hard drive. Once started, the operation is aborted with the
following error: Hard Disk management, Error Code 0x1100a. What is wrong here?

The problem is that the Microsoft VSS service is set as the default Hot Processing mode in the program. But this
service has not been started in your WindowsXP/Windows2003/Vista. Please start this service (right click on My
Computer > Manage > Services > find Microsoft Volume Shadow Copy Service and make it active. Set also to
start it automatically).

10. When running a backup operation with the Paragon Hot Processing mode enabled, | get an error: error code
0x1200e "Internal error during Hot Backup"

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool.
You can find a name of the tool you need here: http://kb.paragon-software.com

11. When running a backup operation with the Microsoft VSS mode enabled, | get the following error: error code
0x12016 "VSS: can't read volume data”

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool.
You can find a name of the tool you need here: http://kb.paragon-software.com

12. When trying to back up to a network share, | get the following error: "i/o error" or "can't open/create file"
Please check whether you’ve got a permission to write to the selected destination or not.

13. When trying to restore a backup archive, | get the following error: "Can't restore to current selection" or
"Archive does not fit"

Most likely you're trying to restore a backup of the whole hard disk to a partition or vice versa.

14. | set up a timetable for a task, but it fails to execute.
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There can be a number of reasons for that:

- Windows Task Scheduler does not work properly. Check whether it is so or not by scheduling a simple task (call
Notepad through scheduling);

- You don’t have permission to write to the selected backup destination.

Glossary
Active Partition is a partition from which an x86-based computer starts up. The active partition must be a primary
partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the system volume.

In the DOS partitioning scheme, only primary partitions can be active due to limitations of the standard bootstrap.

The term backup originates from the time when the best way to protect valuable information was to store it in form of
archives on external media. It's become now a general notion to mean making duplications of data for protection
purposes.

Bootable Archive is created by adding a special bootable section when backing up the data to CD/DVDs. Thus you will
be able to restore the data from these archives without having to run the program, but by simply booting from these
CD/DVDs.

Cluster is the smallest amount of disk space that can be allocated to hold a file. All file systems used by Windows
organize hard disks based on clusters, which consist of one or more contiguous sectors. The smaller the cluster size, the
more efficiently a disk stores information. If no cluster size is specified during formatting, Windows picks defaults based
on the size of the volume. These defaults are selected to reduce the amount of space that is lost and the amount of
fragmentation on the volume. A cluster is also called an allocation unit.

Extended Partition is a partition type you create only on a basic MBR (Master Boot Record) disk. Extended partition is
used if you want to create more than four volumes on a disk, since it may contain multiple logical drives.

File System Metadata. The servicing structures of a file system, which contain information about allocating files and
directories, security information etc, are named the file system metadata. It is invisible for users and regular
applications because its accidental modification usually makes a partition unusable.

Hard Disk Geometry. Traditionally, the usable space of a hard disk is logically divided into cylinders, cylinders are
divided into tracks (or heads), and tracks are divided into sectors.

The triad of values {[Sectors-per-Track], [Tracks-per-Cylinder], [Amount-of-Cylinders]} is usually named the Hard Disk
Geometry or C/H/S geometry.

Tracks and cylinders are enumerated from "0", while sectors are enumerated from "1". These disk parameters play an
essential role in the DOS Partitioning scheme.

Modern hardware uses an advanced scheme for the linear addressing of sectors, which assumes that all on-disk sectors
are continuously enumerated from “0”. To allow backward compatibility with older standards, modern hard disks can
additionally emulate the C/H/S geometry.

Hidden Partition. The concept of a "hidden" partition was introduced in the IBM OS/2 Boot Manager. By default, an
operating system does not mount a hidden partition, thus preventing access to its contents.
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A method of hiding a partition consists in changing the partition ID value saved in the Partition Table. This is achieved by
XOR-ing the partition ID with a 0x10 hexadecimal value.

Master File Table (MFT) is a relational database that consists of rows of file records and columns of file attributes. It
contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is similar to a FAT table in a
FAT file system.

MBR & 1st track of the hard disk is the Oth sector of the disk. MBR (Master Boot Record) contains important
information about the disk layout:

- The used partitioning scheme;

- The starting records of the Partition Table;

- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses).
Generally, the Oth sector is used for similar purposes in all existing partitioning schemes.

The MBR capacity is not sufficient to contain sophisticated boot programs. That’s why the on-boot software is allowed
to use the entire Oth track of the disk. For example, boot managing utilities such as LILO, GRUB and Paragon Boot
Manager are located in the Oth track.

Partition ID (or File system ID) is a file system identifier that is placed in the partition. It is used to quickly detect
partitions of supported types. A number of operating systems completely rely on it to distinguish supported partitions.

Partition ID is saved in appropriate entries of the Partition Table and takes only 1 byte of space.

Partition Label (or Volume Label) is a small textual field (up to 11 characters) that is located in the partition's boot
sector. This value is used for notification purposes only. It is detectable by any partitioning tool including the DOS FDISK
utility.

Modern operating systems save it within a file system, e.g. as a special hidden file. Thus it is able to contain a relatively
large amount of text in multiple languages.

Partitioning Scheme is a set of rules, constraints and format of the on-disk structures to keep information on partitions
located on a hard disk.

There are known several partitioning schemes. The most popular of them is the so-called DOS partitioning scheme. It
was introduced by IBM and Microsoft to use multiple partitions in the disk subsystems on IBM PC compatible
computers.

Another popular partitioning scheme is the so-called Logical Disks Model (LDM) that originates from the UNIX
mainframe systems. Veritas Executive accommodates a simplified version of LDM to the Windows 2000 operating
system.

Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme and the new
Dynamic Disk Management (DDM). The problem is that earlier versions of Windows do not support DDM. In addition,
most hard disk utilities do not support it as well.

Recovery Media is a CD/DVD disc, a USB flash card or even a floppy disk from which you can boot for maintenance or
recovery purposes.
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Root Directory is the top-level directory of a formatted logical drive to include other files and directories. In modern file
systems (Ext2/Ext3, NTFS and even FAT32) it does not differ from other directories. This is not the case for old FAT12
and FAT16 file systems.

Serial Number. In the DOS partitioning scheme, every hard disk and every partition has a 32-bit serial number
represented by an 8-figure hexadecimal value. It is stored in the MBR and its value is assigned when the MBR sector is
initialized by Microsoft standard disk managing tools, such as Windows Disk Administrator and the FDISK utility.

In fact, a hard disk's serial number is not important for most operating systems and software. It is known that Windows
NT, 2000 and XP store its value in the database of assigned drive letters.

A partition's serial number is stored in its boot sector (in FAT16, FAT32 and NFTS file systems). Its value is assigned when
the partition is formatted. It does not play an important role for most operating systems and software as well.
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